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Disclaimer 

This is the first edition of the edDesk (Lotus Notes) User Guide. You are part of the 
review and feedback cycle for this user guide and your input is greatly appreciated. 

Please be aware of the following: 

•	 If you find any errors, please email: fborkman@itechne.com 

•	 There is mention of advanced / specialised courses being available.  They are 
not available yet, but will be coming soon. 

•	 This first edition does not have an index.  There will be an index in future 
editions. The Table of Contents is comprehensive.  

•	 Owing to some developmental issues there is no information on using the 
Calendar features. However, as soon as the Calendar has been upgraded a 
chapter on its functionality will be reinstated in this user guide. 

Thank you. 

Frances Borkman 
User Education Director 
itechne 
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1.	 Introduction 

1.1 	 WHAT IS EDDESK? 
edDesk is an "editor's desk" that allows you to write, edit, produce and distribute 
content for multiple media.  edDesk brings together everyone on a team so you can 
see who is working on what, and where it is up to in the editing process. 

There are two basic concepts in edDesk –  

•	 you have content 

•	 you can organise and display your content in several ways, depending on 
your role and objectives. 

edDesk separates content from appearance, letting content contributors concentrate 
on content, and not be concerned about the layout of that content.  edDesk also 
provides version control and workflow management, making it easy and effective to 
use when your team is located in more than one place. You can access edDesk from 
two places: 

Web browser.  This is mainly for simple editing, writing copy and filing 
copy. There are some features of edDesk that are not available through your 
web browser. 

Lotus Notes.  This is the recommended access when you need to do a lot of 
editing. There are several features available through Notes that are not 
available in the web version. 

This user guide covers only the Lotus Notes version of edDesk. 

1.2 	 GENERAL OBJECTIVES 

After reading this user guide and participating in an introductory training session 
you should be able to: 

•	 login and logout from edDesk 

•	 navigate accurately through edDesk 

•	 use Views to list articles that meet certain criteria 

•	 search for articles from within Views 

•	 create new articles 

•	 create a hierarchy of related articles 

•	 use the edDesk workflows to manage the progress of your 
articles 

•	 edit articles and subarticles 

•	 attach files in various formats to your articles 

•	 import and insert images into your articles 

•	 cancel articles when they are no longer required 

•	 edit homepages 
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•	 replicate your databases and know when replication has 
occurred successfully 

•	 add your most often used databases to your Favorites 

•	 create and maintain a Folder structure so you can quickly access 
your articles 

•	 print Views and articles 

After attending the introductory course you are eligible to attend an advanced 
training session.  By the end of the advanced training session you will be able to: 

•	 create simple Views to list articles fulfilling particular criteria 

•	 create simple "Agents" to automate some processes for you 

•	 delete Agents that you have created but no longer need. 

Specialised courses 
These courses are not yet available. 

1.3 	 INTENDED AUDIENCE 

This user guide and accompanying training course are intended for those people who 
have not used edDesk before but now need to use it to write and edit articles and 
prepare those articles for publishing - in various media formats. 

It is not intended for those people involved in the technical setup and support of 
edDesk. 

1.4 	 ABOUT THIS USER GUIDE 

This user guide instructs you in how to use the most common features of the Lotus 
Notes version of edDesk. 

This user guide is structured so that you: 

•	 first learn the various ways of viewing content that is already in edDesk and 
then 

•	 learn to create your own content (called articles). 

The primary goal of this guide is to be a reference for you when you have returned 
to your work location. It will be referred to during training courses, but not followed 
cover to cover. 

Appendices introduce you to some of the more “advanced” features of edDesk.  
Some people will not need to learn these features, others may wish to attend a more 
specialised training course, dealing with just those features. 

1.5 	 NOTATION CONVENTIONS 

This guide uses the following notation conventions: 

Bold 	 screen names and for general emphasis 

Italics 	 Menu option that you select 
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Bold courier 	 edDesk tabs and article tabs (article tabs are tabs 
within an article) 

Field names Lucida sans 
console 

<italics> 	 button to be clicked to get to the next step 

Courier 	 text of on-screen messages and prompts 

century gothic 	 used for examples 

Used for important points and handy hints thatbordered century 
gothic you should try to remember! 

i Spelling 
Australian English is used throughout this guide, except where Lotus Notes menus 
use American English. 

ii Control keys 
If you see an instruction written like “Press <Ctrl>+b” then you hold down the 
<Ctrl> key while you press the letter after the plus sign. 
For example, <Ctrl>+b means hold down <Ctrl> while you press b, then let both keys 
go. 

1.6 TERMINOLOGY 

The terms listed alphabetically below are mentioned only in context of their 
relationship to edDesk. 

Article 	 Each story is called an article. 

Database 	 The collection of articles for your organisation.  An organisation may have 
several databases – often one for “production” (real articles, to be 
published); one for “playing” (often used for training, or experimenting 
with new features). Your organisation may also have separate databases 
for large projects. 

edDesk 	 The application you use to create and edit articles and to manage the 
workflow for the publishing of those articles 

Form	 Any page that requires you to enter information so that content can be 
updated and saved. 

Menu 	 A list of options that drops down (opens) when you click on the menu 
name.  For example, the Tools menu in the article toolbar. When you click 
on Tools a list of options opens for you. 

Menu – Lotus 	 Menu that appears along the top of your Lotus Notes window.  Different 
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Notes menus are displayed depending on what you are doing in edDesk. 

Navigation 
pane 

The menu down the left side of your screen.  Options vary depending on 
which tab you have opened (and your organisation’s requirements). 

Subarticle / 
Related article 

Large articles may be broken into smaller parts, called subarticles or 
related articles.  Subarticles are “children” of articles. 
For example if you are reviewing digital cameras you may want each 
camera reviewed to be in a separate subarticle.  They can be reordered 
easily within the article structure. 

Tab List of windows you have opened in edDesk.  Appears along the top of 
your edDesk screen. 

The first tab you normally see is the Home tab. 

In addition each article has a set of tabs that allow you to enter specific 
types of information. 

Toolbar A list of options that you can select, displayed horizontally. 

Toolbar – The toolbar that appears along the top of an article. 

View A way of organising the display of articles in a relevant manner.  For 
example, if you are in the Creating tab you can organise your content by 
Story Idea, Active Briefs, Filed Copy. 

Workflow Where an article is up to in the entire production process – ranging from 
story concept to published. 

article 
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2.	 Publishing steps in a nutshell and how they 
relate to edDesk 

This chapter outlines the publishing steps (briefly) and how it relates to what you 
need to do in edDesk. 

2.1 	 GENERAL PUBLISHING PROCEDURES 

Step What needs to be edDesk procedure Chapter in User 
done Guide for more 

information 

Step 1 Decide on what None yet 
story is needed 

Step 2 Write story brief Create a New Article 	 Chapter 6 – Creating 
an article that is ready Fill in the details in the for briefing outBasics and Brief tabs 

Brief details include 
instructions on length, 
payment, briefing 
instructions and illustration 
instructions, copy deadline, 
copyright options 

Step 3 Send brief to Email using edDesk’s Chapter 6 – section 
desired author Brief tab. 6.5 – Briefing out 

your article 

Step 4 Author writes Can write article in edDesk 
article (if they have access to 

edDesk – determined by 
your organisation). 

If no access to edDesk, copy 
written in MS Word then 
emailed to the sub-editor. 

Chapter 7 – Editing 
articles – entering 
copy into edDesk. 

Chapter 8 – 
Formatting text 

Chapter 9 – Including 
documents and images 
in articles 

Step 5 Author submits 
article 

If article written in edDesk 
then submitted via edDesk 

Chapter 13 – 
Workflows 

and workflow updated to 
reflect that copy has been 
Filed. 

If article is not written in 
edDesk, article submitted by 
email (eg. as Word 
attachment in email) 
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Step What needs to be 
done 

edDesk procedure Chapter in User 
Guide for more 
information 

Step 6 Sub-editor or 
production-editor 
loads received 

Edit article that was created 
for the briefing instructions. 
Add the text of the 

Chapter 7 – Editi
articles – entering 
copy into edDesk. 

ng 

content into 
edDesk 

submitted copy.  Update 
workflow of article. Chapter 8 – 

Formatting text 

Chapter 9 – Including 
documents and images 
in articles 

Chapter 13 -
Workflows 

Step 7 Sub-editor edits 
copy in edDesk 

Make appropriate changes 
to the uploaded copy. 
Update workflow of article. 

Chapter 7 – Editing 
articles – entering 
copy into edDesk. 

Chapter 8 – 
Formatting text 

Chapter 9 – Including 
documents and images 
in articles 

Chapter 13 – 
Workflows 

Step 8 Graphic artist 
does layout 

Edits edDesk article, takes 
out any attached files, 
creates pages using Quark 
and Indesign. Creates PDF 
of finished pages and 
attaches the PDF to the 
edDesk article. Update 
workflow of article. 

Chapter 9 – Including 
documents and images 
in articles 

Chapter 13 -
Workflows 

Step 9 Sub-editor does 
final check of laid 

Reviews completed edDesk 
article with attached PDF. 

out pages, 
pictures, captions 
etc 

Step 10 Sub-editor 
requesting 
changes to article 
(not always 
required) 

Comments entered into the 
PDF (not the edDesk 
article). 
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Step What needs to be edDesk procedure Chapter in User 
done Guide for more 

information 

Step 11 Editor does finals Update workflow details in Chapter 13 – 
edDesk article. Workflows 

Step 12 Publish article 	 Update workflow for the Chapter 13 – 
intended publishing format. Workflows 

Articles to be published to 
the web will be published 
automatically when the 
workflow status is changed 
to “posted”. 

2.2 TYPICAL ROLES AND EDDESK KNOWLEDGE/SKILLS REQUIRED 

Role 	 Relevant chapters /sections in this User Guide 

All roles 	 Chapter 1 – Introduction 

Chapter 2 – Publishing steps and how they relate to 
edDesk 

Chapter 3 – Getting started 

Chapter 4 – Views 

Chapter 5 – Searching for articles 

Author / Contributor 	 In addition to those chapters listed for All roles: 

Chapter 6 – Creating an article that is ready for 
briefing out (not all authors will need to know how to 
do this) 

Chapter 7 – Entering copy into edDesk 

Chapter 8 – Formatting text 

Chapter 9 – Including documents and images in 
articles 

Chapter 10 – Article toolbar – Tools, New, Import, 
Export. Particularly sections 10.2 Tools menu and 
10.3 Import menu. 

Chapter 12 – Creating hierarchical content – related 
articles 

Chapter 13 – Workflows – only section 13.2 Workflow 
for authors 

Sub-editor and Editor In addition to those chapters listed for All roles: 

Chapter 6 – Creating an article that is ready for 
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Role Relevant chapters /sections in this User Guide 

briefing out 

Chapter 7 – Entering copy into edDesk 

Chapter 8 – Formatting text 

Chapter 9 – Including documents and images in 
articles 

Chapter 10 – Article toolbar – Tools, New, Import, 
Export 

Chapter 11 – Using article tabs 

Chapter 12 – Creating hierarchical content – related 
articles 

Chapter 13 – Workflows 

Chapter 14 – Housekeeping 

It is a good idea to be familiar with: 

Chapter 15 – Folders 

Chapter 18 – Webifying your article – Getting ready to 
publish on the web 

Chapter 19 – Printing edDesk content 

Administrators Entire User Guide 

Webmaster Entire User Guide 
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3.	 Getting started – becoming familiar with 
edDesk screens 

3.1 	 OBJECTIVES 

By the end of this chapter you should be: 

•	 able to login to edDesk 

•	 familiar with the left navigation pane 

•	 aware of the most commonly used tabs in edDesk 

•	 able to logout of edDesk. 

3.2 	 EDDESK CONCEPTS 

There are two basic components in edDesk.  These are: 

•	 Articles: this is where you create and edit content.  You 
complete “article forms” then can later change the content in 
your forms; AND 

•	 Views: Views let you control the way you display your content. 
For example, in the Creating tab you can order your articles by 
author, issue or keyword.  Under the Production tab you can 
look at articles that have layout instructions, requests for change 
or that are being sub-edited. 

edDesk displays relevant menu items depending on the tab you are using.  Each 
menu item has a brief description.  This lets you quickly select the part of edDesk 
that you want to use. The menu items are repeated in the left navigation pane. 

3.3 	 LOGGING IN TO EDDESK 

1.	 Click on your Lotus Notes icon. 

2.	 The following login form displays, with your user name and organisation. 

Figure 1: edDesk Lotus Notes login screen 

3.	 Type your password. 

4.	 Click on <OK>. The Home tab displays. 
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3.4 EDDESK TABS
 

Figure 2: edDesk Home tab for the itechne Intranet 

Each tab has three main components: 

• navigation pane 

• tab bar 

• body 

Navigation pane 	 Lets you access the various views of editorial content for 
your organisation. You can choose what you want to see, 
depending on pre-defined criteria, (known as Views).  Late 
versions will let you Search for articles which meet your 
own criteria. 

You also use this pane to create new articles, view your 
articles, and schedule meetings. 

Tab bar 	 Provides a quick way to go to different areas of activity in 
edDesk. 
For example, Editing tab provides the tools most commonly 
used by editors.  Production tab groups together all the 
activities and information relating to production of the 
articles, with particular regard to illustration and layout 
requirements. 

If you do not have access to a particular tab can see the Tab 
name, but you will not be able to select it. 
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Body 	 The body is where the most commonly used features of that 
tab are listed. 

i Navigation pane 
The options you see in the navigation pane change as you move to different tabs in 
edDesk. 
For example if you are in the Setup tab you see navigation options relevant for 
Setup, in the Creating tab you see options relevant for creating content. 

There are standard collapsible menus available in each tab, meaning that no matter 
which tab you are using, you can still perform the most common functions. 

The following options are available in each tab: 

• New article 

• New library item 

• New meeting (uses the calendar feature – being upgraded) 

• Team tools (some variations within the menu) 

• Content 

 Team tools 

There are various tools available to members of a team.  These include seeing those 
emails sent by team members, deadlines (approaching and past), bulletin board for 
interesting items and a calendar of team member commitments.  The tools vary 
depending on which tab you have selected. For example, the tools in the Creating 
tab are different to the tools in the Production tab.

 Content 

This is where you can see specific content for your organisation, using pre-defined 
"views" and structures of content.   
For example, you can view by Authors, Sections, Issues - depending on your 
requirements.  You can also select to view All Documents. 
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Tabs – an overview 
Think of tabs as part of the publishing process. For example, if you want to create 
articles you would use the Creating tab.  If you were involved in the editing of 
articles you would use the Editing tab more than other tabs. 

Each tab has options relevant to the publishing stage of which it is part. 

Brief descriptions of each tab follow: 

Home 

Home is the first tab to display when you login to edDesk.  The Home tab lets you 
quickly do the most fundamental operations in edDesk. 

Tools available in the Home tab are: 

•	 New article 

•	 New library item 

•	 New meeting – this feature is being upgraded 

•	 View team calendar – this feature is being upgraded 

•	 Easy content selector 

•	 My active briefs – stories assigned to you 

•	 My articles 

•	 My article by issue 

Creating 

The Creating tab has many of the tools used by writers.  This tab is also used to 
view the progress of new articles. Tools available in the Creating tab are: 

•	 New article 

•	 New library item 

•	 New homepage (for web publishing) 

•	 Story ideas – ideas for stories that have not yet been commissioned 

•	 Active briefs – stories that have been commissioned but not yet 
filed 

•	 Filed copy

 Editing 

The Editing tab has many of the tools used by editors.  These include views for: 

•	 Late running copy 

•	 Active briefs 

•	 Filed copy 

•	 Ready for production 
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•	 Changes required - stories requiring rewrites or edits, and the 
status of those stories 

•	 Unassigned copy - stories currently unassigned to an issue. 

Production 

The Production tab has many of the tools used in the final production of an 
article. This tab includes views for the following information: 

•	 Subs work desk - articles being subbed 

•	 Changes required 

•	 Artist and illustration requirements 

•	 Production directions 

•	 Production schedules 

•	 Deadline calendars.

 Setup 

The Setup tab is for non technical administration of edDesk.  Information entered 
in this tab becomes available to be used in articles.  You can: 

•	 create, view and edit sections 

•	 create, view and edit subsections 

•	 create volume and issue definitions 

•	 create, view and edit geographical regions 

•	 define production schedules 

•	 create, view and edit keyword topics 

•	 create, view and edit definition documents for a publication. 
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4. Views 

Views are a way of looking at and sorting articles.  There are many views available 
in edDesk and the most popular are available from the body of the relevant tab. 

That is, if you are using the Creating tab you will have different views listed in the 
body of your screen to those in the Editing tab. Other views are available, but the 
most popular are listed in the body of the page. 

edDesk is usually customised for your organisation, so some of the views listed in 
this user guide may not be available to you.  However, the techniques and concepts 
involved in using views are always the same. 

4.1 OBJECTIVES 

By the end of this chapter you should be: 

• familiar with views from the Creating tab 

• familiar with views from the Editing tab 

• familiar with views from the Production tab 

• able to select views from the navigation pane 

• able to sort your results by various criteria. 

4.2 WHY DO I NEED VIEWS? 
Views let you find and organise your articles easily and quickly. They also let you 
track the editorial status of articles.  They are an extremely useful tool for managing 
the flow of articles through the publishing process. 

If you have a particular article listed in a view, you can select that article and (if you 
have access) edit it, pass it to the next stage of the workflow and manage the 
progress of that article. 

Some views simply display their results as soon as you click on the view name.  
These include the views selected from the body of the Home, Creating, Editing, 
and Production tabs. 

If you prefer to use your own criteria for viewing articles you would use the 
Easy Selector, available from the left navigation pane on all tabs. 

4.3 WHERE DO VIEWS GET THEIR INFORMATION FROM? 
Views use various criteria to display articles that match those criteria.  The 
information used in views is entered into each article.  If information has not been 
updated in the article, then that article will not be listed in the view results.  Many 
views check the Workflow tab to find articles that match particular statuses, or have 
editing notes and change requests made. 

For example, the view Filed copy lists all articles that have a status of Filed. This 
information is entered by either the article author or editor into the Workflow tab.  If 
an article has been filed, but the status not updated in the Workflow tab then 
that article will not be listed in the view. 

4-1 



 
 

 

 

 
 

 
 
 

 

 

 

 

 

 

 

 
 

 

 

 

edDesk (Lotus Notes) User Guide 

Make sure your articles are updated correctly so that they are listed in the relevant 
views. 

4.4 	 GENERAL INFORMATION ABOUT USING VIEWS 

i 	 Selecting a view 
1.	 Go to the required tab (for example, Home, Creating, Editing). 

2.	 Look at the body of the page. 

3.	 Click once on the required view. 

4.	 Your results are displayed. 

ii 	 Display of results 

Order of listed articles 

Results are ordered by: 

•	 To Be Assigned (to an issue) 

•	 Issue date (descending order – most recent/future issue at the top 
of the list) 

•	 Alphabetically by Library entry 

Arrow next to article 

Several views show an arrow next to some articles.  The arrow indicates that there 
are articles related to the one shown. 

Figure 3: Note right pointing arrow indicating subarticles 

1.	 Click on the arrow. 

2.	 The related articles are now listed. This is known as expanding the view.  
The arrow changes from a right-pointing arrow to an arrow pointing down. 

Figure 4: Note downward arrow indicating that you are now displaying the expanded list, 
with subarticles 

3.	 Click on the arrow again to collapse the view. 
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 Horizontal scrolling 

Many views display their results in a table.  Often you will need to scroll 
horizontally to see the full summary of the article. 

Figure 5: View results showing horizontal scrollbar across bottom of results table 

If you don’t want to scroll horizontally: 
1.	 Click once on the article for which you want to view more details. 

2.	 Move the mouse over the desired article. 

3.	 Wait a couple of seconds. A popup window displays the details of the 
article. 

Figure 6: Popup after moving mouse over article - showing detail available through 
horizontal scrolling 
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Expanding and collapsing your results 

Many views are collapsed when you first select them.  This means that all you really 
see are categories of results and you need to drill down through them to the 
particular articles you wish to view. The drilling down is known as “expanding” 
your view. 

Views that are expandable and collapsible have the following toolbar along the top 
of the view. 

Below is an example of a collapsed and expanded version of the same view. 

Figure 7: Collapsed version of the All issues view 

Figure 8: Expanded version of the All issues view 

Expanding your entire results 
1. Click on <Expand>. 

2. All items in your view are expanded. 
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Collapsing your entire results 
1.	 Click on <Collapse>. 

2.	 All items in your view are collapsed. 

Note 

When you click on <Expand> or <Collapse> all items in your view are expanded or 
collapsed. You cannot expand or collapse only part of a view. 

Drilling down through a view 

If your view has returned a long list you may not want to expand the entire view.  
You may drill down through a part of the view. 

1.	 Scroll to the category you wish to expand. 

2.	 Click on the next to the category. 

3.	 That category is expanded and the changes to a . 

4.	 Repeat steps 1, 2 and 3 until you have drilled down to the required article. 

Information displayed in a view 

Going from left to right: 

•	 Volume and Issue number 

•	 Section that article has been entered under.  Sections are used to 
categorise articles.  For example you might have a Corporate 
section with subsections for Information Technology, Human 
Resources and so on. 

•	 Subsection: article description. 

•	 Number of words in the article (only words entered in the body 
of the article are counted). 

•	 Author name 

•	 Checkout – whether the author has marked the article so that 
changes can only be made by the author. 

•	 Production – gives status of the article for printing and web.  
Status is taken from the Workflow tab of the article. 

4.5 	 EASY SELECTOR 

This is the most powerful and versatile view available.  You can enter your own 
criteria for articles to view. 

The Easy Selector lets you quickly filter articles by the following criteria, and the 
associated sub-criteria: 

•	 Volume/Issue 

•	 Authors 

•	 Keyword topics 
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•	 Copy status 

•	 Sections 

•	 Companies 

•	 Regions 

Important to put your keywords into articles 

When you create an article it is important that you use as much classification 
information as you think you will need.  It is used by the Easy selector. 

For example, you might want to list all articles that are to do with the keyword Main 
Topic “Business”, with Sub Topic “Human Resources”.  Only articles which have had 
the keywords attached will be found. 

See chapter 11.3: Classification tab for more information. 

1.	 Move your mouse to the left navigation pane. 

2.	 Click on Easy selector. 

3.	 The default Easy selector view displays, listing articles by Volume/Issue.  
The default display is collapsed. 

Figure 9: Easy selector default view - collapsed 

4.	 You can expand your view by clicking on the arrow next to the required 
issue. 

L See section 4.4ii: Display of results: Arrow next to article for more 
information on expanding and collapsing views. 
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Figure 10: Easy selector default view - expanded 

Setting your criteria in the Easy selector 
1.	 Go to the Easy selector. 

2.	 Click on the dropdown arrow under Information to display. 

3.	 Select the required information.  Another dropdown menu is now available 
for subcriteria. 

4.	 Select the subcriteria. 

5.	 Click on <Display Selection>. 

6.	 All articles matching your criteria are listed. 
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 Example 1: 

The diagram below shows the following selections: 

•	 Information to display: Companies 

•	 Subcriteria dropdown: all companies entered into edDesk 

Figure 11: Easy selector after selecting Information to display “Companies”, but before 
selecting a particular company 

 Example 2: 

The diagram below shows the following selections: 

•	 Information to display: Keyword topics 

•	 Subcriteria dropdown: Main topic: Education; Subtopic: Reference 
manuals 

Figure 12: Easy selector after selecting Information to display “Keyword topics”, with Main 
Topic "Education" and Sub Topic "Reference manuals" 
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4.6 	 VIEWS FROM THE NAVIGATION PANE 

There are several views that are always available from the navigation pane, (no 
matte which tab you have selected).  These views are: 

•	 Easy selector.  L see section 4.5: Easy Selector for more 
information. 

•	 All Issues 

•	 Keywords 

•	 Authors 

•	 Library items. 

There are several other views available from the navigation pane in some tabs.  
These views are: 

•	 Sections 

•	 Current issues 

•	 Companies 

•	 Biographies 

• All Documents. 

These views automatically display their results when you click on the view title.  
L see section 4.4: General Information about Using Views for more information. 

i 	 All issues 
Articles are listed by Volumes and Issues.  The results are categorised by: 

1. Volume 

2. Issue 

3. Section 

4. Articles 


You may expand and collapse this view. 


ii 	 Keywords 
Articles are listed by keywords and subtopics.  Keywords and their subtopics are 
ordered alphabetically. You may expand and collapse this view. 

iii 	 Authors 
Articles are listed by author. Expand the list to view all articles by a particular 
author. The view includes a word count for each article and the total number of 
words in articles by that author. 

iv 	 Library items 
Library items are standard items that you might want to re-use in your entire 
publication and database. They are particularly useful if you are publishing to the 
web. 
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Your system administrator will usually maintain library items. 

Typical library information includes contact information, guidelines for authors and 
standard code. Library items are ordered by category.  The category is selected 
when the library item is created.  Available categories are determined by your 
database administrators. 

v 	 Sections 
Articles are listed by section and subsection.  Sections and subsections are listed 
alphabetically. You may expand and collapse this view. 

vi 	 Current Issues 
Only articles in the current volume and issue are listed.  You may expand and 
collapse this view. 

vii 	 Companies 
Articles are listed alphabetically by the company with which they are associated.  
Companies are entered in the Classification tab of each article. You may 
expand and collapse this view. 

viii 	 Biographies 
Biographies contain information about authors and team members.  Position status, 
job title, contact details are contained in the author biography.  Authors are listed 
alphabetically by first name. 

ix 	 All Documents 
All Documents lists all entries into your database.  This view is particularly useful if 
you have created an item, but cannot remember if it is an article, a library item, 
items added to classifications.  Items are listed by descending date order (most 
recent item at the top of the list). 

4.7 	 VIEWS FROM THE HOME TAB 

Available views are: 

•	 Easy selector.  L see section 4.5: Easy Selector for more 
information. 

•	 My active briefs 

•	 My articles 

•	 My articles by issue 

i 	 My active briefs 
View articles that have been briefed to you, but which you have yet to file.  These 
are generally articles that you are still working on.  This view gives you a good way 
to track your articles through the production cycle.  All articles where you are 
entered in the Author field in the Brief tab are listed. 
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Displayed by selecting: 

•	 My work > My active briefs from the navigation pane OR 

•	 My active briefs from the body. 

When you first select this view, you see your articles with a status of briefed.  You 
may change the status and author. 

Figure 13: Default details - my briefed articles 

Changing the articles you view 

1.	 Click on the dropdown arrow next to Show articles for this status. 

2.	 Scroll down to the status of articles you wish to view. 

3.	 Click on the required status. 

4.	 Show articles for this author: If you want to display articles for another 
author, type the author name. 

5.	 Click on <Display selection>. 

My articles 

This view lists all articles where you are entered in the Author field in the Brief 
tab. They are sorted by date. 

Displayed by selecting: 

•	 My Work > My articles from the navigation pane OR 

•	 My articles from the body. 
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iii My articles by issue 
This is currently the same as the All Issues view and is being amended. 

4.8 VIEWS FROM THE CREATING TAB 

Views accessed from the Creating tab show the progression of new articles 
through the publishing process. These views are: 

• Story ideas 

• Active briefs 

• Filed copy 

i Story ideas 
This view lists all articles with at Concept stage.  Concept is the initial stage of an 
article – before it has been briefed to an author.  The Workflow tab has a Copy 
status of Concept. 

Displayed by selecting: 

• Creating > Story Ideas from the navigation pane OR 

• Story ideas from the body. 

Articles are listed in descending order by issue date then alphabetically by Section 
and Subsection. 

Figure 14: View Story ideas. 

In the diagram above, 2005:8 would be August 2005. Articles which have yet To Be 
Assigned (TBA) to an issue will be at the top of the list. 

Active briefs 
This view lists all articles that have been commissioned, but not yet filed by the 

author. Overdue articles are also listed; however there is another view specifically 

for overdue articles. The Workflow tab has a Copy status of Briefed. 


Displayed by selecting:
 

• Creating > Active Briefs from the navigation pane 

• Active briefs from the body. 

Articles are listed in descending order by issue date, then alphabetically by Section 
and Subsection. 
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iii 	 Filed copy 
This view lists all recent articles that have a status of filed. The Workflow tab has a 
Copy status of Filed. 

Displayed by selecting: 

•	 Creating > Filed Copy from the navigation pane OR 

•	 Filed copy from the body. 

Articles are listed in descending order by issue date, then alphabetically by Section 
and Subsection. 

4.9 	 VIEWS FROM THE EDITING TAB 

Available views are: 

•	 Late running copy 

•	 Active briefs 

•	 Filed copy 

•	 Ready for production 

•	 Changes required 

•	 Unassigned copy 

i 	 Late running copy 
This view lists all articles that have not been filed by their copy deadline.  The copy 
deadline date is entered by the article creator in Copy deadline field in the Briefs 
> Details tab. 

Displayed by selecting: 

•	 Editing > Late copy from the navigation pane OR 

•	 Late running copy from the body. 

Articles are listed in descending order by issue date, then alphabetically by Section 
and Subsection. 

ii 	 Active briefs 
This view lists all articles that have been commissioned, but have not yet been filed 
by authors. Overdue articles are also listed; however there is another view 
specifically for overdue articles. The Workflow tab has a Copy status of Briefed. 

Displayed by selecting: 

•	 Editing > Active Briefs from the navigation pane OR 

•	 Active briefs from the body. 

Articles are listed in descending order by issue date, then alphabetically by Section 
and Subsection. 
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iii 	 Filed copy 
This view lists all recent articles that have been filed by authors.  The Workflow tab 

has a Copy status of Filed. 


Displayed by selecting:
 

•	 Creating > Filed Copy from the navigation pane OR 

•	 Filed copy from the body. 

Articles are listed in descending order by issue date, then alphabetically by Section 
and Subsection. 

iv 	 Ready for production 
This view lists all recent stories which have been edited and are ready for subbing.  

The Workflow tab has a Copy status of Submitted. 


Displayed by selecting:
 

•	 Editing > Production ready from the navigation pane OR 

•	 Ready for production from the body. 

Articles are listed in descending order by issue date, then alphabetically by Section 
and Subsection. 

v 	 Changes required 
This view lists all articles needing re-writes or edits, and the status of those articles.  
Information is taken from the Workflow > Change Requests tab. If the 
Change Requests tab is not filled in the articles will not be listed in this view. 

Displayed by selecting: 

•	 Editing > Changes required from the navigation pane OR 

•	 Changes required from the body. 

Information displayed is the Volume and Issue number, Section, Article Description.  
Other information is: 

•	 Change status: indicates whether the change has been requested, 
acknowledged and/or completed. 

•	 Sent status: indicates whether a copy of the change request has 
been sent to the author. 

•	 Changes: the changes that are required. 

Figure 15: Changes required view 
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Unassigned copy 
This view lists all articles which have not been assigned to a particular issue. 

Displayed by selecting: 

• Editing > Unassigned copy from the navigation pane OR 

• Unassigned copy from the body. 

Many items listed here will be library items – that is, articles that store standard 
templates and formats which you will use across a publishing title, especially one on 
the Web. 

Figure 16: Unassigned copy - showing articles that have not been assigned to a volume or 
issue 

4.10 VIEWS FROM THE PRODUCTION TAB 

Views from the Production tab are mainly used to track articles that have been 
submitted for editing and are now closer to publishing.  Views include: 

• Subs work desk / Subbing 

• Changes required 

• Artist and illustration requirements / Layout 

• Production directions (same as Artist and illustration requirements) 

• Production schedule 

• Deadline calendar (feature being refined) 

• Simple export 

• Website homepages 
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Subs work desk 
This view lists recent stories that have been submitted and are in the process of 
being sub-edited. The Workflow tab has a Copy status of Submitted. 

Displayed by selecting: 

• Production > Subbing from the navigation pane OR 

• Subs work desk from the body. 


Icons next to the article title indicate: 


•  Editing note has been entered. The text of the note is in the 
Notes field of the view. 

•  The article is checked out.  This means that only the person 
who checked it out can save changes). 

If an article is both checked out and has an editing note only the checked out icon 
displays. 

Articles are listed in descending order by Volume and Issue, then alphabetically by 
Section and Subsection. 

Figure 17: Expanded view of Subs work desk.  One article has an editing note; the other is 
checked out and also has an editing note. 

 Editing notes 

•	 Articles: Editing notes are entered in the Workflow > Editing
notes tab. 

•	 Subarticles: Editing notes are entered in the Workflow tab and 
Editing notes field. L see section :13.4 Editing notes  for more 
information. 

If the author has Acknowledged or Completed the tasks in the editing note the 
Acknowledgement/Completion is indicated after the text of the editing note.  For 
example, Please detail in what ways this dynamite will be attractive only to coyotes 
[Acknowledged]. 
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Figure 18: Detail of notes field showing note text and that the editing note has been 
Acknowledged 

Changes required 
This view lists articles that need rewrites or edits.  Information is taken from the 
Workflow > Change Requests tab. If the Change Requests tab is not filled 
in the articles will not be listed in this view. 

Displayed by selecting: 

• Changes required from the body. 

Note 

Subarticles are not listed in this view. Subarticles do not have a separate Changes
Requests tab.  If changes are requested in subarticles they are entered in the 

Changes field in the workflow tab. 
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Information displayed is the Issue number, Section and Description of the article.  
Other information is: 

•	 Change status: indicates whether the change has been requested, 
acknowledged and/or completed. 

•	 Sent status: indicates whether a copy of the change request has 
been sent to the author. 

•	 Changes: the changes that are required (this is entered in the 
Workflow > Change Requests tab. 

Figure 19: Changes required view 

Artist and illustration requirements 
This view lists illustration requirements, indicates whether images have been 
attached to an article and also displays any production directions.  Information is 
taken from the Paper tab. 

Displayed by selecting: 

•	 Production > Layout from the navigation pane OR 

•	 Artist and illustration requirements from the body. 

Figure 20: Artist and Illustration requirements view with checked out article selected 

Information displayed includes: 

•	 Volume and Issue Number, Section, Subsection and Description 

•	 Checkout: (if the article is checked out the name of the person to 
whom it is checked out is displayed). There is also a padlock icon 
at the left of the article description. 
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•	 Filename: if you choose to export the file to another program 
edDesk suggests a filename.  The format of this filename is First 
letter of Section, first letter of subsection, then first word and first 
two letters of second word from the article description. 
For example you have a file in Section: Resources, Sub section: 
Reference materials and Description: Acme corporation… edDesk 
would suggest a filename of rr_acmeco. 

•	 Illos: Illustration instructions are here.  A paperclip icon indicates 
that there are attached images. 

•	 Production: Displays any production directions. 

iv 	 Production directions 
This is the same as the Artist and illustration requirements view and is being 
amended. 

v 	 Production schedule 
This view lists issue dates, deadlines and important dates. 

Displayed by selecting: 

•	 Production > Schedule from the navigation pane OR 

•	 Production Schedule from the body. 

You can define new issues in this view. Issues must be defined before they can be 
selected and added to an article (Volume and Issue are mandatory fields in articles).  
L see section 20.5: Production schedule – volume and issue definitions for more 
information. 

Issues are listed in the order in which they were entered into edDesk.  This is usually 
with the oldest issue at the top of the list. 

Figure 21: Production schedule view 
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Information displayed includes: 

•	 Serial: only used in edDesk – each issue is assigned a sequential 
number used to order the issues. 

•	 IssueCheck: displays the Volume:Issue details.  For example 
2003:7 would be Volume: 2003 Issue number 7. 

•	 Volume: volume of publication. 

•	 Issue: Issue number 

•	 Cover: Date that will appear on the cover of a printed article. 

•	 Onsale: Date the publication goes on sale 

•	 Copy: Date by which copy must be submitted for editing. 

vi 	 View deadline calendar 
This feature is being reviewed. It currently displays no information. 

vii 	 Deadlines 
This view lists deadlines, with the most recent/future deadline at the top of the list 
and the oldest deadline at the bottom. Deadlines is important for managing the flow 
of articles through edDesk and for checking that your team is on schedule to meet 
production targets. 

Displayed by selecting: 

• Production > Deadlines from the navigation pane. 

Deadline dates are taken from the Copy deadline field in the Briefs > Details 
tab. 


You can add new articles and edit existing articles from this tab. 


Information displayed includes: 

•	 Deadline: Date specified for the article to be filed. 

•	 Subject: Subject of the article. 

•	 Status: Article status (from the Workflow tab). 

•	 Author: article author. 

•	 Issue/Section: Information is Volume/Issue/Section/Subsection. 
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viii 	 Simple export 
This view lets you select an article and export it to your computer in the following 
formats: 

•	 ASCII text file – very basic formatting only.  Your fonts, lists etc 
are not retained. 

•	 RTF (Rich Text Format) – retains your formatting.  Do not use this 
if you have images attached or imported into your article as they 
do not display correctly. 

•	 CGM (Computer Graphics Metafile) – only use this if your article 
contains CGM images. 

•	 TIFF (image) – only use this if your article contains bitmap 
images. 

Displayed by selecting: 

• Production > Simple Export from the navigation pane. 

1.	 Select Simple Export from the navigation pane. A list of all the articles in 
your database is displayed. 

Figure 22: Simple Export view. 

2.	 Double click on the article you want to export to another format.  The 
article opens in an Export tab. 
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Figure 23: Article is opened and you can now export it to a different format.  The 
article in this screen capture has one attached image and one imported image. 

3.	 Click on <Export>. An Export dialogue box displays with the export 
directory being the directory you used most recently. 

4.	 Navigate to the directory to which you want to export your file. 

5.	 File name: Enter a filename for your exported file. 

6.	 Save as type: Select a file type from the list.  Your choices are: 

•	 ASCII text 

•	 CGM image 

•	 Microsoft RTF 

•	 TIFF 5.0 image 

7.	 Click on <Export>. 

8.	 If you selected the ASCII filetype the Text File Export dialogue box is 
displayed, letting you select options for this filetype. 
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Figure 24: Text File Export dialogue box. Best to leave the options as the default 
ones (as shown). 

9. Leave the options as they are – it will work just fine! 

10. Click on <OK>. 

11. Your file is exported. 

Homepages 
Important 

Only use this option if you are creating or editing homepages for internet or intranet 
sites. 

L see Chapter 14: Editing homepages for instructions on maintaining homepages. 

4.11 VIEWS FROM THE SETUP TAB 

Views from the Setup tab are used for the non technical administration of edDesk.  
This is mainly for adding items that appear in dropdown lists within articles. 

L see Chapter 20: Non-technical administration of edDesk for instructions on using 
the Setup tab. 
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5.	 Searching for articles 

You can search for articles that match your criteria.  You must be in a view to search 
for articles.  Later versions of edDesk will let you search from the navigation pane, 
without having to select a view to search in.  This will mean that you can easily 
search your entire database. 

5.1 OBJECTIVES 

By the end of this chapter you should be able to: 

• open the search bar from within a view 

•	 enter words and phrases as your search criteria 

•	 use the Boolean operators – AND, OR, NOT 

•	 use wildcards 

•	 use a simple search to find articles containing particular words 

•	 use the advanced search feature to find articles matching criteria 
that you specify. 

5.2 	 SEARCHING IN VIEWS 

You can use the Search form in many views to list only those articles that match 
your criteria. 
For example, you have selected the view All Issues but only want to view those 
articles which contain the word “payroll”.  You would use Search to list only those 
matching articles. 

Views filter the articles so only those that match the view criteria are displayed.  
When you use Search you are refining the criteria and looking for articles in that 
view. 

Searching all articles 

Use the view All Issues (available from the Navigation pane in every tab) if you want 
to search through your entire database. 

Searching all entries 

Use the view All Documents (available from the navigation pane in the Home tab) 
to list all items in your database.  This is particularly useful if you have created an 
entry and cannot remember where you put it (ie. What section and subsection, 
volume or issue you entered) or whether it was created as an article or library item. 
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5.3 OPENING THE SEARCH BAR 

You need to open the Search bar before you can conduct your search. 

1. Go to the view in which you want to search. 

2. Click on <Search Bar>. 

3. The Search bar displays, as below. 

Figure 25: Search bar in view "Sections" 

5.4 TEXT SEARCH OPTIONS 

This section instructs you how to format your search text.  All text entered is entered 
in the Search for field. 

i Searching for a single word or a phrase 

1. Put your cursor in the Search for field. 

2. Type the word or phrase to search for. 

3. Click <Search>. 

Common words 

If you search for common words you will probably return a long list of matching 
articles.  Then you either have to navigate to the ones you want, or try to further 
refine your search. 

Very common words, such as “the” will be ignored by the search engine. 

Using Boolean operators – AND, OR, NOT 
edDesk’s operators are similar to the Boolean operators used by most search engines 
on the web. They are not case sensitive – AND, and, And are the same. 

AND 

The AND operator finds articles which contain all the words linked by AND.  The 
words may appear in any order, in phrases or in isolation. 
Example 1: digital AND camera AND quality will find all articles that contain all three 
words. 

Example 2: digital camera AND quality will find all articles that contain the phrase 
‘digital camera’ and the word ‘quality’. 

1. Click in the Search for field. 

2. Type the first word or phrase. 

3. Type AND. 

4. Type the next word or phrase. 

5. Repeat steps 3 and 4 until you have typed all the words to search for. 
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6. Click <Search>. 

OR 

The OR operator finds articles which contain either of the words or phrases.  Your 
results are listed in order with the most occurrences at the top of the list. 

The OR operator returns a longer list of articles than the AND operator.  The more 
words you have separated by the OR operator, the longer the list of resultant articles 
will be. 
Example 1: digital OR camera will find all articles that contain at least one of the 
words. 

Example 2: digital OR camera OR dog finds all articles that contain at least one of 
the words.  This is likely to be a longer list than in example 1. 

1. Click in the Search for field. 

2. Type the first word or phrase. 

3. Type OR. 

4. Type the next word or phrase. 

5. Repeat steps 3 and 4 until you have typed all the words to search for. 

6. Click <Search>. 

NOT 

The NOT operator makes your search query negative.  You are saying that you want 
to find articles that do NOT contain particular words or phrases.  NOT is usually 
used in conjunction with AND. 
Example 1: digital AND NOT camera finds all articles that contain the word ‘digital’ 
but not the word ‘camera’. 

Important 

You must type in AND before NOT.  If you don’t you will receive an error message 
“Query is not understandable.” 

1. Click in the Search for field. 

2. Type the first word or phrase. 

3. Type AND NOT. 

4. Type the next word or phrase. 

5. Click <Search>. 
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5.5 SLIGHTLY MORE COMPLEX SEARCHES 

This section instructs you in performing more complex searches, using a 
combination of operators and wildcards. 

i Determining the order in which your search criteria is processed 
Parentheses are used to tell edDesk which order to process your search criteria.  The 
part of your search criteria enclosed in parentheses is processed before parts outside 
the parentheses. 
Example 1: (digital AND camera) OR photograph finds all articles that contain both 
the words ‘digital’ and ‘camera’ or the word ‘photograph’. 

Example 2: (digital OR camera) AND (photograph OR magazine) finds all articles 
that contain at least one of ‘digital’ or ‘camera’ and at least one of ‘photograph’ 
or ‘magazine’. 

ii Wildcards 

* (asterisk) 

The * is used as a wildcard. It represents any number of letters.  The * is 
particularly useful if you want to search for a word that may have a variety of 
endings, or a variety of standard spellings.  It does not work with numbers. 
Example 1: swim* finds swim, swims, swimming 

Example 2: *one* finds any word with the letters ‘one’ – one, sandstone, cone and 
so on. 

Example 3: mari*uana finds both marijuana  ,marihuana and ‘Maria iguana’ 

? (question mark) 

The ? represents a single letter.  It does not work with numbers.  You can use more 
than one ? wildcard in your search criteria. 
Example 1: ?ick finds lick, sick, hick and so on 


Example 2: clo?? finds, cloth, clock and so on 


Example 3: mari?uana finds both marijuana and marihuana
 

5.6 ADVANCED SEARCH 

The search bar lets you search for articles containing various words, phrases and 
combinations of these.  If you want to further control your search criteria there is a 
more advanced search feature available. 

Note 

Advanced means that you can do more, not that it is harder to use. 

1. Go to the view in which you want to search. 

2. Click on <Search Bar>. 

3. The Search bar displays, as below. 
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Figure 26: Search bar with More expandable menu at bottom right of search bar. 

4.	 Click on <More>. 

5.	 The Advanced search bar displays. 

Figure 27: Advanced search bar 

6.	 Search for: enter the text to search for.  L see section 5.4: Text search 
options and section 5.5: Slightly more complex searches 

7.	 Refer to the following sections for detailed instructions on completing the 
search form. 

Conditions 
This is a very powerful part of the advanced search.  Remember that the more 
conditions you add to a search, the more your results will be limited (expect fewer 
results with more conditions). 

Only the most commonly used (and most useful) conditions are explained here. 

Date 

If you want to limit your results to only those articles with certain created or 
modified dates then use this condition. 

1.	 Click on <Date…>. 

2.	 The Add Condition dialogue box displays as below. 
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Figure 28: Default values in Date condition dialogue box 

3.	 Condition: lets you select a range of conditions for articles to match.  At 
the moment you have selected By date. 

4.	 Search for document whose…: the options you see depend on the 
selected condition. The default for the condition By date is to search for 
articles created on the current day. 

Click on the dropdown arrows to change the details. 
Example 1: date modified is before 04/07/2005 

Example 2: date created is between 01/07/2005 and 04/07/2005 

5. Click on <Add> to add the condition to your search criteria. 
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Author 

You can add the Author condition to find articles by particular people or to exclude 
articles by particular people. 

1. Click on <Author>. 

2. The Add Condition dialogue box displays as below. 

Figure 29: Default values in Author condition dialogue box 

3. Condition: your currently selected condition is By author. 

4. Author: select from: 

• is any of to find articles by particular authors 

• is not any of to find articles that are NOT by particular authors 

5. Name: Click on the  to see a list of authors in your organisation. 

a. Select each author and click on <Add>. 

b. Click <OK> when you have selected the required authors. 

6. Click on <Add> to add the condition to your search criteria. 
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Fill out example form 

If you do not feel confident to add conditions then use the Fill out example form 
option. This lets you enter your conditions in a screen that looks like an article.  
You can click on the article tabs to navigate to the required fields. 

Figure 30: Default values for Fill out example form dialogue box 

1.	 Click on the tab that contains the information you want to search by. 

2.	 Enter your search criteria by: 

•	 Typing into the field – for example subject of acme. OR 

•	 Selecting it from a list of options – for example articles that have 
the copy status of concept. 

3.	 Click on <Add> to add the example form to your search criteria. 

4.	 The advanced search screen displays with the Search for field now 
containing “matches example form”. 
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 Multiple words 

Multiple words is a different (and simpler) way of searching for multiple words or 
alternative words. If you don’t like using the Boolean operators AND and OR then 
use this form instead. 

1.	 Click on <Multiple words…>. 

2.	 The Add Condition dialogue box displays as below. 

Figure 31: Default values in Multiple words condition dialogue box 

3.	 Search for documents containing… 

•	 any of the terms below – same as using OR.  This finds all 
articles that contain at least one of the words you enter. 

•	 all of the terms below – same as using AND.  This finds all 
articles that contain ALL of the words you enter. 

4.	 Click on <Add> to add your words to the search criteria. 

Editing your conditions 
You may have entered some search conditions that you want to change, without 
having to enter them completely again. 

Figure 32: Current conditions for this search 

1.	 Click once on the condition to be edited.  This selects the condition. 

2.	 Double-click on the condition. 

3.	 You are taken to the dialogue box with the condition. 
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4.	 Make your edits. 

5.	 Click on <Add> to accept your edits. 

Options 
There are two text search options available in Advanced search. 

Use word variants 

Tick this option to find any base word with certain suffixes. 
For example swim also finds swims, swimmer but not swam or incorrect words.

 Fuzzy search 

Tick this option to find words and phrases that are similar to your search criteria.  
This is particularly useful if you don’t know exactly how something could be 
phrased. 
For example, communication also finds articles with communicate, communicated. 
User requirement also finds articles with user group requirement. 

Figure 33: Advanced search with the options Use word variants and Fuzzy search selected 

Navigating through your search results 
After you conduct your search you see a list of all matching articles.  You can see 
your search criteria in context in each article.  Each search term is highlighted, with 
the currently selected term highlighted in pink and other terms highlighted in green. 

If you can’t find a search term in the article consider that… 

Matching text in the Subject field is not highlighted.
 

If a term appears only in the article’s metadata you will not see highlights.
 

If a term appears in an attached filed the title of the attached file is highlighted.
 

Your index needs to be updated.  See section 15.5: Updating an index. 


1.	 Click on the required article. Your article is opened with the earliest 
occurring search term displayed on screen. 

2.	 To move to the next term: press <Ctrl>+ 

3.	 To move to the previous term: press <Ctrl>-
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Saving searches 
If you have searches that you perform frequently you may save them.  This means 
that you do not have to enter the criteria each time you want to perform that search. 

1.	 Click on <Save search…>. 

2.	 The Save Search dialogue box displays. 

Figure 34: Save Search dialogue box 

3.	 Name: type in a name for your search.  Make it a meaningful name – so 
you know what the search is for. 

4.	 Share this search with other users: Tick this box if you want other 
people with access to your database to be able to use this search. 

Share this search with other users 

Only some people have permission to select Share this search with other 
users. 

If you do not have permission you will get an error message “You are 
not authorized to perform this action.” 

5.	 Click <OK>. 

Using your saved searches 
Saved searches must be “loaded” before you can use them. 

1.	 Click <Load Search>. 

2.	 A list of your searches displays. 

Figure 35: List of currently saved searches - acme corporation 

3.	 Click on the required search. 

4.	 Enter any other criteria. 

5.	 Click on <Search> to conduct your search. 
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Deleting saved searches 
When you have finished with a saved search (and don’t need it again) you can delete 
it. 

1. Click on <Load Search>. 

2. Click on Delete Saved Search. 

3. Click on the search to be deleted. 

4. Click on <Delete>. 
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6.	 Creating an article that is ready for briefing 
out 

This chapter introduces you to creating articles, entering briefing instructions, then 
briefing out your article. 

L see Chapter 7: Entering copy into edDesk for more information on editing and 
formatting articles. 

Some organisations brief out using edDesk, others just send an email, or phone the 
contributor. This chapter is relevant to those organisations that do brief out using 
edDesk. 

6.1 	 OBJECTIVES 

By the end of this chapter you should: 

•	 know what an article is 

•	 be aware that you can have an hierarchy of “related articles” 

•	 be able to create articles containing briefing instructions 

•	 be able to brief out your article by email. 

Please see Chapter 12: Creating hierarchical content – related articles for 
information and instructions about creating related articles. 

6.2 	 WHAT IS AN ARTICLE? 
An article is a story, or part of a big story.  Articles contain the content. Content 
includes: 

•	 briefing instructions 

•	 printing instructions 

•	 web publishing instructions 

•	 workflow 

•	 attached files, including graphics and PDFs 

•	 text of each article. 

 Related articles 

Articles may be part of a hierarchy of “related articles”.  You can have a “parent” 
article, usually general information or an introduction, and then create “children” for 
more specific information.  The children can have children of their own – a whole 
“family”.  A hierarchy makes it easy to order your story, move the separate elements 
around and insert more related articles. 

edDesk displays the related articles (parents and children) with the children indented 
under the parent. You can have as many indented levels as you need. 

The diagram below has the following hierarchy: 

•	 Parent - article entitled “Digital camera review” 
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• Children – subarticles entitled 

• “Camera 1” 

• “Camera 2” 

• “Camera 3” 

• “Camera 4” 

Figure 36: Parent and Child articles 

6.3 CREATING AN ARTICLE WITH BRIEFING INSTRUCTIONS 

One of the first things an editor needs to do is decide what sort of story is needed.  
An edDesk article is then created with appropriate instructions so that the author can 
submit an article that meets the stated requirements. 

Each story is created in a separate article with its own briefing instructions. 

1. Go to either the edDesk Home tab OR the Creating tab. 

2. Click on New article. 

Selecting “New Article” 

New Article can be accessed in several ways: 

* From the left navigation pane 

* From the body area of the page 

* When viewing All Issues you click on the dropdown button “New” then select 
“Article”. 
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3.	 The Article form opens, as below. 

Figure 37: Article form - Basics tab active 

4.	 You will see that there are several tabs along the top of the Article form.  
At this stage you only need to enter information in two of those tabs – 
Basics and Brief. 

Mandatory fields 
You may notice that several of the fields have ticks next to them.  These indicate 
mandatory fields.  Mandatory fields must be completed before you can save the 
article. 

Figure 38: Example of mandatory field - note the tick 

Basics tab 
The Basics tab contains general information about the article.  This tab must be 
completed before you can save your article. 

1.	 Subject – Enter a description of what the article is about. Make sure that 
whatever you type here will be meaningful to all people working with the 
publication that this article will appear in.  The subject displays in 
navigation on the published website. 
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2. Section – Click on the dropdown arrow . Select the section of the 
publication in which the article will appear. 

Figure 39: Sample dropdown list for Sections 

3.	 Subsections - The dropdown menu next to Section now contains a list of 
subsections relevant to the section you selected. Click on the dropdown 
arrow  for the subsection menu and select the required subsection in 
which the article will appear. 

Figure 40: Sample dropdown list for Subsections 

4.	 Paper / Web / CD – Select the media in which the article will be 
published. The default is Paper and Web. 

5.	 Story order – This numerical field is used to control the order in which 
your stories appear in an issue or for a particular date.  The default value is 
100. If you are creating several articles for an issue use century numbering. 
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Default order 

If you leave this field blank the default order is alphabetical within an Issue 
or where articles have the same date. 

Century numbering 

Century numbering means that you would number articles as 100, 200, 300 
etc.  This makes it easy to insert articles between other articles without 
having to renumber every article after the one you insert. 

You would use 150, 250, 350 as the numbers for inserted articles.  This would 
have the effect of having your articles ordered as 100, 150, 200, 250, 300, 
350 and so on. 

L see section 12.3: The importance of Story Order in a hierarchy for more 
information. 

6.	 Volume – Select the required volume from the dropdown list.  Usually each 
year will be a separate volume. 

7.	 Number – Select the required issue number from the dropdown list.  Issue 
numbers assume that January is Issue 1, February is Issue 2 and so on. 

Figure 41: Volume 2005 with list of issue numbers available 

Brief tab 
The Brief tab contains details of the brief that is to be sent to an author.  The 
brief tab is divided into several tabs for particular information. 

1.	 Click on Brief. 

2.	 The Details tab displays. 
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Figure 42: Initial view of Brief > Details tab 

Details 

1.	 Author – the person who will be writing the copy.  If you want to select an 
author already in your Address Book you can click on <Add Author> and 
select them from a list.  Otherwise, type in the author’s name. 

Important 

After you add an author they are listed in the Authors view, so make sure 
you enter their name accurately. 

2.	 Email – the email address of the author you are briefing.  When you have 
entered your instructions and saved the article you can click on 
<Email brief> to send the brief to that author. 

3.	 Copy deadline – This is the date by which copy has to be filed. 

Date format 

The date format is American – that is month/day/year 

If you click on the number next to the date a popup calendar is displayed.  
Scroll to the copy deadline needed and click.  This selects the date and 
ensures that it is in the correct format. 

Figure 43: Popup calendar displayed for copy deadline 
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Rights 

This tab contains information about the publishing rights to the article. 

Figure 44: Initial view of Brief > Rights tab 

1.	 Copyright – The default is for First use rights. Click in the boxes required 
if you want other copyright rights. 

2.	 Type of rights – you can only select one type of right. Click on the 
required rights type. 

3.	 Licensees – If there are licensees enter their details. 

Payment 

This tab contains payment details for the article. 

Figure 45: Initial view of Brief > Payment tab 

1.	 Article type – You may only select one article type.  The default is Staff. If 
you select another type you may have other payment options available. 
For example if you select “Freelance” as the article type you can enter the 
specific payment rate per thousand words and also select whether to cap 
the payment (useful if an author submits an article which is longer than 
commissioned). 
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Figure 46: Payment tab after selecting Freelance article type 

2.	 Words briefed – Enter the desired length of the article.  The default is 750. 

3.	 Payment rate – Enter the payment rate per thousand words.  This option is 
only available if you select Freelance or Flat rate as the Article type. 

•	 Payment capped to briefed words – select this if you want to cap 
the payment to the number of words briefed even if an author 
submits copy that is longer than commissioned. 

4.	 Payment due – this amount is automatically calculated from the number of 
words in the body of the article. 

 Briefing instructions 

Type the briefing instructions in this tab. Make sure your instructions are clear, so 
that anyone working on the article will understand the requirements. 

Briefing instructions are emailed to the author when the article is briefed out. 

Figure 47: Briefing instructions tab 
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 Illustration instructions 

Type the illustration instructions in this tab.  Make sure your instructions are clear, 
so that anyone working on the article will understand the requirements. 

Illustration instructions are emailed to the author when the article is briefed out. 

Figure 48: Brief > Illustration Instructions tab 

6.4 SAVING YOUR NEW ARTICLE 

After you have filled in the required fields in the Basics and Brief tabs your 
article is ready to be saved. 

Save before briefing out 

You must save your article before you can email the brief to the required author. 

1. Look at the toolbar along the top of your article form. 

Figure 49: Editing article toolbar 

2. You have two Save choices: 

a.	 Save – where you want to save your article and continue working on 
it. 

b.	 Save & Close – where you want to save your article and have 
finished working on it (for now). If you want to email the brief to the 
author now do not use this option (as you will have to reopen and edit 
the article in order to send the brief). 

3. Click on <Save> or <Save & Close>. 

6.5 BRIEFING OUT YOUR ARTICLE 

Now that you have created an article and entered briefing instructions, the article is 
ready to be briefed to your selected author.  This is the author who you entered on 
the Brief > Details tab. 
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Figure 50: Email address of author to be briefed 

1. Go to the Brief tab. 

2. Click on Details. 

3. Click on <Email brief>. 

4. A confirmation message displays. 

Figure 51: Confirmation message of briefing 

5. Click on <OK>. 
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Below is an example of an email brief received by an author and sent through 
edDesk. 

Figure 52: Example of emailed brief 

6.6 A QUICK LOOK AT WORKFLOW 

Workflow defines a set of statuses that an article must go through before it is 
published. edDesk has separate workflow statuses for copy, printing and web 
publishing. Workflow indicates which status the article is up to in the publishing 
process. 

When you emailed your brief to the author you received a confirmation message part 
of which said that the status of your article had been changed to Briefed. The 
changed status may be seen in the Workflow tab of the article. 

Many of edDesk’s view list articles according to their statuses.  For example, the 
view Story Ideas lists articles with a status of Concept, the view Ready for production 
lists articles with a status of Submitted. 

L see Chapter 13: Workflows for instructions on entering workflow information. 

6-11 



 



 
 

 

 

  
   

  
   

 

 

 

 

 

  

 

 

 

 

 

  

 
 
 

edDesk (Lotus Notes) User Guide 

7.	 Entering copy into edDesk 

edDesk is used to edit all copy. This means that you don’t have to save your copy in 
other programs and email it around.  edDesk keeps your articles up-to-date with all 
changes that have been made.  There is no risk of accidentally editing or reviewing 
an old version of an article. 

Every member of a team can see where articles are up to in the production process, 
and which person in that team is currently working on an article. 

Note to Authors 

Many of you will find that articles have been created by an editor and sent to you 
when briefed out.  You will be adding your copy to the created article. 

If a brief is sent by email, without having an article created in edDesk first, you will 
need to create that article in edDesk, and add your copy to it.  See 
Chapter 6: Creating an article that is ready for briefing out for information on 
creating articles. 

7.1 	 OBJECTIVES 

By the end of this chapter you should be able to: 

•	 select an article for editing 

•	 check out an article 

•	 add text to an article 

•	 paste text from other applications into an article 

•	 save an article 

•	 release a checked out article after you have made your changes 

•	 use edDesk’s workflow to submit an article for editing. 

7.2 	 SELECTING AN ARTICLE TO BE EDITED 

See the following sections for information on locating articles: 

•	 L Chapter 4: Views – using views to find articles matching 
criteria. 

•	 L Chapter 1: Searching for articles – using edDesk’s search form 
to find articles. 

1.	 Use the Views or Search to display your article description on your screen. 

2.	 Double-click on the article. 

3.	 Your article opens in Preview mode. You cannot make any changes. 
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Figure 53: article in Preview mode 

4.	 Click on <Edit>. 

Shortcut key 

You can press <Ctrl> + e to go into Edit mode instead of clicking on <Edit>.  
You can also press <Ctrl> + e from a View when your article is selected and 
go straight into Edit mode. 

5.	 Your article is now in Edit mode. 

7.3 	 IS MY ARTICLE IN PREVIEW OR EDIT MODE? 
The easiest way to check which mode your article is in is by looking at the article 
toolbar. 

 Preview mode: 

Characteristics: 

•	 Only five buttons on the toolbar 

•	 Only one tab – Preview 

•	 Subject and other article information as display only – not in 
editable fields 

•	 Web link displayed (more on this later) 
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Figure 54: Preview mode - article toolbar and information 

 Edit mode 

Characteristics 

• More buttons in the toolbar (than Preview mode) 

• Several article tabs 

• Article information in editable fields (in white rectangles) 

• No web link displayed 

Figure 55: Edit mode - article toolbar and information 

7.4 CHECKING OUT AN ARTICLE 

Checking out an article means that only you can save changes, although other people 
can read your article. edDesk automatically makes an article unavailable for others 
to change whenever you are editing it. 

However if you are working on an article but will be away from edDesk for some 
time (eg. attending a meeting, lunch) it is a good idea to manually check out the 
article before you leave your desk. 

1. Make sure your article is in Edit mode. 

2. Click on <Tools>. 

3. Select Checkout. 

4. Click on <Save> or <Save & Close> to save the checkout. 

Checked out articles have a padlock next to their description when they are listed in 
views. 
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Figure 56: Checked out articles with padlock icon 

7.5 	 RELEASING A CHECKED OUT ARTICLE 

When you check out an article, it remains checked out to you until you release it.  
After you have made all your changes to an article you must release it so that other 
people can make further changes if they need to. 

1.	 Make sure your article is in Edit mode. 

2.	 Click on <Tools>. 

3.	 Select Release. 

4.	 Click on <Save> or <Save & Close> to save the release. 

7.6 	 PASTING TEXT FROM OTHER APPLICATIONS INTO AN ARTICLE 

edDesk allows you to copy and paste text from other applications into articles. 

Pasting from documents with complex formatting 

If you are pasting from a document that has complex formatting some of that 
formatting may be lost. 

1.	 Open the edDesk article you want to paste the text into. 

2.	 Go into Edit mode. 

3.	 Put your cursor in the article text field. 

4.	 Open the source document (the one from which you want to paste the text). 

5.	 Highlight the text to copy. 

6.	 Use the program’s Copy feature (usually <Ctrl>+c). 

7.	 Go back to the edDesk article. 

8.	 Select the Edit menu. 

9.	 Select Paste… 

10.	 Your text is pasted into the edDesk article. 

11.	 Check the formatting of the text, and make any basic formatting changes 
required. 

L see Chapter 8: Formatting text for more information. 
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7.7 	 PASTING FROM COMPLEX DOCUMENTS – USING “PASTE SPECIAL…” 
Paste special is used when your source document contains complex formatting that 
you want to keep. 

1.	 Open the edDesk article you want to paste the text into. 

2.	 Go into Edit mode. 

3.	 Put your cursor in the article text field. 

4.	 Open the source document. 

5.	 Highlight the text to copy. 

6.	 Use the program’s Copy feature (usually <Ctrl>+c). 

7.	 Go back to the edDesk article. 

8.	 Select the Edit menu. 

9.	 Select Paste special… 

10.	 A dialogue box similar to the one below is displayed. 

Figure 57: Paste special dialogue box when pasting from a MS Word source 
document 

11.	 Look at the Result field. This is where you see a description of what will 
be pasted into your article. 

12.	 Click on the required format to be pasted. 

Recommendation 

For source text that uses outline numbering (also known as automatic paragraph 
numbering) and cross references, paste as Rich Text Format.  Rich Text displays more 
of your complex formatting. 

13.	 Click on <OK>. 
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14. Your text is pasted into the edDesk article. 

Paste special formats 

 Microsoft Word Document 

Note 

This option is only available if your source document is in MS Word format. 

You will be able to edit the pasted text, however much of your formatting is lost. 

• Outline numbering (automatic paragraph numbering) 
If you have used outline numbering in your source document and 
then selected some of the numbered paragraphs (not including the 
first numbered paragraph) to be copied, the numbering will be 
different in edDesk to your source document. 

• Cross references 
If you have used “automatic” cross references (that is, you have 
not manually typed them in) they will NOT be put in the edDesk 
article. 

• Heading styles 
If you have used heading styles, especially associated with 
automatic paragraph numbering, your styles will be put into the 
edDesk article but if you edit the text they will be replaced by 
edDesk’s default heading styles. 

Rich Text Format 

Most of your complex formatting is kept.   

Recommended format 

Rich Text Format is the recommended format to choose for complex documents. 

• Outline numbering 
Your numbers will be retained, but they are now text.  That is, they 
are not automatically updated if you need to insert new numbers. 

• Cross references 
Your references will still display correctly, but they are no longer 
updated automatically. 

• Heading styles 
Your styles are replaced by edDesk default styles. 

 HTML 

If you particularly want your text to be converted to HTML, for publishing on the 
Web you could select this option. However, it is not generally used. 
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Picture 

Your text is pasted in as a picture.  You cannot edit text pasted in as a picture.  
However your text will look exactly the same as in the source document. 

Text 

Removes your formatting and inserts only the text, with line and paragraph breaks.  
All other formatting, such as bold, italics, changes of font etc are removed.  
However it is extremely reliable and unlikely to cause problems when your article is 
further along the production cycle and has been exported to various layout formats. 

Editing text pasted in with Paste special… 

Pasted as Microsoft Word Document 

This option is often selected if your source document is a program such as 
MS Word.  Many complex formatting features are removed. 

You will see that in the edDesk article your pasted text is surrounded by a greyed 
rectangle. This indicates that you cannot directly edit the text in the article.  You 
will have to “activate” the source program to edit your text. 

1.	 Have your edDesk article in Edit mode. 

Figure 58: Paste special text area surrounded by grey rectangle.  This example 
uses outline numbering, heading styles and has a cross reference. 

2.	 Double-click in the text surrounded by a rectangle. 

3.	 A version of your source program opens and you can edit the text. 

4.	 Click away from the text area in the rectangle when you have finished 
editing your text. 

5.	 You will see that some of your original formatting has been removed. 
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Figure 59: Text from Figure 58 which has been edited, and has now lost some of 
its complex formatting 

Pasted as Rich Text Format 

1.	 Have your edDesk article in Edit mode. 

2.	 You will see that your text is just part of the article, no grey rectangle 
around it. 

Figure 60: Text paste special... as Rich Text Format.  This figure uses the same 
source document as Figure 58 and Figure 59.  Compare the formatting features 
retained by pasting as Rich Text Format. 

3.	 Click in the text and make your changes. 
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7.8 ATTACHMENTS AND RESOURCE FILES 

The Attachments and resource files field is used when you have items that are to 
be displayed programmatically (usually for articles that will be published on the 
web). 

It may also be used if you have a small image on a webpage and want to link to 
another larger or better quality image.  You would attach the required image, then 
refer to it using the format given: 
articleIDs/[thisdocid]/$file/[filename] 

L see section 9.9: Image hotspots for more information. 

If you want your attachments to appear in the body of an article, you would attach 
them in the article body at the position you want them to be displayed. 

L see Chapter 9: Including documents and images in articles for more information. 

Figure 61: Attachments and resource files field expanded 
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Attach files 
Filenames 

If your filenames contain spaces edDesk automatically replaces those spaces when 
it refers to the files.  For example, a file named test document.doc would become 
test+document.doc or test%20document.doc. 

1. Click on the right arrow next to Attachments and resource files. 

2.	 The Attachments and resources field expands, as in Figure 61. 

3.	 Click on <Attach files>. 

4.	 The Create Attachment(s) dialogue box displays, listing the directory 
from which you last attached files. 

Figure 62: Create attachment(s) dialogue box 

5.	 Navigate to the directory that contains the files you want to attach. 

6.	 Select the file(s) to be attached. 

7.	 Compress: Make sure this field is ticked. That way your file will be made 
as small as possible (and take up less space on the computer). 

8.	 Click on <Create>. 

9.	 Your file is now attached to your article. 

ii 	 Lead picture and lead caption 
Lead picture and lead caption are used to enter the filename and caption for the main 
picture in your article. 

iii 	 Further reading 
Not generally used except by staff of the Bulletin magazine. 
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iv Website links 
This option is no longer used. Hotspot links replaces this option.  L see 
section 8.9: Creating link (text) hotspots – Linking to other articles and external 
sites. 

7.9 FORMATTING TEXT 

Refer to Chapter 8: Formatting text for detailed instructions on formatting the text in 
articles. 

Do not spend much time formatting an edDesk article.  edDesk uses “export 
templates” to ensure that the format of your finished article is correct for its intended 
publication. If you add much of your own formatting you may end up with an 
article which does not comply with your publication’s formatting, and you may have 
to take out some of your own formatting! 
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8. Formatting text 

You should not spend much time formatting an edDesk article.  edDesk uses “export 
templates” to ensure that the format of your finished article is correct for its intended 
publication. If you add much of your own formatting you may end up with an 
article which does not comply with your publication’s formatting, and you may have 
to take out some of your own formatting! 

The following items explain how to add the most commonly used (and allowed) 
formatting to your articles. 

There are often several ways of doing the same thing… only the most commonly 
used are discussed here. 

Note about <Ctrl> keys used in combination with other keys to get particular results 

If you see an instruction written like “Press <Ctrl>+b” then you do the following… 


Hold down the <Ctrl> key while you press the letter after the plus sign.
 

For example, <Ctrl>+b means hold down <Ctrl> while you press b, then let both keys
 
go.
 

8.1 OBJECTIVES 

By the end of this chapter you should be able to: 

• apply the edDesk standard format to your article 

• embolden text 

• italicise text 

• create numbered lists 

• create bulleted lists 

• create nested lists 

• create hotspot links to other articles and websites 

8.2 ARTICLE IN EDIT MODE 

You must have your article in Edit mode before you can format it. 

1. Open the article. 

2. Click on <Edit>. 

8.3 APPLYING THE EDDESK STANDARD FORMAT 

The edDesk standard format gives you an article with text well spaced vertically.  
This makes it much easier to read onscreen as you edit the article.  If you have 
pasted your text from another application, Standard format removes extraneous 
formatting so that the article is correctly formatted for publishing to the web. 

3. Click on <Tools>. 

4. Select Standard format. 
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Before applying standard format 

Figure 63: article before applying the standard format 

Same article with standard format applied 

Figure 64: same article with standard formatting applied.  This is much easier to read on the 
screen. 

8.4 	 EMBOLDENED TEXT 

This section assumes that you have very little experience in formatting text.  If you 
already use word processing applications, such as MS Word, you will see that the 
technique is the same in edDesk as in most Windows applications. 

Before typing text 

1.	 Press <Ctrl>+b. 

2.	 Type the text that is to be bold. 

3.	 Press <Ctrl>+b to end the bold. 

After text has been typed 

1.	 Highlight the text you want to be bold.  (The easiest way is to drag your 
mouse over the text.) 

2.	 Press <Ctrl>+b. 
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8.5 	 ITALIC TEXT 

This section assumes that you have very little experience in formatting text.  If you 
already use word processing applications, such as MS Word, you will see that the 
technique is the same in edDesk as in most Windows applications. 

Before typing text 

1.	 Press <Ctrl>+i. 

2.	 Type the text that is to be italics. 

3.	 Press <Ctrl>+i to end the italics. 

After text has been typed 

1.	 Highlight the text you want to be italics.  (The easiest way is to drag your 
mouse over the text.) 

2.	 Press <Ctrl>+i. 

8.6 	 UNORDERED (BULLETED) LISTS 

An unordered list has list items indicated by bullets, not alphanumeric ordering. 

There are several types of bullet and they can be applied either before or after the 
text is entered into the article.  Each list item must be separated by a paragraph (by 
pressing <Enter>) for the bullet to appear. 

You will use the Lotus Notes toolbar and menus. 

Figure 65:Lotus notes menu and toolbars that display when you are editing an article 

Before your text is entered  

This is useful if you are typing your copy directly into edDesk. 

1.	 Click on the Text menu. 

2.	 Select List. 

3.	 Select the type of bullet you want 

• bullet 

□ checkmark 

○ circle 

■ square 

4.	 Type your first list item. 

5.	 Press <Enter> to start the next list item.  The bullet is automatically created 
for the next item. 

6.	 Repeat steps 4 and 5 for each item. 
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7.	 When you have finished adding list items click on the Text menu. 

8.	 Select List. 

9.	 Select the ticked bullet type (this is the one that you have been using for 
your list). 

10.	 Any text typed now will not be in the list. 

After your text has been entered (if you are pasting text from another 
program) 

1.	 Select the text you want to put in a list. 

2.	 Click on the Text menu. 

3.	 Select List. 

4.	 Select the type of bullet you want: 

• bullet 

□ checkmark 

○ circle 

■ square 

5.	 Your items are now in an unordered list. 

8.7 	 ORDERED (NUMBERED) LISTS 

There are several types of ordering you can use for lists.  The most common are 
arabic numerals and alphabetical characters. 

Before your text is entered  

This is useful if you are typing your copy directly into edDesk. 

1.	 Click on the Text menu. 

2.	 Select List. 

3.	 Select the type of ordering you want: 

1. number 

A. uppercase alphabetic 

a. lowercase alphabetic 


I uppercase roman 


i lowercase roman 


4.	 Type your first list item. 

5.	 Press <Enter> to start the next list item.  The number is automatically 
created for the next item. 

6.	 Repeat steps 4 and 5 for each item. 

7.	 When you have finished adding list items click on the Text menu. 

8.	 Select List. 
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9.	 Select the ticked order type (this is the one that you have been using for 
your list). 

10.	 Any text typed now will not be in the list. 

After your text has been entered (if you are pasting text from another 
program) 

1.	 Select the text you want to put in a list. 

2.	 Click on the Text menu. 

3.	 Select List. 

4.	 Select the type of ordering you want: 

1. number 

A. uppercase alphabetic 

a. lowercase alphabetic 


I uppercase roman 


i lowercase roman 


5.	 Your items are now in an ordered list. 

8.8 	 NESTED LISTS 

Nested lists are lists within lists.  The following is an example of a nested list within 
the first list item. 

Improved dynamite will: 

•	 have smaller blast zone, more efficient blasting 

o less interruption to environment 

o less likelihood of blaster being killed 

•	 have a more powerful blast 

•	 look like roadrunners, to attract foolish coyotes 

1.	 Create your list and enter the items you want in your lists. 

L see section 8.7: Ordered (numbered) lists for instructions on creating 
lists. 

2.	 Highlight the items to be in a nested list. 

3.	 Do one of the following: 

a. Press <F8>.  This is Lotus Notes Indent key; OR 

b. Click on the Text menu then select Indent; OR 

c. Click on the Indent icon  in the Lotus Notes toolbar. 

4.	 Your highlighted text is now in a nested list. 
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i 	 “Unnesting” lists 
Sometimes you may need to make a previously nested list part of the main list and 
remove the nesting. 

1.	 Highlight the nested list items that you want to “unnest”. 

2.	 Do one of the following: 

a. Press <Shift>+<F8>. This is Lotus Notes Outdent key; OR 

b. Click on the Text menu then select Outdent; OR 

c. Click on the Outdent icon  in the Lotus Notes toolbar. 

3.	 Your list is now unnested. 

8.9 	 CREATING LINK (TEXT) HOTSPOTS – LINKING TO OTHER ARTICLES AND 
EXTERNAL SITES 

If your article is going to be posted on the web (Internet, Extranet or Intranet) you 
may need to create links to relevant sites and articles from within your article.  
People can then choose whether to follow those links or not. 

These links are called hotspots.  There are two types of hotspot: 

•	 Text – discussed in this section 

•	 Image - L see section 9.9: Image hotspots for more information. 
Example 1: you are reviewing several newspapers and want to put a link to those 
newspapers in your article. 

Example 2: You are preparing a report for publishing on the web.  You want to put in 
links to other parts of the report wherever it refers to those other sections or pages. 

1.	 Type the text from which you want to create a link. 

2.	 Highlight the text. 

3.	 Go to the Create menu. 

4.	 Select Hotspot. 

5.	 Select Link Hotspot. 

6.	 The HotSpot Resource Link dialogue box appears. 

Figure 66: Create Hotspot dialogue box 
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To link to another article in your database 

1.	 Type: this should be URL. 

2.	 Value: 

a. Locate the article to which you want to link. 

b. Open the article. Stay in Preview mode. 

c. Select and copy the contents of the Web Link field. 

d. Paste the Web Links contents into the Value field. 

3.	 Frame: There are a few ways of displaying a link that is followed.  This is 
determined by what you enter in the Frame field.  Only the two most 
common ways are mentioned here. 

•	 _new: your link opens in a brand new browser window.  Your 
page is left open in the old window. 

•	 If you leave this field blank: when a person follows the link the 
link contents replace your article. 

4. Display: if you want a border around your link check this box. 

Default display of link text 

Your link is automatically emphasised by appearing in a different colour to 
the rest of your text. When you are viewing an article the hotspot text is 
blue. 

5.	 Close the HotSpot Resource Link dialogue box. 

To link to another website 

1.	 Type: this should be URL. 

2.	 Value: 

a. Locate the website to which you want to link. 

b. Select and copy the address field. 

c. Paste the address contents into the Value field. 

3.	 Frame: There are a few ways of displaying a link that is followed.  This is 
determined by what you enter in the Frame field. Only the two most 
common ways are mentioned here. 

•	 _new: your link opens in a brand new browser window.  Your 
page is left open in the old window. 

•	 If you leave this field blank: when a person follows the link the 
link contents replace your article. 

4.	 Display: if you want a border around your link check this box. 

5.	 Close the HotSpot Resource Link dialogue box. 
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iii 	 Reviewing your hotspot properties 
1.	 Open the required article. 

2.	 Click on <Edit>. 

3.	 Move your mouse over the hotspot you want to review. 

4.	 Right click your mouse.  A popup menu displays. 

5.	 Select Hotspot properties… 

6.	 The HotSpot Resource Link dialogue box displays with the properties of 
the selected hotspot. 

iv 	 Removing a hotspot 
Sometimes you might want to delete a hotspot but retain the text that used to be the 
link. 
For example you have created an article discussing cameras, with hotspot links to 
various cameras.  You now need to update the article as one camera is now 
superseded.  You might want to keep the camera name in your article but remove 
any link to it. 

1.	 Open the required article. 

2.	 Click on <Edit>. 

3.	 Move your mouse over the hotspot you want to remove. 

4.	 Right click your mouse.  A popup menu displays. 

5.	 Select Remove Hotspot. (It is the last item on the menu.) 

6.	 Your hotspot is removed, however the text is still blue.  If you want the text 
to become the same colour as the rest of your article text then do the 
following: 

a. Select the text. 

b. Right click on the text.  A popup menu displays. 

c. Select Text Properties… 

d. The Text Properties dialogue box displays. 

e. Click on the down arrow in the Colour field. 

f. Select the required colour for your text. 

g. Close the Text Properties dialogue box. 
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9.	 Including documents and images in articles 

You will probably want to include images, PDFs, wordprocessing documents, 
spreadsheets and other filetypes in some of your articles.  You can attach and import 
files in many formats, and even attach files that are for recordkeeping purposes, and 
are not to be published with the article. 

9.1 	 OBJECTIVES 

By the end of this chapter you should be able to: 

•	 attach files that you want to be published with your article 

•	 attach files that you do NOT want to be published with your article 
but that you want to retain as a record of the original copy 

•	 attach images to your article 

•	 import an image into your article 

•	 place an image in a required position in your article 

•	 align your images in your article. 

9.2 	 WHAT IS THE DIFFERENCE BETWEEN ATTACHED AND IMPORTED FILES? 

Attach 	Import 

Keeps your attached files separate to the 
article. You have an icon and filename 
that ndicate that a file has been attached, 
but you cannot see the contents of the 
file when you are editing the article. 

Can attach files in any format. 

9.3 	 ATTACHING FILES 

Incorporates your files into the article.  
You can see the contents of your files as 
you edit your article. 

Limited range of filetypes can be 
imported.  Cannot import PNG filetypes 
(a fairly common graphics format). 

Attached files are published with your article.  You can attach files in any format, 
but the most common are wordprocessing, images, PDFs and spreadsheet files. 

There are a couple of ways to attach files to your article: 

•	 Using the File > Attach menus 

•	 Using the Import menu from the article toolbar. 
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File > Attach menu 
File > Attach lets you attach a file of any filetype to your article. 

1.	 Open the article to which you want to attach files. 

2.	 Go into Edit mode and put the cursor wherever you want the attachment to 
be placed. 

3.	 Click on the File menu. 

4.	 Select Attach… 

5.	 The Create Attachment(s) dialogue box opens, listing files in the directory 
from which you last attached files. 

6.	 Navigate to the required directory (the one your attachments are currently 
in). 

7.	 Select the files to attach. 

Selecting several files to attach 

If the files are listed in a group (no other files between them) click on the 
first file then hold down <Shift> while you click on the last file to be 
attached. 

If the files are listed separately (with other files between them) click on the 
first file, then hold down <Ctrl> while you click on each file to be attached. 

8.	 Click on <Create>. Your files are attached to your article. 

Import menu 
Note 

Despite of being called Import, this menu gives options to both import and attach 
files. 

1.	 Open the article to which you want to attach files. 

2.	 Go into Edit mode and put the cursor wherever you want the attachment to 
be placed. 

3.	 Click on the Import menu. 

4.	 A list of options displays. Choose the option that allows you to import the 
required file. 

•	 Import article from file – this adds the text (and some formatting) 
from your source file to your article.  The file becomes 
incorporated into your article rather than just being attached 
separately. 

•	 Attach original WP file – attaches the original wordprocessing file 
to your article. This file is listed in the Log tab and does not 
appear in the article’s content.  The file is attached with all 
formatting (and is not incorporated into your article text). 

•	 Paste text from clipboard – uses Paste Special to insert any text on 
your clipboard into your article. Your inserted text is incorporated 
into the article and some formatting from the source will be 
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removed.  L see section 7.7: Pasting from complex documents – 
using “Paste special…” 

•	 Attach pics – attaches images that you want to be used by the print 
production team only.  Images imported here are listed in the 
Paper tab. They are not published on the web version of your 
article. 

5.	 If you selected the Import article from file, the Import dialogue box opens. 
If you selected to Attach original WP file, or Attach pics, the Create 
Attachment(s) dialogue box opens. Both dialogue boxes list files in the 
directory from which you last attached or imported files. 

6.	 Navigate to the required directory (the one your attachments are currently 
in). 

7.	 Select the files to attach or import. 

Selecting several files to attach 

If the files are listed in a group (no other files between them) click on the 
first file then hold down <Shift> while you click on the last file to be 
attached. 

If the files are listed separately (with other files between them) click on the 
first file, then hold down <Ctrl> while you click on each fie to be attached. 

8.	 Click on <Create>. 

9.4 	 ATTACHING WP FILES THAT YOU DO NOT WANT TO PUBLISH WITH 
YOUR ARTICLE 

If you want to keep a copy of the original wordprocessing document for a story and 
do not want that copy published use the Import menu. 

1.	 Open the article and go into Edit mode. 

2.	 Go to the Import menu. 

3.	 Select Attach original WP files. 

4.	 The Create Attachment(s) dialogue box opens, listing files in your default 
directory. 
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Figure 67: List of files to attach to an article 

5.	 Navigate to the directory that contains the file(s) you want to attach to your 
article. 

6.	 Click on the filename of the file to attach. 

Selecting several files to attach 

If the files are listed in a group (no other files between them) click on the 
first file then hold down <Shift> while you click on the last file to be 
attached. 

If the files are listed separately (with other files between them) click on the 
first file, then hold down <Ctrl> while you click on each fie to be attached. 

7.	 Make sure the Compress box is ticked (that way your attached file will be 
as small as possible). 

8.	 Click on <Create>. 

9.	 Your selected files are attached to the article. 
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To see WP files that have been attached to your article 
WP files that are not to be published with your article are not visible when you are 
editing the article. To see a list of those attached files do the following: 

1.	 Open your article and go into Edit mode. 

2.	 Click on the Log tab. 

Figure 68:Log tab with one attached WP file 

3. Your attached WP files are listed in the Original attachments field. 

9.5 	 IMAGE PREPARATION 

Images must be prepared in the requested format, pixel size and quality in an image 
editing program before you add them to your edDesk articles.  Your editor should 
specify the image qualities of any image to be used in an article and include these in 
the brief. 

9.6 	 ATTACHING IMAGES THAT ARE TO BE USED IN PRINTED PUBLISHING 
ONLY 

Sometimes you may want to publish your article on the web and on paper.  If you 
have images that are only to be used in the printed version of the article you can 
store them separately to the images that are to be used in the web version.  This 
makes them easy to manage. 

You can also enter specific illustration instructions for those print images. 

1.	 Open the article and go into Edit mode. 

2.	 Go to the Import menu. 

3.	 Select Attach Pics. 

4.	 The Create Attachment(s) dialogue box opens, listing files in the directory 
from which you last attached files. 
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Figure 69: Create Attachments(s) dialogue box listing directory from which files 
were last attached 

5.	 Navigate to the directory that contains the file(s) you want to attach to your 
article. 

6.	 Click on the filename of the file to attach. 

Selecting several files to attach 

If the files are listed in a group (no other files between them) click on the 
first file then hold down <Shift> while you click on the last file to be 
attached. 

If the files are listed separately (with other files between them) click on the 
first file, then hold down <Ctrl> while you click on each fie to be attached. 

7.	 Make sure the Compress box is ticked (that way your attached file will be 
as small as possible). 

8.	 Click on <Create>. 

9.	 Your images are now attached to your article. 
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To list images that have been attached to your article 
Images that are only to be published on paper are not visible when you are editing 
the article. To see a list of those attached images do the following: 

1.	 Open your article and go into Edit mode. 

2.	 Click on the Paper tab. 

Figure 70: Paper tab listing attached images in the Picture attachments field 

3.	 Picture attachments: Your attached images are listed in this field. 

To view an attached image 

1.	 Double-click on the image icon. 

2.	 The Attachments dialogue box opens. 

3.	 Click on <View>. Your image is opened in a new window tab. 

9.7 	 IMPORTING AN IMAGE INTO AN ARTICLE 

Importing images incorporates the image into your article – that is, it becomes part 
of your article, rather than just being attached to it.  Importing gives you control over 
the image size on the page, physical position of the image, and properties such as 
borders, text wrapping and captions. 

1.	 Prepare your image in your image editing program. 

2.	 Open your article and go into Edit mode. 

3.	 Position your cursor where you want the image to appear. 

4.	 Go to the File menu. 

5.	 Select Import. 

6.	 The Import dialogue box displays showing you the directory you last used 
to import files from. 
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Figure 71: Import image dialogue box with image type of JPEG selected 

7.	 Files of type: select the image type for the image you want to import. 

8.	 Click <Import>. 

9.	 The image is placed at the current cursor location in its original format and 
is rendered inline. 

9.8 	 IMAGE PROPERTIES 

When you have placed your image in your article you can set various properties to 
control the display of your image. 

1.	 Click once on your image. 

2.	 Select the Picture menu (from the Lotus Notes menus at the top of your 
screen). 

3.	 Select Picture Properties…. 
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4. The Picture properties dialogue box displays. 

Figure 72: Picture properties dialogue box 

5.	 Text Wrap: Select the down arrow next to this field.  You see a list of 
choices, each with a diagram displaying the effect your choice will have on 
your image and its relation to the text in the next paragraph.  Select the 
desired wrap. 

Figure 73: Text wrap options, showing layout of each option 

Note 

Images rendered inline are treated as part of a paragraph. Any wrapping 
will be within that paragraph only. 

If your paragraph is short and the image large you will still see blank spaces 
next to the image. 

6.	 Scaling (%): When you first import an image this will be Width 100 
Height 100.  If you have resized your image you will see different 
percentages. 

Click on <Reset> to put the scaled image back to its original size. 

7.	 Alternate Text: This is the text that appears when a person hovers their 
mouse over an image on the web.  It is important to enter alternate text if 
your article is to be published on the web because visually impaired people 
and people who have images turned off on their browser rely on alternate 
text to “see” the image. 
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8.	 Caption: If you want a caption for your image, enter the caption in this 
field. Click on the tick icon to confirm your caption. 

9.	 Display caption: Select where you want the caption to display. The option 
“Centred on image” does mean that your caption appears in the centre of 
your image (not centred underneath your image!). 

9.9 	 IMAGE HOTSPOTS 

Hotspots may be used when your article is published on the web.  Hotspots are areas 
that people can click on in an image.  When they click they are taken to another 
webpage. 

Hotspots are often used in maps.  For example, you have a web page with a map of 
Australia.  If a person clicks on New South Wales they are taken to more details for 
New South Wales. 

1.	 Click on the image. 

2.	 Select the Picture menu.  You will see a list of Hotspot shapes. 

3.	 Select Add Hotspot (shape). 

Choose a shape that fits with the area you want to make a hotspot.  If you 
want to select an irregular area then select Add Hotspot Polygon. 

4.	 Position your cursor where you want your hotspot to be then drag your 
mouse to make the hotspot the required size. 

5.	 The Hotspot properties dialogue box opens. 

i 	 To link to another article in your database 

1.	 Type: this should be URL 

2.	 Value: 

a.	 Locate the article to which you want to link. 

b.	 Open the article. Go into Edit mode. 

c.	 Go to the Web tab. 

d.	 Copy the contents of the Human URL field. 

e.	 Paste the Human URL contents into the Value field. 

3. Frame: There are a few ways of displaying a link that is followed.  This is 
determined by what you enter in the Frame field. Only the two most 
common ways are mentioned here. 

•	 _new: your link opens in a brand new browser window.  Your 
page is left open in the old window. 

•	 If you leave this field blank: when a person follows the link the 
link contents will replace your article. 
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Using Human URLs  

Human URLs (also known as human-readable, user-centred, user-friendly, spider-
friendly or URL rewriting) not only makes your pages much clearer to site visitors, but 
goes a long way to help increase your visibility with Web search engines. Using Web 
addresses that echo keywords and content within the same page will directly 
benefit your page rankings in search engines like Google and Yahoo!. Not only do 
search engines “prefer” sites whose URLs have keywords in them, but they can 
penalize sites that contain such database-created URL characters as question 
marks. 

Human-readable URLs are easier to remember, and importantly to marketers, easier 
to tell people. If you want to build a campaign around a specific page, you can 
name that page in a way that reinforces the campaign, and create a unique URL 
for campaign tracking. 

From a visitor point of view, the human-readable URL is indicative of what the page 
is about. Web-savvy visitors will quickly grasp your naming scheme and use it to 
explore your site. A surfer who types in a URL that results in a “Page Not Found” 
message may be able to reach the page by checking for a typing error. Or they 
may try to “hack” the URL by removing the end segment. This is almost impossible if it 
is not human-readable. 

(source - http://www.brookgroup.com/Resources/Content-Management/Human-
Readable-URL.html) 

To link to another website: 

1.	 Type: this should be URL 

1.	 Value: 

a.	 Locate the website to which you want to link. 

b.	 Copy the address field. 

c.	 Paste the address contents into the Value field. 

2.	 Frame: There are a few ways of displaying a link that is followed.  This is 
determined by what you enter in the Frame field. Only the two most 
common ways are mentioned here. 

•	 _new: your link opens in a brand new browser window.  Your 
page is left open in the old window. 

•	 If you leave this field blank: when a person follows the link the 
link contents will replace your article. 

5.	 Close the Hotspot properties dialogue box. 
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To link to a larger image from the image on your webpage 
1.	 Add the small image to the article, in the position in which you want it to 

display on the posted webpage. 

2.	 Click on Attachments and resource files (this is at the bottom of your 
article). This section expands. 

Figure 74: Expanded Attachments and resource files section of the article 

3.	 Click on the <Attach files> button. 

4.	 The Create Attachments dialogue box displays.  Locate the image you 
want to link to. 

5.	 Double-click on the image.  It is now added to the article (in the 
Attachments and resource files section). 

6.	 Click once on the small image. 

7.	 Select Add Hotspot (shape). 

8.	 Choose a shape that fits with the area you want to make a hotspot.  If you 
want to select an irregular area then select Add Hotspot Polygon. 
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9.	 Position your cursor where you want your hotspot to be then drag your 
mouse to make the hotspot the required size. 

10.	 The Hotspot properties dialogue box opens.  There are a couple of fields 
that you need to complete: 

•	 Type: leave this as URL 

•	 Value: This must be in the format 

articleIDs/[thisdocid]/$file/[filename]
 

WHERE 
[thisdocid] is the article ID and 
[filename] is the filename of the image. 

Important 

The square brackets just indicate that variable information goes 
here - make sure that you don't put them in your value field. 

•	 Type: enter _new. This opens the linked image in a new browser 
window. 

To get the article ID: 

1.	 Go to the Web tab. 

2.	 Copy the contents of the Article ID field. 
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About the images used in this screen capture 

Figure 75: Image in body of article, with Attach files listing image linked to by a hotspot set in 
the body image. 

This article has an image in the body of the article.  It also has an attached file 

topgear_peugeot.jpg. 


A hotspot was created around the image in the body of the article.  The hotspot 

properties Value field contains the following: 


articleIDs/22AEA87282497C14CA257267000F96F2/$file/
topgear_peugeot.jpg 

WHERE  

22AEA87282497C14CA257267000F96F2 is the articleID (from the 
Web tab) AND 

topgear_peugeot.jpg is the name of the attached file 
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10.	 Article toolbar – Tools, New, Import, Export 

This chapter instructs you in using the toolbar items available within articles.  This 
chapter does not include: 

•	 <Save & Close> 

•	 <Cancel> 

Figure 76: Default article toolbar when editing an article 

10.1 	 OBJECTIVES 

By the end of this chapter you should be able to use the: 

•	 Tools menu to assist in preparing your article 

•	 New menu to create comments and insert backgrounders into your 
article 

•	 Import menu to attach and import various filetypes to your article 

•	 Export menu to export your finished article to other formats ready 
for printing 

•	 Hide info option 

•	 Preview option 

10.2 	 TOOLS MENU 

The Tools menu has many useful features that are used in your articles.  These are: 

•	 Checkout / Release 

•	 Word count 

•	 Address… 

•	 Spell check 

•	 Print article 

•	 Send brief via Email 

•	 Standard format 

i 	 Checkout / Release 
L see section 7.4: Checking out an article and section 7.5: Releasing a checked out 
article for more information. 

ii 	 Word count 
Counts the number of words in the article body.  This does not include any text 
entered in the Subject, or other fields above the article body. 
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iii 	 Address… 
This option lets you enter an email address for the author to whom you are briefing 
the article. 

iv 	 Spell check 
Checks the spelling of the entire article – that is, text entered in every tab. 

1.	 Click on the Tools menu. 

2.	 Click on Spell check. 

3.	 If there are any words that the spell check does not recognise a dialogue 
box opens with the first unrecognised word highlighted. 

Figure 77: spell check with first unrecognised word in the "Not in dictionary" field 

4.	 If the word is correct as you typed it click on either: 

a.	 <Skip> - to keep just that instance of the word; OR 

b.	 <Skip All> – to keep all instances of the word through the entire 
document. 

5.	 Not in dictionary: If the word is incorrect, but none of the suggestions are 
what you want (this may occur when you mistype a name) then type the 
word correctly in the Not in dictionary field. 

6.	 Suggest: If any of the suggestions are the correct spelling click once on the 
suggestion and then click on either: 

a. <Replace> - to replace just that instance of the word; OR 

b. <Replace All> - to replace all instances through the article. 

7.	 <Add to dictionary>: This is particularly useful for company names and 
addresses. Click this button to add a word in the Not in dictionary field to 
your dictionary.  This means that the spell check will now recognise that 
word. 
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8.	 <Edit dictionary>: Mostly useful if you have accidentally added an 
incorrectly spelt word to the dictionary.  This is only for words that you 
have added. 

a.	 Click on <Edit dictionary>. 

b.	 The User Spell Dictionary dialogue box opens, listing all the words 
you have added to your personal dictionary. 

Figure 78: Dialogue box displayed after selecting Edit dictionary... 

c.	 New/Selected word: This field is where you enter any words you 
want to add to the dictionary. If you click on a word listed in your 
dictionary, it will be displayed in this field.  Make any changes to the 
word then select one of the following buttons: 

•	 <Add> - to add to your dictionary 

•	 <Update> - to update the word to whatever is in the 
New/Selected word field 

•	 <Delete> - delete the word in the New/Selected word field. 

d. When you have made the required changes click on <OK>. 

9.	 Dictionary: Displays the selected language.  You can select other 
languages if required (especially useful if your article should be written 
with American English spelling). 

 Spelling options 

You can select various rules to be obeyed when running the Spell check. 

1.	 Click on Spelling Options. 

2.	 The following menu is displayed. 

Figure 79: Spelling options menu 

3. Click on the options you want to use. 
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4.	 Click on Spelling Options to close the options display. 

v 	 Print article 
Select this option to print your article.  The printout will include the following: 

•	 Subject 

•	 Volume and Issue 

•	 Section 

•	 Headline 

•	 Intro 

•	 Web link 

•	 Author 

•	 Word count 

•	 Article text 

vi 	 Send brief via Email 
This option lets you send the brief for an article to the person entered as the Author 
in the Brief tab. It is used mainly by editors and other people commissioning 
articles. 

All briefing instructions are included in the email. 

L see section 6.3iii: Brief tab for more information. 

vii 	 Standard format 
This applies edDesk’s standard format to your text.  This formats your text so that it 
is easy to read on screen. 

L see section 8.3: Applying the edDesk standard format. 

10.3 	 NEW MENU 

The New menu is used to: 

•	 create related articles. L see Chapter 12: Creating hierarchical 
content – related articles 

•	 enter comments about an article 

•	 enter background information about an article. 
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Comments 
Comments are often used for internal editorial comment about an article.  However, 
your export template may allow comments to be published on the web as part of the 
article. You can have several comments for each article.  Comments cannot be 
edited once they are saved. 

People visiting your site may also be allowed to comment on your content. 

Examples of such websites that have been created using edDesk, are: 

• http://www.tomatomagazine.com.au 

• http://www.colinclimo.com 

• http://www.wheelsmag.com.au 

Getting to the Comment screen – from a View 

1. Display a view that has a toolbar (views such as Sections and All Issues). 

2. Click on the title of the article to which you want to add a comment. 

3. Click on the New menu. 

4. Select Comment. 

5. The Comment screen displays in a new window tab called (Untitled). 

Getting to the Comment screen – from an article 

You do not have to be in Edit mode to add a comment to an article. 

1. Open the article to which you want to add a comment. 

2. Click on the New menu. 

3. Select Comment. 

4. The Comment screen displays in a new window tab called (Untitled). 

Entering your comment 

edDesk fills in some fields automatically for you.  These are the Posted field, which 
edDesk gets from the current date and the By field, which edDesk gets from your 
login. 

Figure 80: Comment screen when first opened 
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1.	 Topic: Type the title of the article for publication. 

2.	 Comment: Type the text of your comment. 

3.	 After you have entered your comment click on the cross in the 
(Untitled) window tab. 

4.	 You see a message: Do you want to save this new
document? 

5.	 Click on <Yes> to save your comment, <No> to not save your comment or 
<Cancel> to continue working on your comment. 

When you are looking at an expandable view (such as Sections or All Issues) your 
comment is listed underneath your article title. 

Figure 81: Comments listed under article title 

Backgrounders 
Backgrounder is used to enter information that you probably don’t want to be 
published. They may be used for research notes, interview notes to which you refer 
as you are writing the article. 

Your organisation’s export templates can be setup to publish your background 
information if required. 

You can have several backgrounders for each article.  Backgrounders cannot be 
edited once they have been saved. 

Getting to the Backgrounder screen – from a View 

1.	 Display a view that has a toolbar (views such as Sections and All Issues). 

2.	 Click on the title of the article to which you want to add a backgrounder. 

3.	 Click on the New menu. 

4.	 Select Backgrounder. 

5.	 The Backgrounder page displays in a new window tab called 
(Untitled). 

Getting to the Backgrounder screen – from an article 

You do not have to be in Edit mode to add a backgrounder to an article. 

1.	 Open the article for which you want to add a backgrounder. 

2.	 Click on the New menu. 

3.	 Select Backgrounder. 

4.	 The Backgrounder page displays in a new window tab called 
(Untitled). 
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Entering your backgrounder 

edDesk fills in some fields automatically for you.  These are the Posted field, which 
edDesk gets from the current date and the By field, which edDesk gets from your 
login. 

Figure 82: Backgrounder screen as first displayed 

1.	 Topic: Type the title of the article for publication. 

2.	 Type of backgrounder: Select the type of background information you are 
entering. You can only select one type. 

3.	 Content: Type your backgrounder. 

4.	 After you have entered your backgrounder click on the cross in the 
(Untitled) window tab. 

5.	 You see a message: Do you want to save this new
document? 

6.	 Click on <Yes> to save your backgrounder, <No> to not save your 
backgrounder or <Cancel> to continue working on your backgrounder. 

When you are looking at an expandable view (such as Sections or All Issues) your 
backgrounders are listed underneath your article title.  The type of backgrounder is 
listed before the backgrounder topic. 

Figure 83: Article with two backgrounders - Clipping and Research.  There is also one 
comment for the article. 

10.4 	 IMPORT MENU 

The Import menu allows you to import and attach files in various formats to your 
article. There are several options available. 

L see Chapter 9: Including documents and images in articles for instructions. 
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i Import article from file 
This adds the text (and some formatting) from your source file to your article.  The 
file becomes incorporated into your article rather than just being attached separately. 

L see section 9.3ii: Import menu for more information. 

ii Attach original WP file 
Attaches the original wordprocessing file to your article. This file is listed in the 
Log tab and does not appear in the article’s content.  The file is attached with all 
formatting (and is not incorporated into your article text). 

L see section 9.4: Attaching WP files that you do NOT want to publish with your 
article for more information. 

iii Paste text from clipboard 
Uses Paste Special to insert any text on your clipboard into your article.  Your 
inserted text is incorporated into the article and some formatting from the source will 
be removed. 

L see section 7.7: Pasting from complex documents – using “Paste special…” 

iv Attach Pics 
Attaches images to be used by the print production team only.  Images imported here 
are listed in the Paper tab. They are not published on the web version of your 
article. 

L see section 9.6: Attaching images that are to be used in printed publishing only 
for more information. 

10.5 EXPORT MENU 

The Export menu is used to save your articles in different formats when they are 
ready to be published. For example, if you are going to publish to paper you may 
want to export the completed article to Quark XPress format. 

1. Open the article that you want to export to another format. 

2. Click on the Export menu. 

3. A list of available export formats displays. 

• InDesignXML 

• Quark XPress 

• Microsoft Word 

• InDesign 

• Text 

4. Select the required format you want to export your article to. 

Note 

You have to have the relevant export application installed to export to 
most of these formats. 
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5.	 The Export filename dialogue box displays, with the filename pre-filled.  
The default name for your exported file is first letter of the section, first 
letter of the subsection, then first word and first two letters of second word 
from the article description. 
For example, you have an article in section: Resources Subsection: Training 
with a Description “Acme corporation”.  You want to export it as a text file.  
edDesk would suggest an export filename of “rt_acmeco.txt” 

Figure 84: Export filename dialogue box 

6.	 <Save> your exported file. 

10.6 	 HIDE INFO 

Select this option if you want to display more text of your article, but do not want to 
see the information about the article at the top of your screen. 

1.	 Open the article and go into Edit mode.  The article information shows as 
below. 

Figure 85: Information shown when article is in Edit mode 

2.	 Click on <Hide Info>. 

3.	 The article information is hidden. 
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Figure 86: Same article as in Figure 85, above, after clicking on Hide Info 

4. Click on <Show Info> to see the information again. 

10.7 PREVIEW 

After you have entered your copy into the article form you can use Preview to see 
how your article would look if published on the web. 

Note 

This uses the default edDesk template for your site.  If your template is highly tailored 
the display will not reflect the final posted article. 
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11.	 Using article tabs 

This chapter gives instructions on entering information in the following tabs within 
articles: 

•	 Copy tab – where you enter information about your article.  
Information entered here is used for headlines, introductions etc, 
when your article is laid out. 

•	 Classification tab –a very important tab where you enter 
keywords for your article. Keywords are used by the Easy selector 
and other search features in edDesk. 

•	 Paper tab – Information entered here is used by printers and 
layout people when preparing your article for paper publishing. 

•	 Web tab – used when you are “webbifying” your article, for 
publishing on the web. 

•	 Log tab – displays information about the edits made to your article.  
Very useful when tracking changes that have been made to the 
article. 

Tabs not covered in this section are: 

•	 Basics tab – see section 6.3ii: Basics tab 

•	 Brief tab – see section 6.3iii: Brief tab 

•	 Workflow tab – see Chapter 13: Workflows 

11.1 	 OBJECTIVES 

By the end of this chapter you should be able to: 

•	 enter information to be used in the printed version of your article 

•	 enter information to be used in a web version of your article 

•	 correctly classify your article with keywords, geographical regions 

•	 amend article classification appropriately 

•	 enter details about the media format to which your article will be 
published 

•	 enter companies and events with which your article is associated 

•	 add links to an article that will be published on the web. 

11-1 



 
 

 

 
 

 

 

 

 

 

 

 

edDesk (Lotus Notes) User Guide 

11.2 	 COPY TAB 

The Copy tab is where you enter information about the structure of your article – 
Title, Headline, Introductory paragraph etc. 

The fields in this tab are used by export templates to place their contents in the 
relevant locations in your publication. 

Figure 87: Copy tab 

1.	 Title: Whatever you type in this field is displayed in search results and 
indexes. Make it meaningful! 

2.	 Headline: The heading for your article.  The appearance of this is 
determined by your template. 

3.	 Intro: Ifyou article has a separate introduction, enter it here.  This field is 
used as the first paragraph of your article, and appears in a style determined 
by your template. 

4.	 Summary: Enter a short summary of the article.  This field is used in 
section pages. It is also displayed under the article title in search results. 

5.	 Pull quote: no template uses this field yet.  Enter any quotes that you 
want to be prominently displayed in your article. 

6.	 Bio: no template uses this field yet.  Enter a brief biography of the author. 
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11.3 CLASSIFICATION TAB 

The Classification tab is where you enter keywords, geographical regions 
where the article is relevant, media format details and companies and people 
associated with an article.  This tab should be completed at the beginning of the 
subbing process. 

A well classified article is easy to find and is indexed appropriately.  Information 
entered in this tab is used by indexes and the Easy Selector. 

Many sites allow you to link to other articles with the same classification. 
For example, the Wheels magazine site – after the article text there is a heading 
>> Tags > which lists the classifications applied to this article and lets you link to 
articles with the same classification. 

Figure 88: article classification being used in the >> Tags: part of an article in the Wheels 
magazine website. 

The Classification tab is divided into four subtabs: 

• Keyword Topics 

• Geography 

• Product 

• Other 
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Figure 89: Classification tab, showing the Keyword Topics subtab 

Classification options not listed 

If your required classification options are not listed you will have to use the Setup
tab and add Keywords. 

L see section 20.6: Keyword topics for more information. 

Keyword Topics 
Keywords entered in the Keyword Topics tab are used by the Easy Selector. 

1. Click on the dropdown list in the New Topics field. 

2. Select the required keyword topic. 

3. A list of subtopics is displayed, each with a checkbox. 

4. Tick as many of the boxes as are relevant for your article. 

5. Click on <Add>. 

6. Your choices are listed next to Current topics. 
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Figure 90: Keyword Topics Education with Reference manuals and Research selected 

Need more than one keyword topic? 

You can classify your article by more than one keyword topic. 

1. Add your first keyword topic and subtopics. 

2. Click on the dropdown menu in the New Topics field. 

3. Select the required keyword topic. 

4. Select the required subtopics from the list. 

5. Click on <Add>. 

6. Your selected keywords are listed in the Current topics field. 

7. Repeat steps 2 through to 5 for each separate keyword topic. 

Figure 91: Selected keywords are displayed in the Current topics field.  Keywords have 
been chosen from Keyword Topics of Education and Business. 
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Geography 
The Geography tab is where you enter the regions where this article is relevant, or 
the regions to which this article refers. 

1. Click on the Geography tab. The Geography tab is displayed, as below. 

Figure 92: The Geography tab 

2. Click on the dropdown menu in the New regions field. 

3. Select the required region from the list. 

4. A list of areas in that region is displayed, each with a checkbox. 

5. Tick as many of the boxes as are relevant for your article. 

6. Click on <Add>. 

7. Your choices are listed next to Current regions. 
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Figure 93: Selected region is "Sydney" with selected areas of North Shore, Northern 
Beaches and South Western 

Need more than one region? 

You can classify your article by more than one region. 

1.	 Add your first region and areas. 

2.	 Click on the dropdown menu in the New regions field. 

3.	 Select the required region. 

4.	 Select the required areas in that region from the list. 

5.	 Click on <Add>. 

6.	 Your selected regions are listed in the Current regions field. 

7.	 Repeat steps 2 through to 5 for each region you want to add to this article. 

Deleting Keyword Topics and Geography 
If you have added keywords and/or geographical regions that are incorrect, or no 
longer relevant you should delete them from your article.  They will only be deleted 
from your article – you can still use them in other articles. 

1.	 Go to the Keyword topics or Geography tab (as appropriate). 

2.	 Click on <Delete>. 

3.	 The Delete topics dialogue box opens, listing all of the topics in your 
article. 
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Figure 94: Delete keyword topics - no selection made yet 

4. Select the keyword or geographical region to delete. 

Figure 95: Delete Keyword topics with Keyword topic: Education and 
subtopic:Reference manuals selected for deletion from this article 

5.	 Click <OK>. 

6.	 Your selections are deleted from this article. 

7.	 Your Keyword topics or Geography tabs now display your updated 
classifications. 

Figure 96: Keyword topics with the Keyword topic “Education>Reference manuals” deleted 
from this article 

Selecting more than one keyword topic or geographical region to delete 

1.	 Go to the Keyword topics or Geography tab (as appropriate). 

2.	 Click on <Delete>. 

3.	 The Delete topics dialogue box displays. 
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4.	 Hold down <Shift> while you click on the items to be deleted.  Each item 
to be deleted is highlighted in blue. 

5.	 Click on <OK>. 

Product 
The Product tab is used to enter details of the media format in which your article 
will be published. 

The fields in these tabs comply with the Australian Publishers Association’s 
implementation of ONIX standards. 

Product details tab 

This tab is where you enter information about the production format, ISBN details, 
pricing and availability of your publication and article(s). 

Order that the fields in the Product details tab are described 

Each field is listed in order that you get to it by pressing the <Tab> key to move 
around the form. 

Figure 97: Product > Product details tab 

1.	 ProductID Type: select the type of product ID from the dropdown list.  As 
per ONIX PR.2. 

2.	 ProductID: Use this only if the choice in the ProductID Type field 
indicates a proprietary scheme.  As per ONIX PR.2.8. 

3.	 Citation: 

4.	 ISBN: If your Product ID Type is an ISBN (International Standard Book 
Number), enter the ISBN number here. 

5.	 Product form: Select the format your final article will be presented as.  If 
you are unsure, leave Undefined selected. As per ONIX PR.3.1. 

6.	 Price: Enter the product price, as per ONIX PR.24.27 
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7.	 Product form description: If the codes in PR3.1 and PR3.2 of ONIX do 
not adequately describe the form of the product, enter a short description of 
the product. 

8.	 Price description: Further description of the price type, if needed.  As per 
ONIX PR.24.51. 

9.	 Contributor statement: Free text showing how the authorship should be 
described in an online display.  As per ONIX PR.8.33. 

10.	 Contributors: names of the contributors to this product. 

11.	 Distributor: Name of company distributing the final article in the selected 
format. 

12.	 Availability: Select the required option from the dropdown list.  As per 
ONIX PR.24.22. 

 Publishing information 

Order that the fields in the Publishing information tab are described 

Each field is listed in order that you get to it by pressing the <Tab> key to move 
around the form. 

Figure 98: Classification > Product details > Publishing information tab 

1.	 Imprint / brand: Full name of the imprint or brand under which the 
product is issued. As per ONIX PR.19 

2.	 Publisher / producer: The full name of the publisher of the product.  As 
per ONIX PR.19.11. 

3.	 Publication date: Date of first publication in the market n which it is first 
released. As per ONIX PR.20.5. 

4.	 Publisher role: Select the appropriate role from the dropdown list.  As per 
ONIX PR.19.7. 
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5.	 Pages: an indication of the total number of pages in a book or other printed 
format.  As per ONIX PR.12.1. 

6.	 Place published: City or town of publication. 

7.	 Page description: 

8.	 Edition number: The number of a numbered edition.  As per ONIX 
PR.10.2. 

9.	 Series: The full title of the series. No abbreviations or abridgement.  As 
per ONIX PR.5.6. 

10.	 Edition statement: Enter a description of a version or edition.  As per 
ONIX PR.10.4. 

11.	 Number in series: The distinctive enumeration of this product within a 
series. As per ONIX PR.5.7. 

12.	 Website link: URL for the website which is related to the publisher 
identified in the Publisher/producer field.  As per ONIX PR.9.21. 

13.	 Organisation Website: URL for the website related to the author. 

 Product classification 

Fields in this tab conform to the Book Industry Communication (BIC) international 
subject classification standards. 

Order that the fields in the Product classification tab are described 

Each field is listed in order that you get to it by pressing the <Tab> key to move 
around the form. 

Figure 99: Classification > Product > Product classification tab on entry. 
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1.	 BIC subject (level 1): Select the main subject from the dropdown list.  As 
per BIC standards. 

2.	 BIC subject (level 2): Select the secondary subject from the dropdown list.  
As per BIC standards. 

3.	 Code: This field is automatically completed with the BIC code for the 
selected subject/secondary subject for the product. 

4.	 Language of text: Select the language for this product from the dropdown 
list. You can select more than one language.  As per ONIX PR.11.1. 

5.	 Original language: If this product has been translated from another 
language, select the language from which this product was originally 
translated. As per ONIX PR.11.2. 

Other 
The Other tab is where you enter companies, events and people with which the 
article is associated. 

Companies keywords are used by the Content Easy selector.  See section 4.5: Easy 
Selector for more information. 

1.	 Click on the Other tab. The Other tab is displayed, as below. 

Figure 100: Classification > Other tab on entry. 

2.	 Companies: This is where you enter companies that are associated with 
this article. 

a.	 Click on the down arrow next to the Companies field. A list of all 
companies currently entered in Notes is displayed. 
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Figure 101: Current Companies dialogue box.  No companies are selected yet. 

b.	 Tick the box next each company to add it to your article. 

c.	 New keyword: If the company you want to add to the article is not 
listed, type the company name in the New keyword field. 

d.	 When you have selected all required companies, click <OK>. 

e.	 The Companies dialogue box is closed and the Other tab displays, 
with your selected companies listed. 

Figure 102: Selected companies.  The company "itechne" has been added in the 
New keyword field of the Companies dialogue box. 

3.	 Events: Enter events with which the article is associated.  For example, 
Press Conferences, Product Launches.  Separate each event with a comma. 

4.	 People: Enter people with whom the article is associated.  Separate each 
person with a comma. 
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11.4 	 PAPER TAB 

The Paper tab contains information related to the physical layout, production and 
printing of the article on paper. 

If you are publishing on the Web… 

If your article is going to be published only on the Web you do not need to enter 
information in this tab. 

Information entered in the Illustation instructions and Production directions 
fields is displayed in the following views from the Production tab: 

•	 Production directions 

•	 Layout 

Images must be prepared in the requested format, pixel size and quality in an image 
editing program before you add them to your edDesk articles.  Your editor should 
specify the image qualities of any image to be used in an article. 

L For more information on attaching images and entering filenames in the hi-res 
filenames field see Chapter 9: Including documents and images in articles. 

Figure 103: Paper tab when first selected. 

1.	 Production directions – used for general layout and print production 
instructions. These include whether the article should be laid out on a 
DPS (Double Page Spread), how to handle images or other design 
directions or suggestions. 

This field expands automatically if you type a lot of text in it. 

Figure 104: Production directions field default 

Figure 105: Production directions - automatically expanded, and including word 
wrapping, to accommodate lengthy text. 
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2.	 Illustration instructions – This is the only mandatory field in the Paper 
tab. Enter instructions specific to the positioning of illustrations.  This field 
automatically expands to accommodate lengthy text. 

3.	 Picture attachments – Used when you want to attach low resolution 
images that are not held in the current image directory.  The images 
attached here are usually to be submitted to the design team. 

Images for use on a website 

Images that are to be used on a website may be pasted directly into the 
article and do not need to be attached using this field. 

Images stored in the images directory 

This field is not used to upload any images that are already stored in the 
image directory for layout on paper.  You would enter the filenames of 
such images in the hi-res filenames field. 

4.	 Hi-res filenames – Enter the filenames and locations of the hi-resolution 
files that are stored in the images directory associated with the article.  Each 
filename should be entered on a new line, or separated with a comma. 

Figure 106: Hi-res filenames field with 2 images, each entered on a new line 

5.	 Caption suggestions – Enter any suggestions for captions for illustrations. 

6.	 Assigned page numbers – Take the page numbers from the publication 
flat plan / grid layout and type them here after the article is exported.  This 
is used in indexes generated by edDesk. 

7.	 Film deadline – Enter the film deadline date here. 

a. If you are not sure of the correct date format click on the 

calendar icon next to the date. A calendar is displayed. 

b. Click on the correct date. 

8.	 Export – click on the format you want to export your article to. 

a. InDesign Article – exports your article to an InDesign file.  The 
filename is automatically selected by edDesk and appears in the 
Export filename field. 

b. InDesign Sidebar - . 
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11.5 WEB TAB 

The Web tab is where you enter information about this article if it is to be published 
on the web (that is Intranets, Extranets and the Internet). 

The Web tab is divided into five sub tabs: 

• Posting details 

• Links 

• Tools 

• Caching 

• Metatags 

i Posting details 
Posting details is the default tab displayed when you click on Web. This is 
where you indicate when your article is to be published and whether people must 
subscribe to a service to see the article. 

Figure 107: Web tab with default sub tab of Posting details displayed 

1. Click on Web. The Posting details tab displays. 

2. Post date – you choose when the article is to be published: 

a.	 Use issueonsale date 
Click on this option if you want to accept the date that the entire 
volume / issue is to be published.  This date is specified by the person 
who enters information about the Volume and Issue number in the 
Production tab. 

L see section 20.5: Production schedule – volume and issue 
definitions for more information. 

b.	 Select a post date manually 
Click on this option if you want to select a particular date for this 
article to be published. This date may be different from the general 
publishing date for the Volume / Issue. 

1.	 After you click this option, click on either <Save> or press 
<F9>. 
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Refresh key 

<F9> is Lotus Notes “Refresh” key – if you press this key your screen 
display is updated. 

You can also click on the Refresh icon, . 

2.	 A date field displays. Enter the publish date for your article.  
Dates must be in the format dd/mm/yyyy.  For example, 
25/05/2005 

3. If you are not sure of the correct date format click on the 

calendar icon next to the date. A calendar is displayed. 

4.	 Click on the required date. 

3.	 Access – who can read your article? 

a.	 Public – when your article is published anyone can read it. 

b.	 Subscriber – when your article is published people are prompted for a 
login / password to read your article. 

4.	 Article URL – copy the contents of this field if you are linking to this article 
from other edDesk articles.  L see section 8.9: Creating link (text) hotspots 
– Linking to other articles and external sites for more information. 

Links 
The Links tab may be used to add links to other pages, either on your own website, 
or on the Internet in general. Export templates determine the display position of 
those links when your article is published. 

If you want to link to other articles, or another website from the text of your article, 
use Hotspot links. 

L see section 8.9: Creating link (text) hotspots – Linking to other articles and 
external sites and 

L see section 9.9: Image hotspots for more information. 

1.	 Click on Links. 

2.	 Click on <Add New Links>. 

3.	 The Add Links dialogue box opens. 
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Figure 108: Add new link dialogue box on entry 

4.	 Link title: Enter the words you want to use as the link (this is what people 
click on to follow your link). 

5.	 Type: select the type of link from the dropdown list.  You will then need to 
complete further fields depending on the link type selected. 

Your link types are: 

•	 Article on this website 

•	 Companion website (this is also known as an “extranet”) 

•	 External website 

•	 Attachment 
For example, if you select a Type of “Article on this website” you will then 
have to supply the address for the article. 

Article on this website 

If you want to link to another article in your own website do the following: 

1.	 Select Article on this website. 

2.	 Click on <Get the address for an article>. 

3.	 A list of all volumes and issues in your database displays. 
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Figure 109: Link type of Article on this website has been selected 

4.	 Drill through the required categories until you have the article listed. 

5.	 Click <OK>. 

6.	 The Address field now displays “articleIDs/”. 

7.	 Click on <Add to links>. 

8.	 When you have finished adding links to your article click on <OK>. 

9.	 The dialogue box closes and you are returned to the Links tab. 

External website and Companion website 

If you want to link to a site on the Internet (that is, external to your own site) or to an 
Extranet, do the following: 

1.	 Select External website. 

2.	 Address: Enter the address of the site in the address field.  You will need to 
enter the entire address. 

Easy way to get an external address 

Open a browser window (this is probably Internet Explorer).
 

Go to the address you want to link to. Use your usual method of getting to
 
this address (eg. Search engine, from Favorites, from another site… 

whatever it takes).
 

Highlight the entire contents of the Address field and copy it.
 

Go back to edDesk and display the Links dialogue box.
 

Paste your address into the Address field.
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3. Click on <Add to links>. 

4. When you have finished adding links to your article click on <OK>. 

5. The dialogue box closes and you are returned to the links tab. 

Attachment 

Select this option if you want to link to a file that is not a website (this may be a 
PDF, image, document etc). 

Note 

You must attach the file to the article before you can link to it. 

1. Select Attachment. 

2. Click on <Select an attachment>. 

3. A list of all files that have been attached to this article is displayed. 

Figure 110: Link type Attachment selected.  Lists all files that have been attached 
to this article. 

4. Click on the file to which you want to link. 

5. Click on <OK>. 

6. edDesk enters its own address for the attachment.  Do not edit this address! 

Figure 111: edDesk's formatting of the address for a linked attachment 

7. When you have finished adding links to your article click on <OK>. 

8. The dialogue box closes and you are returned to the Links tab. 
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iii Tools 
The Tools tab contains information that is completely customised for each 
organisation, so is not discussed in this User Guide.  Generally the Tools tab 
contains an option that flags an article so that a web developer can use the 
information.  This option is often used in shopping carts. 

Figure 112: Tools tab 

Caching 
Many websites allow storage of previously retrieved pages.  If a person clicks on a 
link to that page, the already stored version is displayed.  This is known as caching. 
Caching reduces load on the web, making your page faster to display.  However, you 
may not always be looking at the most up-to-date version of a page. 

If you have pages where it is imperative that a person be viewing the most recent 
version, even if it takes longer to display, you can set the caching to never.  If it is 
more important the page display quickly (and not be checked by the browser each 
time it is requested) then you can set the caching to a longer period of time. 

The Caching tab lets you set your caching requirements. 

Figure 113: Caching tab with default settings shown. 

1. Click on Caching. 

2. Caching for this article: There are several options available: 
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•	 Use site default settings – the default value. This is whatever your 
administrator has set for your site generally.  If in doubt, select this 
option. 

•	 Never – select this option if you want the browser to check every 
time a page is requested.  This is for pages which are often updated 
– and may be updated several times a day. 

•	 Cache for the same day – once a page is retrieved, it is cached for 
the rest of the day. Choose this option if your pages change 
regularly but not usually throughout the course of a single day. 

•	 Cache for multiple days – choose this option if your page is not 
likely to be regularly updated. 

3.	 Number of days: If you have selected Cache for multiple days you must 
enter the number of days you want your page to be cached in this field. 

Metatags 
A metatag is used to describe your page content.  Metatags (also known as metadata) 
are used by search engines to help people find your pages. 

edDesk lets you add information about two aspects of pages – keywords and 
description. These are the most often used metadata fields by search engines. 

1.	 Keywords: add words or phrases that best describe the content of your 
page. Separate your keywords and phrases with a comma.  Keywords that 
you enter here are appended to the Keyword Topics metadata when the 
article is posted onto the web. 

2.	 Description. Enter a brief one or two sentence description of your page.  
The description often appears under a page title when it is listed in search 
results. Make it meaningful!  The Description and Summary fields 
(Summary field is in the Copy tab) are appended to the Description 
metadata when the article is posted onto the web. 

Figure 114: Metatags tab with keywords and description. 
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11.6 LOG TAB 

The Log tab records changes made to an article.  If the article has been filed, 
submitted, or exported to a publishing format you can view those versions of the 
article. A brief revision history, of the five most recent edits, with numbered 
revisions is also displayed. 

You can also use the Log tab to attach original wordprocessing files that you do not 
want to be published with your article. L see Chapter 9: Including documents and 
images in articles for more information. 

Figure 115: Log tab, listing an attached WP file. 

Viewing filed, submitted and exported versions of your article 
You may preview those versions of your article that you have filed, submitted or 
exported. This depends on you using to Workflow tab to update the status of your 
article. 

You may not change the views – just preview the contents of the article as they were 
at the time of filing, submitting and exporting. 

Viewing Filed Copy 

1. Click on <View Filed Copy>. 

2. You will see a preview of the version of the article that you filed. 
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Figure 116: Preview of filed article text 

Viewing Submitted  Copy 

1.	 Click on <View Submitted Copy>. 

2.	 You will see a preview of the version of the article that you submitted. 

Viewing Exported  Copy 

1.	 Click on <View Exported Copy>. 

2.	 You will see a preview of the version of the article that you have exported 
to another format. 

L see section 10.5: Export menu for instructions on exporting articles. 
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12.	 Creating hierarchical content - related 
articles 

Articles can be in a hierarchy of “related articles”.  You can have a “parent” article, 
usually general information or an introduction, and then create “children” for more 
specific information.  The children can have children of their own – a whole 
“family”. 

A hierarchy makes it easy to order your story, move the separate elements around 
and insert more related articles. 

edDesk displays the related articles (parents and children) with the children indented 
under the parent. You can have as many levels as you need. 

12.1 	 OBJECTIVES 

By the end of this chapter you should be able to: 

•	 create related articles 

• create several levels of related articles 

• order your articles 

•	 reorder your related articles within their hierarchical level 

•	 move articles to another level in a hierarchy. 

12-1 



 
 

 

 

 

 

 

 

 

 

 

 

  
 

  

edDesk (Lotus Notes) User Guide 

12.2 EXAMPLE OF AN ARTICLE HIERARCHY 

Below is an example of a hierarchy of related articles.  There is also an explanation 
of how each article relates to its hierarchy. 

Figure 117: Example of parent article Quantitative Legal Needs Survey - Bega Valley (Pilot) 
with some of its children 

Each level of the hierarchy is indented from its parent.  Articles at the same level in 
the hierarchy are indented the same amount. 

In the example above, the following subarticles are at the same level in the 
hierarchy: 

• Preface 

• Acknowledgements 

• Access to Justice and Legal Needs Program: Terms of Reference 

• 1: Introduction 

• 2: The Pilot Survey 

• 3: The Incidence of Legal Events 

Note 

In the above example the structure has been taken from a report with numbered 
chapters.  The numbered subarticles refer to chapter numbers only and have been 
entered as part of the article subject. 
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In addition the following subarticles have children of their own: 

1: Introduction 

•	 The pilot survey 

•	 Structure of this report 

2: The Pilot Survey 

•	 Methodology 

•	 Issues associated with the pilot survey 

3: The Incidence of Legal Events 

•	 Number of legal events 

•	 What factors affect whether participants experience any 
legal events at all? (this one only partly visible at the 
bottom of the example) 

The fourth hierarchical level contains the children of Methodology: 

•	 Questionnaire Design 

•	 Conduct 

•	 Sampling 

•	 Analysis 

12.3 	 THE IMPORTANCE OF STORY ORDER IN A HIERARCHY 

Story order determines where an article is placed in a hierarchy.  Story order is a 
mandatory numerical field that is filled in when an article is created.  Story order can 
be changed if you want to move an article within a hierarchy. 

Use century numbering when creating articles and the first level of subarticles. 
Century numbering means that each article is given a number expressed in whole 
hundreds – for example 100, 200, 300. You can continue to use century numbering 
for all levels of your hierarchy (although it is equally common to number articles 
further down the hierarchy in tens). 

Century numbering allows you to insert extra articles into a hierarchy, without 
having to change the story order in all the articles that you want to be after your 
inserted article. To maximise the number of articles that you can insert easily, it is 
best to give your inserted article a number as close to the middle of the numbers you 
are inserting between. 
For example, you have numbered your articles 100, 200, 300, 400.  You now want to 
place another article between those numbered 300 and 400.  You could give your 
inserted article a number of 350.  If you then decide to insert another article 
between 300 and 350 you could give that article a story order of 325 (or any number 
between the numbers you are inserting between). 

The numbers in the example below indicate the story order for each article and its 
related articles. For clarity of the following diagram, each hierarchical level has its 
story order in the same colour.  You do not see the numbers until you edit an article. 
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Figure 118: 4 levels of article hierarchy with the story order shown. 

Numbers are restarted for the children of each parent. 

In the example above you can see that a second level subarticle: 1: Introduction has 
two children. They are numbered 10 and 20.  The next second level subarticle 
2: The Pilot Survey also has two children. They also are numbered 10 and 20. 

12.4 CREATING A RELATED ARTICLE 

Related articles can be created by three methods: 

• when you are editing the article that is to be the parent article 

• when you are in a view and have clicked on an article to select it 

• when you have opened an article, but have not selected <Edit>. 

These methods all have the same result – a new article that is a child of the selected 
article. 

i The three methods of creating related articles 

From editing the article that is to be the parent 

1. Open the article that you want to be the parent. 

2. Go into Edit mode. 

3. Click on <New>. 

4. Select Related Article. 
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When you are in a view 

You cannot create a related article from all views – only those views that have a 
toolbar at the top. 

Figure 119: Toolbar at top of a view from which you can create a Related Article 

1.	 Scroll to the article that you want to be the parent. 

2.	 Click once on the article.  The article summary is highlighted with a 
rectangle. 

Figure 120: Selected article is highlighted with a rectangle 

3.	 Click on <New> in the toolbar. 

4.	 Select Related Article. 

When you have opened an article, but are not yet editing the article 

1.	 Open the article that you want to be the parent. 

2.	 Click on <New>. 

3.	 Select Related Article. 

Filling in article details 
After you have selected Related Article the Related Article form displays. 

Figure 121: Initial form displayed after Related Article is selected

 Unavailable fields 

Related articles automatically inherit some values from their parent.  Fields that 
inherit values (and that you do not need to enter details for) are: 

• Section 

• Subsection 

• Volume 
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• Number 

Tabs you need to complete for each related article 

Each child article needs to be tracked through workflow, status and briefing 
instructions independently of its parent article.  This is because you might have a 
parent article by one writer and child articles by various other writers.  Although the 
entire article will be published at once (hence the same volume, issue details) there 
will be different authors and workflow statuses for each child article. 
Take, for example a magazine car supplement.  You might have a main article 
written by one author, a series of reviews of car models by individual other review 
writers, and a series of sideboxes from yet another author. Each related item will 
have different authors, status (briefed, filed, subbed etc), briefing instructions and 
copy deadlines etc. 

L see Chapter 13: Workflows for instructions on entering information in the 
Workflow tab. (Section 13.2: Workflow for authors has instructions forauthors.) 

L see section 6.3iii: Brief tab for instructions on entering information in the Brief 
tab. 

L see Chapter 7: Entering copy into edDesk for instructions on entering your copy 
into articles. 

L see Chapter 11: Using article tabs for instructions on using the various tabs 
available in articles. 

Filling in the Basics tab 

1.	 Subject: enter a meaningful description for this related article. 

2.	 Type: What type of article is this?  The default type is Subarticle. The 
type is displayed in several views. Make sure you select a type that is 
meaningful and conveys what the article contains. 
For example, if you are writing a book you might like to have a type of 
Chapter.  If you are creating a related article for graphics and charts, 
select a type of Graphics & Charts. 

Figure 122: Some of the available types of article and related article 
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In Figure 122, above, the article / related article type is displayed as the text 
before the colon. Types listed above include: Related Literature, Stories, 
Subarticle. 

3.	 Story order: enter the order that you want this related article to appear 
under your parent article. If this is the first child of the parent article you 
would usually have a story order of 10, second child would be 20 and so on. 

12.5 	 SAVING YOUR RELATED ARTICLE 

1.	 Complete all required fields and tabs. 

2.	 Do one of the following: 

•	 Click on <Save & Close> if you want to save and close your 
related article (you can do further edits later) OR 

•	 Press <Ctrl>+s to save your article but continue editing it. 

12.6 	 CREATING SEVERAL LEVELS OF RELATED ARTICLES 

You may have as many levels of related articles as you wish.  Many magazines have 
two levels. Some academic reports may have four levels. 

i 	 Creating two levels of articles 
The instructions presented in section 12.4: Creating a related article apply to two 
levels of articles. The parent article is the first level, the related article is the second 
level. 

ii 	 Creating more than two levels of related articles 
More than two levels of related articles 

Although edDesk allows you to create several levels, there are a few steps that must 
be done.  Follow the instructions below. 

Note about diagrams used in this section 

The diagrams used in this section follow the creation of a related article that is in the 
fourth level of a hierarchy. Any asterisks appearing in the diagrams are for emphasis 
in the instructions only – they do not display in edDesk. 

1.	 Go to a view that lists all the articles in a hierarchy.  Views that do this are 
All Issues and Sections. 

2.	 Click on the article that you want to become the parent. 
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Figure 123: Future parent is the subarticle Methodology - outlined with a rectangle.  
Methodology already has four children.  Parent article is indicated with * for 
emphasis. 

3.	 Click on <New> in the toolbar. 

4.	 Select Related Article. Your new related article is opened.  

5.	 Fill in the article fields as appropriate. 

Figure 124: Related article with Type of “Other collateral” and Story order of “50” 
as we want this article to be listed as the 5th child of the selected parent. 

6.	 <Save & Close> your related article. 

7.	 You are now returned to the view from which you created a related article.  
Your article is NOT where you wanted to put it!  That is, it is not shown as 
a child of the desired parent. 

Your related article is always initially displayed as a second level 
article, no matter which level of the hierarchy you want to put it in.  
You need to move it to the required place in the hierarchy. 
Remember that parent and the first level child articles use century 
numbering (100, 200 etc) for their story orders.  If your related article has a 
story order less than 100 it will be listed underneath the topmost parent. 
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Figure 125: New article (example used in Figure 104) in incorrect place in 
hierarchy.  Article is indicated with ** for emphasis. 

8.	 Click once on the child article that you want to move to the correct place in 
the hierarchy. Your article is now highlighted with a rectangle. 

Figure 126: selected child article to be moved to correct place in hierarchy.  
Selected article is highlighted with a rectangle. 

9.	 Cut your article from its current place in the hierarchy by doing one of: 

•	 <Ctrl>+x; OR 

•	 select the Edit menu then select Cut. 

10.	 Click on the correct parent article.  The parent article is now highlighted 
with a rectangle. 

Figure 127: Parent article highlighted with rectangle.  The child article you have 
just cut will be pasted under this parent. 

11.	 Paste your child article into its correct place in the hierarchy by doing one 
of: 

•	 <Ctrl>+v; OR 

•	 select the Edit menu then select Paste. 

Your child article is now in the correct place in the hierarchy.  You will need to 
repeat this procedure for each child article that is higher than the second level in a 
hierarchy. 
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Figure 128: Related article now pasted into the correct place in the hierarchy - as a child of 
Methodology 

12.7 	 REORDERING YOUR ARTICLES – MOVING THEM AROUND WITHIN A 
HIERARCHICAL LEVEL 

If you want to reorder your articles you need to change their Story order. This is 
made much simpler if you use either century numbering (or numbering by tens). 

Following the example used through section 12.6: Creating several levels of related 
articles… 

If we now want our new related article, “Test Related Article” to be listed 
as the third child of the parent (Methodology), we need to make sure that 
the story order for “Test Related Article” is given a number between the 
current second (Conduct) and third (Sampling) articles.  They have a story 
order of 20 and 30 respectively. 

Figure 129: Original story order with “Test Related Article” having story order of 50 
and listed as the fifth child of “Methodology” 

“Test Related Article” can be given a number anywhere between 20 and 30, 
but in case we want to insert other articles, it is best to change its story 
order to 25 – halfway between 20 and 30. 
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Figure 130: “Test Related Article” with story order 25 - now listed as the third child 
of “Methodology” 

1.	 Open the article you want to move. 

2.	 Go into Edit mode. 

3.	 Change the Story order so that your new number is between the article you 
want to be listed before and the article you want to be listed after your 
moved article. 

4.	 <Save & Close> your changes. 

5.	 Your article is now displayed in its new position in the hierarchy. 

12.8 	 MOVING YOUR ARTICLES TO ANOTHER LEVEL OF A HIERARCHY 

1.	 Click once on the article that you want to move to another place in the 
hierarchy. Your article is highlighted with a rectangle. 

2.	 Cut your article from its current place in the hierarchy by doing one of: 

•	 <Ctrl>+x; OR 

•	 select the Edit menu then select Cut. 

3.	 Click on the article that you want to be the parent article.  The parent article 
is highlighted with a rectangle. 

4.	 Paste your child article into its new hierarchical place by doing one of: 

•	 <Ctrl>+v; OR 

•	 select the Edit menu then select Paste. 

5. Your article has now been moved to a new place in the hierarchy. 
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13.	 Workflows 

Workflow is the tracking of the status and progress of an article through the 
publishing process. 

Information entered in the Workflow tab is used in many views, especially those in 
the Editing tab. 
For example, the view Changes required relies on information entered in the 
workflow tab of articles. If the information is not entered then an article won’t be 
listed in the view – even if there really are changes required! 

13.1 	 OBJECTIVES 

By the end of this chapter you should: 

•	 understand what is meant by “workflow” 

•	 understand the importance of updating information in the 
Workflow tab 

•	 be able to correctly update workflow information 

•	 know when to update the copy status 

•	 know when to use print status 

•	 know when to use web status 

•	 be able to save different versions of an article 

•	 be able to change the versioning settings for an article. 

13.2 	 WORKFLOW FOR AUTHORS 

Authors usually need to know how to file an article.  Sub-editors and editors require 
a more in-depth knowledge of workflow.  This section gives instructions on 
workflow as used by authors/article contributors. 

1.	 Enter your copy into the article and format it appropriately. 

2.	 Save the article. 

3.	 Go to the Workflow tab. Look at the article’s Copy status – it is probably 
Briefed. 

4.	 Click on the dropdown list next to Copy status: 

5.	 Select Filed. 

6.	 <Save> or <Save & Close> the article. 

13.3 	 WORKFLOW TAB 

The Workflow tab tracks the progress of the article through the editing process.  
This section is primarily for editors, system administrators and your webmaster.  
Authors do not usually need to know as much about workflow as is in this section 
(see section 13.2: Workflow for authors). 
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The status of three publishing procedures is tracked: 

• Copy status 

• Print status 

• Web status. 

This tab is displayed differently depending on whether you are editing a parent 
article or a child article (subarticle).  However, the same types of information may 
be entered in each tab. 

A parent article (and first level articles) has separate subtabs for Status, Editing 
notes, Changes requests and versioning. A subarticle combines these into the single 
Workflow tab. 

L see section 6.2: What is an article? and 

L Chapter 12: Creating hierarchical content – related articles for more information 
on related (parent and child) articles.

 Parent article 

A parent article displays the Workflow tab with subtabs. This allows more detailed 
information about changes required and editing notes to be entered for the parent. 

Figure 131: Workflow tab with subtabs - parent article 
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 Child article 

A child article displays the workflow tab on a single form.  This allows you to see a 
more summarised version of information than in the subtabs of the parent article. 

Figure 132: Workflow tab on single form – related article 

ii 	 Copy status 
This is initially set to Concept. Concept means that there is a story idea (articles 
with the status of concept are listed in the Story ideas view) but the article has not 
yet been briefed to an author. 

Copy status will not automatically perform tasks for you!  It only indicates that you 
have done some other task associated with moving the article through the publishing 
process. 
For example, if you have already filed the article you would then go to the Workflow 
tab and update the Copy status.  However, if you just update Copy status and the 
article has not really been filed edDesk will not do the filing for you – it updates the 
status only. 

1.	 Copy status: Click on the dropdown arrow next to the current status. 

2.	 Select the article’s new status. 

3.	 Copy sent to author: Check this box when you have sent the edited copy 
to the author for approval. 

4.	 Author approval: check this box when you have received approval of the 
edited copy from the author.  (This may not always be required.) 

5.	 To: Enter the author’s email address here.  If you have the author in an 
address book already, you can click on the down arrow next to the To field 
and select them from that address book. 

6.	 Email a copy: Click on this button to email the edited article to the author.  
The email is sent to the address entered in the To field. 
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7.	 Request approval: Click on this button to request approval for the edits 
from the author.  The email is sent to the address entered in the To field. 

Print status 
You do not need to update this status if the article is going to be published on the 
web only. The Print status is only updated after the edited article has Copy status 
Approved. 

Note 


Print status should be updated after the copy status is set to Approved.
 

1.	 Check that the Copy status is set to Approved. 

2.	 Select the Print status. Often it will change from None to Laid Out. 

3.	 Proof sent to author: Check this box when the proof has been sent to the 
author or client for approval. (This may not always be required.) 

4.	 Author approved: Check this box when the author or client has approved 
the proof. (This may not always be required.) 

iv 	 Web Status 
You only need to update this status if your article is to be published on the web. 

The following statuses are available: 

• None – not going to be published on the web 

• Pre-web – has not yet been prepared for web publishing 

•	 Webified – has been prepared for web publishing 

•	 Preview – available for your team to preview and review 

•	 Posted – has been published on the web 

•	 Archive – old article. Probably no longer generally available for 
viewing, but has been archived so it can be retrieved if required. 

1.	 Click on the required web status. 

2.	 Approve and Post: If your article has a Copy status of Approved (check 
the workflow status) and the article is ready for publishing on the web click 
on <Approve and Post>. 

<Approve and Post> runs a script that changes your article’s workflow 
status to Approved (if it does not already have this status) and publishes 
your article. 

13.4 	 EDITING NOTES 

Editing notes are entered by an editor after the story has been submitted.  They are 
for any editing related comment. 

Editing notes are displayed in the Notes field of the Subs work desk view (from the 
Production tab). 
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Figure 133:Notes field of the Subs work desk view.  This field has the assigned person as 
Frances Borkman and also indicates that this editing note has been acknowledged. 

Figure 134: Editing notes tab (for a first level article). 

Editing notes 

Figure 135: Editing notes field in a subarticle. 
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1.	 Go to the Workflow > Editing notes tab (for a first level article) or to 
the Workflow tab and Editing notes field in a subarticle. 

2.	 Type your editing note. 

3.	 Assigned to: Enter the email address of the person who will be responding 
to the editing note – usually this will be the author. 

4.	 Click on <Email a copy>. An email, containing the text of the article is 
sent to the author. 

5.	 Save your article. 

6.	 When the editing note has been acknowledged tick the Acknowledged box. 
The Subs work desk view shows the person to whom the editing note was 
assigned and whether it has been acknowledged. 

Completed editing notes 

When an editing note has been completed the note is no longer listed in the Subs 
work desk view. 

13.5 	 CHANGE REQUESTS 

Editors can use the Change Requests tab to request changes to be made to an 
article. After an author has made the requested changes the Change requests 
tab must be updated. 

Updates made in the Change requests tab appear in the Changes required view 
(from the Production tab and the Editing tab). 

Figure 136: Changes required view showing that the Changes required has been Requested 
and Acknowledged. 
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Figure 137: Change requests tab in a first level article, with Change status as Requested 
and Acknowledged 

Changes 

Figure 138: Changes field in a subarticle. 

Editor - entering a change request 
1.	 Go to the Workflow > Change requests tab (for a first level article) or 

to the Workflow tab and Changes field in a subarticle. 

2.	 Type your request. For subarticles, this is typed in the Changes field. 

3.	 Assigned to: Enter the email address of the person who will be making the 
changes – usually this will be the author. 

4.	 Click on <Email a copy>. An email, containing the text of the article is 
sent to the author. 

5.	 Tick the Requested option. 

6.	 Save your article. 
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Author - updating a change request 
1.	 Open edDesk and check your email.  You will receive an email that 

contains the text of the article that needs changes. 

2.	 Open the article, go to the Workflow > Change requests tab (or to the 
Workflow tab and Changes field in a subarticle) and note the changes 
that have been requested. 

3.	 Tick the Acknowledged box. 

4.	 Make the changes in the article, as requested. 

Article text displayed 

The article text is displayed under the Workflow tab – so you can make 
changes, while you still have those requested changes on the screen. 

5. Tick the Completed box. 

6. <Save> your changes. 

Completed change requests 

When a change request has been completed the request is no longer listed in the 
Changes required view. 
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13.6 	 VERSIONING 

The Versioning tab lets you control what happens to previous versions of your 
article when it is saved.  For example, you can track versions – letting you retrieve 
previous copies of an article and you can create new versions of the article when 
you need to. 

The Versioning tab is only available in first level articles (article that are not 
children of other articles). 

If you change the versioning settings for an article to allow you to save new versions 
of that article (and keep the old version as a reference) a new item is added to your 
article toolbar.  This is the Save New Version item. 

Figure 139: Article toolbar when in Edit mode.  The versioning settings do not allow different 
versions to be saved. 

Figure 140: Article toolbar when in Edit mode.  Versioning settings allow different versions of 
the article to be saved.  Note new item "Save New Version". 

Important 

If you are unsure of what this tab does make sure that the option Use System Settings 
is selected. 

Most people will not need to use the Versioning tab. 

Versioning choices 
Versioning choices are broken into two main categories – those that do not track 
versions and those that do. If versions are not tracked you do not have the 
Save New Version option available in your article toolbar and you cannot retrieve 
previous versions of your article. 

When you are selecting your versioning settings you need to decide how you want 
the Versioning to work in your article.  There are three main versioning methods: 

•	 Have your new version become a child article of the previous 
version.  Your changes are saved in the child article and the 
original article does not contain the changes. 

Be careful to edit the correct version.  Each time you save changes 
another version is created. If you edit a version then save it as a 
new version the new version is a child of the previous version - a 
hierarchy of different versions of the article. 
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Figure 141: New versions of the article are children of the original article.  If a 
version is edited and saved as New Version, the new version becomes a child of 
the previous version. 

•	 Have the new version promoted to be the main article and the 
previous version demoted to be a child. 
Your changes are saved in the main article and the previous 
version becomes a child article. This is probably the easiest 
method to select as you just have to edit the main article – previous 
versions are still retained, but you don’t have to remember which 
one to edit. 

•	 Have the new version and the previous version at the same 
hierarchical level – both main articles. 

Options that do not add Save New Version to your article toolbar 

•	 Use System Settings – accepts the default settings determined by 
your system administrator.  Use this option if you do not 
understand the other options. 

•	 Don’t track versions – Different versions of the article are not 
tracked.  You will not be able to retrieve previous versions of the 
article. 

Options that add the Save New Version item to your article toolbar 

Child article created for new version 

•	 Create response if File Save As New Version is used 
When you select <Save New Version> or File > Save as new 
version your changes are saved in a new version that is a child of 
the original article. The original article does not contain the 
changes - it stays as it was when you first went into Edit mode. 

•	 Create response automatically 
When you select <Save> or <Save & Close> your article a new 
version is automatically created.  The new version is a child of the 
original article.  The original article does not contain the changes 
made - it stays as it was when you first went into Edit mode. 

New version is now the parent article and the previous version is demoted to a 
child 

•	 Promote to main document if File Save As New Version is used 
When you select <Save New Version> or File > Save as new 
version your changes are saved in the main article and the previous 

13-10 




 
 

 

  

 

 
 

 

  

 

   
  

 
 

 
 

 

 

ii 

edDesk (Lotus Notes) User Guide 

version becomes a child article.  You just have to edit the main 
article – previous versions are still retained, but you don’t have to 
remember which one to edit. 

•	 Promote to main document automatically 
When you select <Save> or <Save & Close> your changes are 
saved in the main article and the previous version becomes a child 
article. This is the easiest method to select as you just have to 
edit the main article – previous versions are still retained, but 
you don’t have to remember which one to edit. 

Both the new version and the previous version are at the same level of the 
article hierarchy 

•	 Create additional main document if File Save As New Version is 
used 
When you select <Save New Version> or File > Save as new 
version your changes are saved in a new version of the main 
article. The new version is at the same hierarchical level as the 
previous version and is not indicated as a version in any way.  The 
newest version is at the bottom of the listed articles. 

•	 Create additional main document automatically 
When you select <Save> or <Save & Close> your changes are 
saved in a new version of the main article.  The new version is at 
the same hierarchical level as the previous version and is not 
indicated as a version in any way. The newest version is at the 
bottom of the listed articles. 

Setting your Versioning options 
1. Open the article for which you want Versioning. 

You can only set Versioning options in articles in the top level of 
the hierarchy (that is, not children of any other article). 

2.	 Go into Edit mode. 

3.	 Go to the Workflow > Versioning tab. 

4.	 Versioning: select the required versioning option. 

5.	 <Save> your changes. If you have selected to Create response 
automatically, promote to main document automatically or Create 
additional main document automatically your new version is 
automatically created for you. 

6.	 To display the <Save New Version> toolbar item you need to close 
your article, reopen it and go into Edit mode. 
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14. Editing homepages 

Every publication that is published on the web (Internet, intranets, extranets) has its 
own homepage.  If you have access to the Development tab, you can create new 
homepages and can edit existing ones. 

14.1 OBJECTIVES 

By the end of this chapter you should be: 

• able to list your publication’s homepages 

• familiar with the most commonly used fields in the homepages 

• able to update the Basics and Copy tabs 

• aware that other tabs are tailored for each client 

• able to edit the Module tab 

14.2 LISTING YOUR HOMEPAGES 

Homepages are available from the Development tab. If you cannot access this tab 
you will not be able to modify your homepages and will have to ask your system 
administrator to make any required changes. 

1. Click on the Development tab. 

2. Select View homepages. 

3. A list of all homepages for your database displays. 

Figure 142: List of homepages for the Wheels magazine website 

Information displayed is: 

• Type of homepage: 

o	 Site homes – the most recent page listed here is the 
homepage for your entire publication’s website. 

o	 Index homes – the web developer of your site determines if 
there are any homepages for other sections of your 
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publication. In the example above, there are separate 
homepages for the Showroom and the Showroom search 
sections of the Wheels publication.  Index homepages tend 
to be used if a section has a complex display. 

Figure 143: Index homepage used for Fashion section of Harpers Bazaar 
magazine website 

•	 PostDate: when the page was published (posted) on the website. 

•	 Name: name of the homepage.  Each homepage should have a 
name that indicates the nature of the homepage and the part of 
the publication to which it belongs. 

•	 Status: where the homepage is up to in the publishing process.  
Pages that have been published have a status of Posted. 

You can have more than one site home page posted but edDesk automatically uses 
the one with the latest PostDate. 

14.3 	 PREPARING TO EDIT A HOMEPAGE 

If you frequently update your homepage it is a good idea to copy the original 
homepage and make your changes to that copy.  That way, if something goes wrong 
you can easily revert to the original homepage. 

1.	 List the homepages. 

2.	 Click once on the homepage that you want to update. 

3.	 Copy this page. You can either select the Edit menu then Copy or use 
<Ctrl> + c. 

4.	 Paste the page. You can either select Edit > Paste or <Ctrl> + v. 
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5.	 You now have two identical site homepages listed.  The bottom one is the 
copy. 

6.	 Open the copy of the homepage. 

i 	 Changing the original homepage so that it is not displayed 
1.	 Go into Edit mode. 

2.	 Change the Web Status to None. 

3.	 <Save & Close> the page. 

ii 	 Displaying the copy of the homepage 
1.	 Open the homepage you want to display (this is the one that has a Status of 

Posted). 

2.	 Go into Edit mode. 

3.	 Change the PostDate to the date that you want to start displaying this new 
homepage. 

4.	 Make sure that the Web Status is Posted. 

5.	 Make any other changes to the page (L see section 14.4: Editing a 
homepage). 

6.	 <Save & Close> your new homepage. 

14.4 	 EDITING A HOMEPAGE 

This section does not discuss every field and tab within a homepage.  Most tabs and 
fields are customised for each client.  However, the concepts and major procedures 
are the same for each homepage. 

1.	 Double-click on the required homepage.  The homepage opens in Preview 
mode, and looks a lot like any other article.  Some homepages have HTML-
type code in the body. 

Figure 144: Homepage for Wheels magazine in Preview mode 
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2. Click on <Edit>. Your homepage is now in Edit mode and you will see 
more fields. 

Figure 145: Homepage for Wheels magazine in Edit mode 

3.	 The fields have been set up by itechne or your system administrator and you 
will not need to change most of them. 

4.	 Make the changes as required. 

5.	 <Save & Close> your homepage after you have made the required changes. 

6.	 Go to your website. If your edited homepage was published previously, 
you will see the changes you have made. 

i 	 Basics tab 
The Basics tab is displayed when you open a homepage. 

There are several fields that you will not need to change, unless you are a system 
administrator.  Fields you may change are: 

•	 Homepage title – this only displays in View homepages. 
Similar to subject field in articles. 

•	 Type – select from Site homepage or Index homepage. You will 
probably not need to change the setting. 

•	 Web status – indicates where the homepage is up to in the 
publishing process. Similar to workflow in articles. 

•	 Post date – date when the homepage is first published on the 
web. 

•	 End date – date that this homepage expires (and will be 
replaced with another homepage).  This is often left blank. 

ii 	 Copy tab 
This tab is similar to the Copy tab in articles. 

•	 Title – Whatever is typed here is displayed in search results and 
indexes, so make sure it is meaningful. 
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•	 Headline – appears as the main heading on the page. 

•	 Intro – this is used as the first paragraph of your homepage and 
appears in a style determined by your template. 

•	 Pull quote – Enter any quotes that you want to be prominently 
displayed in your homepage.  No template uses this field yet! 

•	 Summary – Enter a short summary of the homepage.  This field 
is used in section pages, so is only relevant for index 
homepages. 

•	 Bio – Enter a brief biography of the author or site. Not used by 
any templates at this stage. 

Modules tab 
Many databases and publications have tabs that you use in similar ways.  This 
section instructs you in updating information in those tabs. 

Customised tabs 

Remember that these tabs are customised for each publication, so the titles and 
fields may be different, although the method of updating is the same for each tab. 

The Modules tab lets you break down your homepage into different parts (or 
modules). You then select which items display in those modules. 

1.	 Go to the Modules tab. The available modules are listed in collapsed 
format. 

Figure 146: Modules tab listing modules in a collapsed format 

2.	 Click on the arrow next to the module you want to edit.  The module is 
expanded, displaying all editable fields. 
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Figure 147: Expanded module "More Top Stories" 

3.	 Numbered tabs (#1, #2 etc): Some expanded modules have several 
numbered tabs.  The number indicates the order that the tab is displayed in 
on the homepage.  The actual location on the page is determined by the 
output template (maintained by your system administrator or itechne 
technical staff). 

Each tab links to a separate article. 

4.	 Heading: enter any desired text for the heading for that article.  The 
heading is displayed on the homepage and can be different to the heading 
that has been entered into the article itself. 

5.	 Introduction: Enter introductory for the article.  The Introduction should 
capture a reader’s attention and encourage them to read the complete 
article. 

6.	 Link URL: This is URL of the article that will be displayed when people 
select to view the entire article. 

a.	 Open the article you want to link to. 

b.	 Highlight and copy the contents of the Web link field. 

c.	 Paste the contents into the Link URL field on the homepage. 

7.	 Image URL: If you are putting an image on the homepage, enter the image 
filename. 

8.	 Link text: This is the text that people click on to see the article in its 
entirety. 

Attachments and resource files 
If you are using images on your homepage you should attach them using the 
Attachments and resource files field. 
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L see section 7.8: Attachments and Resource files for instructions on using this 
field. 

Example of source and resulting homepage 

Example of a source homepage 

Figure 148: Source homepage for Wheels magazine site - note that the Top Story and More 
Top Stories fields are expanded 

Web page resulting from the source homepage above 

Page display 

The display of the webpage (eg. Fonts, page layout) is determined by the output 
template, that your organisation will create with assistance from itechne. 
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Figure 149: Homepage created from the source, (see Figure 143, above) 
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15.	 Housekeeping – cancelling articles, 
replication, favorite bookmarks, updating an 
index 

This section instructs you in the fundamentals of managing your content. 

Note: 

“Favorite” is spelled the US way as this is how it appears in Lotus Notes. 

15.1 	 OBJECTIVES 

By the end of this chapter you should be able to: 

•	 cancel an article 

•	 replicate your databases 

•	 see when databases have been most recently replicated 

•	 replicate only email 

•	 add your most commonly used databases to your Favorite 
bookmarks 

•	 update index of articles. 

15.2 	 CANCELLING AN ARTICLE 

Sometimes after an article has been started it will no longer be required. 

Cancel NOT delete 

It is important to cancel the article, and NOT delete it, so that a record of the article 
remains. 

Cancelling an article is done in the article’s workflow.  Cancelling means that there 
is still a record of the article having been commissioned, the author to whom it was 
briefed and the copy that was written.  If you delete the article all information about 
the article is deleted. 
For example, your editor has commissioned an article about sports cars.  There is an 
overview of the cars, each author has written an article about a car and there is a 
separate sidebox comparing the cars discussed.  It has now been decided that only 
the sidebox will be retained, and the separate articles are no longer required. 

1.	 Open the article to be cancelled. 

2.	 Go into Edit mode. 

3.	 Go to the Workflow tab. 

4.	 Click on the dropdown arrow next to Copy status: 

5.	 Select Cancelled. 
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Figure 150: Workflow tab for an article.  Change the copy status to Cancelled. 

Figure 151: Workflow tab for a related article / subarticle.  Change the Copy status 
to Cancelled. 

6. Click on <Save & Close>. 


Views now list the article with a copy status of Cancelled. 


15-2 



 
 

 

 
 

 

 

 
   

 

edDesk (Lotus Notes) User Guide 

Figure 152: View All Sections showing “Copy Status” of cancelled for the cancelled article 

15.3 REPLICATION 

Replication is the process of synchronising two databases.  It is used if you have 
Lotus Notes on your own computer and are not always logging directly into your 
organisation’s computer.  This is a common situation if you are working away from 
the office. Your local copy of Notes will be set up by your administrator to 
automatically replicate your databases throughout the day. 
For example you often work from home and have Notes on your home computer.  It 
is faster to use your own local version of the database to write and edit copy. (This is 
because your computer does not have to communicate with your work servers.)  
Your local Lotus Notes would be set up to replicate your databases several times a 
day. 

Replication ensures that both you and everyone else in your organisation are 
working with the most current information in your databases. 

Replication is done on the Replicator page. 
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Figure 153: Replication icon highlighted in the Bookmark bar 

1.	 Look at the bar running down the left side of your Notes screen.  (Notes 
calls this the Bookmark bar.) 

2.	 Click on the replication icon 

3.	 The Replicator page displays. 

. 

Figure 154: The Replicator page. 
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4.	 Information displayed includes: 

Figure 155: Closer view of the replicator page settings with the itechne Document 
Project edDesk database selected. 

•	 On: whether the item listed will be replicated. 

•	 Priority: lets you view settings for your items.  There is no need 
for most people to look at this. 

•	 Database: which databases are included in the replication process. 

•	 Last Run: when the replication last occurred. 

•	 Scope: indicates whether you are sending information to your 
server , receiving information or both . 

•	 Status: How many items have been Received and Sent and the 
name of the server that you are sending to and receiving from. 

Start now 
Sometimes you will want to manually start a replication of all or some of your 
databases. This is likely if you have created or edited several articles and want to 
ensure that others in your organisation can see the changes you have made. 

Figure 156: Replicator page using the Start Now menu to force a replication now as well as 
when it is normally scheduled. 

Selecting a single database to replicate 

1.	 Click on the database you want to replicate. 

2.	 Click on Start Now. 

3.	 Select Start Now. 
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Selecting to replicate mail only 

1. Click on Start Now. 

2. Select Start Mail Only Now. 

Replicating high priority databases. 

Your administrator will decide which databases are high priority. 

1. Click on Start Now. 

2. Select Start High Priority Databases Now. 

When is replication set to next occur? 
1. Look at the right side of the Replicator page. 

2. The next scheduled replication time is displayed. 

Figure 157: Top right of Replicator page showing next replication time - as set by 
your administrator. 

15.4 USING FAVORITE BOOKMARKS 

Favorite bookmarks are a way of listing and going to your most commonly used 
databases and pages. 

i Adding items to your Favorite Bookmarks list 
There are several ways of creating Favorite Bookmarks. Each item to be added to 
Favorite Bookmarks must be able to be displayed as a window tab. 

Figure 158: Window tabs. These can be added to the Favorite Bookmarks list. 

Right-click on the article 

1. Display the article or screen you want to add to your Favorite Bookmarks. 

2. Right-click on the item. 

3. Select Create Bookmark. 
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Drag a window to the Bookmark bar 

1.	 Display the article or screen you want to add to your Favorite Bookmarks. 

2. Hold down the left mouse button and drag the window tab to the 

Favorite Bookmarks icon . The title bar is greyed out and the mouse 
appears as the “no permission” sign, as in the diagram below. 

Figure 159: Dragging the titlebar with the "no permission" cursor indicating that the 
titlebar cannot be placed where it now is. 

3.	 When you reach the Favorites icon your Favorites list appears. 

4.	 Move your window tab to the position you want it to be listed at.  A 
horizontal line shows you where it will be placed. 

Figure 160: Titlebar and horizontal line showing where it will be placed in the 
Favorite Bookmarks list. 

5.	 Release the mouse button.  Your item is now in the Favorite Bookmarks 
list. 
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Creating a bookmark Folder 
1. Open the Favorite Bookmarks list. 

2. Click the New Folder icon at the top of the Favorite Bookmarks list. 

Figure 161: Mouse pointing to New Folder icon. 

3. Folder name: Type a name for your new folder. 

4. Click on the Folder that you want to put your new folder in. 

Figure 162: New folder called "News items" to be put into the Favorite Bookmarks 
folder. 

5. Click on <OK>. 

Removing an item from the Favorite Bookmarks list 
1. Right click on the item to be removed. 

2. Select Remove Bookmark or Remove Folder. 

Note 

When you Remove Folder you also remove all bookmarks in that folder. 

15.5 UPDATING AN INDEX 

Search engines use indexes to help articles be quickly located and listed on your 
screen. edDesk uses full text indexes because they allow more accurate searching 
of the articles in your databases. 

If you work on your organisation’s server (on a network) the indexes are up-to-date.  
If you work on your own local version of Lotus Notes, indexing is done as a 
“background task” whenever your computer is not too busy – if it’s always busy the 
indexing may not be done as frequently as you need. 
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If you have database permission you can manually update indexes. 

Does my database use a full-text index? 
To see if your database uses a full-text index do the following: 

1.	 Go to a View that displays the Search bar. (All Issues and Sections views 
display the search bar). 

Figure 163: Search bar.  This example is from the "All Issues" view, but other 
views also have the Search bar. 

2.	 Look at the top right of the Search bar. You see the word Indexed with 
either: 

i. a green circle – full text indexed 

ii. a brown circle – not full text indexed. 

When was my index last updated? 
1.	 Go to a view that displays the Search bar. 

2.	 Click on <More>. 

3.	 Your Search bar is expanded. The right side of the search bar is below: 

Figure 164: Search bar with indexing details shown. 

4.	 You can see the date your database was last indexed and how many 
documents were included in your index. 
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Updating an index 
If you notice that the index has not been updated recently and you know that there 
have been several changes made to the articles in the database you can update the 
index. 

The diagram above shows the database was last indexed on 26/08/2005.  The screen 
capture was taken on 30/08/2005. Therefore the index has not been updated for four 
days – this database is also a training database, not a “real live” database, and does 
not have many articles added or edited. 

To update the index: 

1. Go to a view that displays the Search bar. 

2. Click on <More>. 

3. Your Search bar is expanded. 

4. Click on <Update Index>. 
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16.	 Webifying your article – getting ready to 
publish on the web 

If your article is to be published on the web (including intranets) it must be 
“webified”. Many of the steps involved in webifying an article are explained in 
detail in other chapters of this user guide.  These other chapters are referred to in 
each webifying section. 

16.1 	 OBJECTIVES 

By the end of this chapter you will be familiar with the steps needed to webify your 
article to ensure that it is in a format able to be published on the web. 

16.2 	 STEPS INVOLVED IN WEBIFYING AN ARTICLE 

i 	 Paste images into the body of the article 
Images must be put in the body of the article in the position that you want them to 

appear in the published version of your article. 


Pictures that have been added to your article using the Paper tab, 

<Attach Pictures> or the Attachments and resource files field will not appear in 

the article unless they are pasted into the body of the article. 


L see Chapter 9: Including documents and images in articles. 

ii 	 Classifying your article 
Check that the classifications that have been applied to your article are still relevant. 

L see section 11.3: Classification tab for information on adding and updating 
classification details. 

iii 	 Add links to external sites – if needed 
If your article refers to other organisation’s websites and you want your readers to be 
able to quickly go to those other sites, you need to create links to those sites.  Links 
are created by adding Hotspot links. 

L see section 8.9: Creating link (text) hotspots – Linking to other articles and 
external sites and section 9.9: Image hotspots. 

iv 	 Replace internal page references with hotspot links - if needed 
This is mostly relevant when you are converting large articles, or written reports, 
into several smaller articles and subarticles.  Links are created by adding Hotspot 
links. 

L see section 8.9: Creating link (text) hotspots – Linking to other articles and 
external sites and see section 9.9: Image hotspots. 
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17.	 Printing edDesk content 

edDesk allows you to print views and individual articles.  You can select various 
print formats and inclusions.  Printing views is often used for printing details of 
articles for a particular issue of a publication. 

17.1 	 OBJECTIVES 

By the end of this chapter you should be able to: 

•	 change the most commonly used print settings to ensure that your 
printout is formatted as required 

•	 print an edDesk article 

•	 print the list of articles returned by non-expandable views 

•	 print the list of articles returned by expandable views 

•	 print a list of some of the articles in expandable views. 

17.2 	 PRINTING EDDESK ARTICLES 

You can print articles from different places in edDesk.  These are: 

•	 when the article is in Edit mode 

•	 when the article is in Preview mode 

•	 when you are in a view, and the required article is selected 
(clicking once on the article will select it without opening it). 

The Print Document dialogue box displays when you print from an article, or from 
a view where you have not selected any articles. 

The Print View dialogue box displays when you print from a view where you have 
selected at least one article. 
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Printing from an open article 
1.	 Press <Ctrl>+p OR select the File menu then Print. 

2.	 The Print Document dialogue box opens. This lets you set the printing 
options. The options you see depend on the type of printer you have. 

Figure 165: Print document dialogue box as displayed from an article 

Print Frames 

This option is only available when printing from a view.  It is greyed out if you 
are printing from an article. 

3.	 Set your printing options as required. 

4.	 Click on <Preview…> to check how your article will look when it is 
printed. A Print Preview opens. Make sure that your article will print as 
you need. 

Click on <Done> to close the Print Preview. The Print Document 
dialogue box displays. 

5.	 Repeat steps 3 and 4 until you are satisfied with the print settings. 

6.	 Click on <OK>. Your article is printed. 
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Printing from a view where you have selected an article 
1.	 Go to the view that lists the required article. 

2.	 Click once on the article you want to print. 

3.	 Press <Ctrl>+p. The Print View dialogue box opens. 

Figure 166: Print View dialogue box with default settings selected 

4.	 Set your printing options as required. 

L see section 17.4: Printing options for more information. 

5.	 Click on <Preview…> to check how your article will look when it is 
printed. A Print Preview opens. Make sure that your article will print as 
you need. 

Click on <Done> to close the Print Preview. The Print Document 
dialogue box displays. 

6.	 Repeat steps 4 and 5 until you are satisfied with the print settings. 

7.	 Click on <OK>. The article is printed. 

Printing several articles from a view 
Expandable views let you select several articles for printing.  Non-expandable views 
only let you select one article at a time. 

Expandable views have a toolbar along the top of the view. 

L see section 4.4ii: Expanding and collapsing your results for more information on 
expandable views. 
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Figure 167: Expandable view.  This type of view lets you select several articles to print. 

Figure 168: Non-expandable view.  This type of view lets you select only one article at a 
time to print. 

1.	 Go to the required view (it must be an expandable view). 

2.	 Click once to the left of each article you want to print.  A tick appears next 
to that article. 
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Figure 169: Selected articles are indicated with a tick. 

3.	 Select the File menu then Print OR press <Ctrl>+p. The Print View 
dialogue box displays. 

4.	 What to Print. Click on Selected documents. 

5.	 Click on <OK> to print, or <Preview…> to see how your articles will 
print. 

17.3 	 PRINTING VIEWS 

Views are often printed and used as summaries of how articles are progressing in 
relation to publishing an issue of a publication. 

Expandable views allow you to print part of the view.  Non-expandable views print 
the entire list of articles returned by the view. 

i 	 Printing non-expandable views 
1.	 Go to the view you want to print. 

2.	 Click once on any article listed in the view.  (This ensures that the Print 
View dialogue box displays when you select Print.) 

3.	 Select the File menu than Print OR press <Ctrl>+p. The Print View 
dialogue box displays. 

4.	 What to print: Click on Selected view. 

5.	 Click on the Page Setup tab. 
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6.	 Orientation: select Landscape. 

7.	 Click <OK> to print. 

ii 	 Printing the entire list of articles in an expandable view 
1.	 Go to the view you want to print. 

2.	 Click on <Expand>. The view expands, to list all articles matching the 
view criteria. 

3.	 Select the File menu than Print OR press <Ctrl>+p. The Print View 
dialogue box displays. 

4.	 What to print: Click on Selected view. 

5.	 Click on the Page Setup tab. 

6.	 Orientation: select Landscape. 

7.	 Click <OK> to print. 

iii 	 Printing part of the list of articles in an expandable view 
1.	 Go to the view you want to print. 

2.	 Click on <Collapse>. The view collapses. 

3.	 Drill down through the categories in the view until you have listed all 
required articles. For example, in the Production Directions view you may 
wish to print only articles for the coming two issues of a publication – 
Volume 2006, Issue 8 and Issue 9.  You would need to drill through each of 
these categories until all relevant articles are listed. 

4.	 Select the File menu than Print OR press <Ctrl>+p. The Print View 
dialogue box displays. 

5.	 What to print: Click on Selected view. 

6.	 Click on the Page Setup tab. 

7.	 Orientation: select Landscape. 

8.	 Click <OK> to print. 
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17.4 	 PRINTING OPTIONS 

Only the most common printing options are discussed in this User Guide.  If you are 
curious about some of the other options then select the options and click on 
<Preview…> to see the results of those settings. 

Most of the settings are in the Printer tab of the Print Document and Print View 
dialogue boxes. 

i 	 Printer tab 
Most of the options in this tab are for when you have selected to print a view, not an 
individual article. 

What to Print / Print Frames 

When you are in a view that has a toolbar your options are in the field What to 
Print. When you are in a view that has NO toolbar your options are in the field 
Print Frames. 

•	 As laid out on screen – your view prints as it is displayed on the 
screen. Screen items such as the navigation pane and tab bar print. 

•	 Each frame individually – NOT GENERALLY USED. Each 
frame of the screen prints on a separate page.  If you select this 
option use <Preview…> to see how your printouts will look before 
you print! 

•	 Selected frame only – Only the frame that your cursor is in will 
print. Usually this is the body of the page (and this is where you 
want it to be!). USEFUL. 

•	 Selected view – Prints the view that you are in.  This option is not 
listed in the Print Document dialogue box. VERY USEFUL. 

•	 Selected documents – Prints the article(s) that you have selected.  
If you select this option the Print View dialogue box displays the 
Documents Style tab that lets you control how the selected 
articles are printed.  This option is not listed in the Print 
Document dialogue box. VERY USEFUL. 

 Print Range 

•	 All pages – select this option to print all pages in an article or view. 

•	 From page… to – if you only want to print some pages, enter the 
numbers in the From page and To fields.  You will probably need 
to go to <Preview…> to determine which pages to print (as they 
are not numbered in the article or in the view).  This option is not 
widely used in edDesk. 

 Print Quality 

•	 Print as draft – prints quickly, but at lower quality. (Good way to 
save printer ink). 

17-7 



 

 
 

 

 

 

 

  

 

 

 

 

 

 

 

ii 

iii 

edDesk (Lotus Notes) User Guide 

•	 Scale all graphics to 100% - Select this option to print your images 
at their original size. If you have imported an image into your 
article, then resized the image your resizing is ignored when this 
option is selected. 

•	 Preview in colour – select this to do a print preview in colour – as 
you see the article or view on screen.  If you do not select this, 
your preview will be in black and white. 

Copies 

• Number of copies – enter the numbers of printouts you want.   

Note 

It is cheaper to use a photocopier than a printer for extra copies. 

•	 Collate – Only relevant if you want more than one copy.  This 
option is selected by default. This option keeps each copy together.  
If you deselect this option, you will get all page 1 together, all page 
2 together so on. 

Page setup tab 
This is mainly used to set your paper size, page margins and page orientation. 

You will probably only use this to change the paper orientation from portrait 
(default) to landscape. This is useful when you are printing a view, so that your 
printout is not truncated. 

Figure 170: View with page set to landscape so that the text is not truncated. 

Figure 171: Same view with page set to portrait.  See that the text is truncated. 

Document styles tab 

This tab only displays when you have chosen Selected documents in the Print 
Frames field of the Printer tab of the Print View dialogue box. 

How To Print Each Document 

•	 Print each document on a new page – prints each article on a 
separate page. 

•	 Print each document as a separate print job – Each article is 
printed separately. This is a good idea if you are printing a lot of 
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articles and are sharing a printer with other people (their jobs can 
go between your printing articles and they don’t have to wait as 
long for their printouts). 

•	 Print each document continuously with a blank line between each 
document – adds a blank line between articles, but does not put 
articles on separate pages. 

•	 Print continuously with no blank lines between documents – the 
only indication that you are printing separate articles is the header 
information that is printed at the top of each article. 

Format Each Document Using 

You will not need to change anything in this field. 

 Page Numbering 

These options are only available if you have selected Print each document on a new 
page in the How To Print Each Document field. 

•	 Reset page number to 1 for each document – each document will 
start with its first page numbered as 1. 

•	 Page range applies to each document – page numbers are 
incremented.  Only the first page of the first article will be 
numbered as page 1. 
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18. Folders 

Folders help you organise your content so that it is highly accessible for you. 

Folders are different to views in that each article in a folder must be placed there 
manually.  Views use a formula to display articles, and the list of articles is 
automatically updated as articles are added to and deleted from your database. 

Folders are a useful tool if you are working on a large project and have several 
articles in progress. Instead of having to locate the articles in a view you can add 
just those articles to your folders. 

Folders can be shared with other people in your organisation, or private, for your 
use only. You can create folders within folders – just like creating new folders in 
MS Windows. 

18.1 OBJECTIVES 

By the end of this chapter you should be able to: 

• create folders to organise your articles 

• create subfolders to organise your articles 

• use folders to access your articles 

• move articles to other folders 

• rename folders 

• remove folders when they are no longer required. 

18.2 CREATING FOLDERS 

1. Go to your Home page. 

2. Look at the navigation pane. There is a Folder item. 

Figure 172: Folder item available in the navigation pane from the Home screen. 

3. Click on the plus next to Folders. The list of folders expands. 

4. Right click on Folders. A popup menu displays. 

5. Click on New Folder… 

6. The Create Folder dialogue box displays listing your current folders. 
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Figure 173: Create Folder dialogue box with current folders listed. 

7.	 Folder name: Type the name for your new folder.  The dialogue box 
displays with “Untitled” as the name for your folder.  Overtype this name 
with the required folder name. 

8.	 Select a location for the new folder: Navigate through your current 
folders until you have selected the one that will be the parent of the new 
folder. That is, select (by clicking once) the folder that your new folder will 
be put in. 

9.	 Click on <OK>. 

10.	 Your new folder is now listed in the navigation pane. 

18.3 	 PUTTING ARTICLES IN YOUR FOLDERS 

After you have created your folders you need to put the required articles into them. 

1.	 Expand the folder list by clicking on the plus signs next to the folder names 
until you have your folder listed. 

2.	 Go to a view and find the article you want to put in your folder. Use any 
view that will list the required article(s). 

3.	 Click once on the required article. 

4.	 Drag the article to your folder. Dragging is done by holding down the left 
mouse button while you move the mouse to your folder.  A “No 
permission” cursor is shown until the article is dragged to a folder where 
you have permission to put the article. 

Figure 174: Article being dragged has "no permission" cursor meaning that it is not 
able to be dropped into its new folder yet. 

18-2 




 
 

 

 

 

 

 

 

 

 

 

 
 

 

 

i 

edDesk (Lotus Notes) User Guide 

5. When the article is at a folder you can use the “No permission” cursor 
changes to a pointer. 

Figure 175: Permission to drop article into folder. 

6.	 Drop your article into the folder. Dropping is done by releasing the left 
mouse button. 

7.	 Repeat steps 2 to 6 for each article you want to put in your folder. 

Quick way of copying several articles to your folder 
1.	 Expand the folder list by clicking on the plus signs next to the folder names 

until you have your folder listed. 

2.	 Go to a view and find the article you want to put in your folder. Use any 
view that will list the required article(s). 

3.	 Click at the far left of an article to be put in your folder.  A tick appears 
next to the article. Do this for each article to be put in your folder. 

Figure 176: Several articles are selected to be put in a folder.  Each selected 
article is marked with a tick. 

4.	 Move your cursor to the title of one of the articles to be put in your folder. 

5.	 Drag the articles to the folder.  As you drag your articles the cursor changes 
to a “no permission” cursor until you are at a folder.  When you can drop 
your articles in a folder the cursor changes to a pointer with article icons. 

Figure 177: Cursor indicating that several articles are being put in a folder. 

6.	 Drop your articles in the required folder. 
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18.4 USING FOLDERS TO LIST ARTICLES 

After you have placed your articles in the required folders you may use those folders 
as a quick way of accessing your articles. Folders are used like Views – the only 
differences are that only the articles that you placed in the folders are listed – you 
don’t have to search through other articles. 

1. Go to your database Home page. 

2. Click on Folders. 

3. Navigate through the folders until you see the required folder listed. 

4. Click on the folder name that contains the articles you want to work with. 

5. The articles are now listed in the body of your page. 

Figure 178: Folder "Frances articles" has been selected and all articles in the 
folder are listed. 

6. Each article has an icon next to the author name. 

•  indicates an article or subarticle 

•  indicated a comment or backgrounder. 

7. You can now select an article to edit, just as you would by using a View. 

18.5 MOVING ARTICLES TO ANOTHER FOLDER 

Only move articles from one of your private folders to another of your private 
folders. 

1. Go to the folder that has the article you want to move. 

2. Click on the article. 

3. Click on <Folder> (in the toolbar above the listed articles). 

4. Select Move to Folder. 

5. The Move to Folder dialogue box displays. 
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Figure 179: Move to Folder dialogue box with folder "another folder" selected. 

6.	 Click on the folder to which you want to move the article. 

7.	 Click on <Move>. 

i 	 Adding an article to another folder 
Sometimes you may want to copy your article to another folder. 

1.	 Repeat steps 1 to 6 above. 

2.	 Click on <Add>. 

3.	 Your article is added (copied) to the other folder. 

18.6 	 RENAMING A FOLDER 

Only rename your own private folders. Ask your system administrator if you want 
any shared folders renamed. 

1.	 Move your mouse to the navigation pane. 

2.	 Right-click on the folder you want to rename.  A popup menu displays. 

3.	 Select Rename Folder… 

4.	 The Rename folder dialogue box displays. 

5.	 Name: type the new name of the folder in the Name field. 

6.	 Click on <OK> to accept the new name, or <Cancel> to keep the old 
name. 

18.7 	 REMOVING A FOLDER WHEN YOU NO LONGER NEED IT 

1.	 Go to your database Home page. 
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2.	 Click on Folders. 

3.	 Navigate through the folders until you see the required folder listed. 

4.	 Right-click on the folder. 

5.	 Select Remove Folder… 

6.	 A message displays “This action may not be undone. Are 
you sure you want to remove the folder
‘(foldername)’ from this database.” 

7.	 Click on <Yes> to remove the folder. 
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19. Team tools 

Team tools are available from the navigation pane in the Home, Creating, 
Editing, Setup and Development tabs. The tools available in each tab are 
relevant to the tab (not all have the same tools). 

Tools are: 

• Inbasket 

• Bulletin board 

• Deadlines 

• Calendar / Team Calendar 

19.1 OBJECTIVES 

By the end of this chapter you should: 

•	 be familiar with the purpose of the Inbasket 

•	 know how to use the Inbasket for items that require follow-up, story leads, 
articles submitted to an inbasket email address 

•	 know how to post items to the Bulletin Board 

•	 be able to delete a posting that you made to the Bulletin Board 

•	 know how to use the Deadlines feature. 

19.2 INBASKET 

The Inbasket is used for work that hasn’t yet been assigned or has recently been 
submitted by authors. 

If authors are submitting their copy to an email address, they often submit to an 
inbasket email address. The address is contained in the email brief that is sent via 
edDesk. This means that editors can go to their Inbasket and then edit the article, 
assigning appropriate sections and subsections and other information. 

The inbasket can also be used for items that need to be followed up, for example, 
potential story ideas. 

Inbasket items are articles, assigned to section Inbasket. 
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Figure 180: Inbasket item that is going to contain an email 

1.	 Create the article as usual. 

2.	 Section: select Inbasket. 

3.	 Subsection: choose from Email or Stories: 

a.	 Email: select this option if you are copying an email into the 
Inbasket. This is often used for new projects, or ideas / leads to 
follow up. 

b.	 Stories: select this option for all other Inbasket articles. 

4.	 Volume / Issue: If you don’t know when you want this Inbasket articles to 
be published or posted, you can select Volume: 1 Number 1. 

5.	 <Save> your Inbasket article. 

i 	 Looking at the Inbasket 
1.	 Select Team tools, from the navigation pane. 

2.	 Select Inbasket. All inbasket items are listed. 

19.3 	 BULLETIN BOARD 

Bulletin board is generally used by people as a “classifieds” and for interesting 
snippets of information. 

Each listing on the bulletin board is known as a “post”.  Posts are categorised when 
you create them: 

•	 Announcement 

•	 Press Release 

•	 Notice 

•	 Reminder 

•	 Comment 
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Posting an item to the bulletin board 
1.	 Click on <New Post>. 

2.	 The Post / New post form displays as below. 

Figure 181: Post / New post form when first displayed. 

3.	 Subject: enter the subject of your post. The subject is displayed on the 
bulletin board listings. Make sure it is meaningful. 

4.	 Type: select the type of item you are posting.  Your choices are: 

5.	 Category: enter keywords for your post. Separate keywords with a 
comma. 

6.	 Enter the text for your bulletin board post in the white text area. 

7.	 Click on <Save> or <Save & Close> when you have created your post. 

Deleting a posting from the Bulletin board 
1.	 Click on the post to be deleted. 

2.	 Press <Delete>. The post is marked with a cross.  Do this for each post to 
be deleted. 
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Figure 182: Posting to be deleted is marked with an "X". 

3.	 Press <Refresh (F9)>. 

4.	 A message displays “Do you want to delete (number of
items) documents from the database
(databasename)?” 

5.	 Click on <Yes> to delete the post(s). 

6.	 Your Bulletin board is updated and the deleted posts are no longer listed. 

Figure 183: Deleted postings no longer listed after Refreshing. 

Displaying bulletin board postings 
You can display items posted to the Bulletin board from the: 

Left navigation pane 

1.	 Select Team tools. 

2.	 Select Bulletin board. The bulletin board is displayed as below. 
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Figure 184: Bulletin board.

 Home tab 

1.	 Select the Home tab. 

2.	 Look at the Announcements area – at the bottom right of the tab. 

Figure 185: Announcements area displaying the most recent bulletin board 
postings. 

3.	 The bulletin board postings are displayed, with the most recent posting at 
the top of the list. 

4.	 New post: select this if you want to add a new post to the bulletin board. 

5.	 View more announcements: select this if you want to view the entire 
bulletin board. 

19.4 	 DEADLINES 

Deadlines lists all deadline dates for articles. The most future deadline is at the top 
of the list. The default is to show an “expanded view” of your deadlines.  This 
means that subarticles are also listed. 

A down triangle next to an article subject means that the article has subarticles and 
they are displayed hierarchically, with each level of the hierarchy being indented 
from its parent. 
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Figure 186: Default Deadlines page.  Note that subarticles are listed. 

Information displayed is: 

•	 Deadline date: date entered at the Brief tab in the Copy 
deadline field. 

•	 Subject: Subject of the article. 

•	 Status: where the article is up to in the workflow. 

•	 Author: name of the author assigned to thearticle. 

•	 Issue/Section: Volume and Issue number for the article and the 
section and subsection in which the article has been created. 

L see section 4.4ii: Display of results for instructions on expanding and collapsing 
the article hierarchy. 

L see Chapter 18: Folders for instructions on using Folders. 

19.5 	 CALENDAR / TEAM CALENDAR 

This feature is currently being developed and is unavailable. 
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20. Non-technical administration of edDesk 

This chapter instructs you in maintaining some of the items in dropdown lists that 
you choose from edDesk menus.  Most of this administration is done using the 
Setup tab. 

This chapter is not for technical administration – rather it is for administration that a 
“super user” can perform. You do not need technical knowledge to do the 
maintenance covered in this chapter. 

20.1 OBJECTIVES 

By the end of this chapter you should have the knowledge and skills to add, delete 
and edit: 

• Section and Subsection information 

• Volume and Issue information 

• Keywords and subtopics 

• Geographical regions and areas within those regions. 

20.2 SETUP TAB 

Most of the non-technical administration of edDesk is done through the Setup tab. 
The body of the Setup tab is broken into two parts – Create new items and Setup 
tools. 

Important 

Before creating new items go to the relevant Setup tools and see if the items 
already exist. 

If items already exist you may just need to update them – but be careful.  Your 
updates will update every article that uses that item. 

The Setup tab lets you create and maintain: 

• sections 

• subsections 

• issue definitions 

• keyword topics 

• geographical regions 
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20.3 	 SECTIONS 

Use this to view, edit and create top-level section structure.  Use this view instead of 
Create new section because Sections lists all current sections instead of going 
straight to the new section entry form.  This means that you are less likely to create 
duplicate sections! 

Section information is mandatory and is entered when an article is created. 

Figure 187: Sections listed alphabetically 

Information displayed is: 

•	 Section name – sections are listed alphabetically. 

•	 Order – this is used when you are maintaining subsections. 
Sections are listed in the order given in the sections view.  If 
sections have the same order they will be listed alphabetically. 

•	 Description - description of section and type of content that would 
be assigned to this section. 

•	 Active – whether the section is available for selection in new 
articles. 

•	 Web – whether the section is available in online menus. 

Creating sections 
1.	 Go to the Setup tab. 

2.	 Select Sections. 
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3. Click on <Add Section>. The Section definition form displays. 

Figure 188: Section definition form 

4.	 Title of the section: enter the title that you want to display when people 
assign articles to a section. Sections are listed alphabetically by title in the 
Sections view. 

5.	 Order in the publication: enter a number.  The default is 10.  Sections are 
listed by this order in the Subsections view. Order determines the order in 
which sections are listed when you are assigning them in an article and in 
various views (especially the Easy content selector). 

6.	 Description of section: enter a description that indicates the type of 
articles that should have this section applied.  For example, the section Dev 
has a description of “Development tools and resources”. 

7.	 Section Editors: Name of the people who edit articles that are given this 
section. 

8.	 Show in online menus?: Select Yes if you want the section available in the 
web version of edDesk. 

9.	 Is Section available for new articles?: Select Yes if you want to make this 
available for new articles.  This gives the Section an Active status. 

10.	 Click on <Save & Close>. 

11.	 Your section is added to the Sections view. 

Editing sections 
1.	 Go to the Setup tab. 

2.	 Select Sections. 

3.	 Double-click on the section name.  The Section definition form opens. 
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4.	 Make your changes. 

5.	 Click on <Save & Close>. 

20.4 	 SUBSECTIONS 

Use Subsections to view, edit and create subsections.  The subsections are grouped 
by section. You must use Sections to maintain information about top-level sections. 

Subsection information is mandatory and is entered when an article is created. 

Figure 189: Subsections grouped by Section and listed by Order 

Information displayed is: 

•	 Section – the section that this subsection has been created in. 

•	 Subsection – name of the subsection. 

•	 Description – description of subsection and type of content that 
would have this subsection assigned. 

•	 Order – the order by which you want the subsections to be listed 
when creating / editing an article. 

•	 Active – whether the section is available for selection in new 
articles. 

•	 Web – whether the section is available in online menus. 
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Creating subsections 
1.	 Go to the Setup tab. 

2.	 Click on Subsections. 

3.	 Click on <Add Subsection>. The Subsection definition form displays. 

Figure 190: Subsection definition form 

4.	 Section to be added to: Select the section that you want this subsection to 
be in. 

5.	 Title of the subsection: Enter subsection title.  This is what people see 
when they assign an article to a subsection. 

6.	 Order of the subsection within the section: Enter the order that you 
want to list this subsection. The default is 10.  Order determines the order 
in which subsections are listed when you are assigning them in an article 
and in various views (especially the Easy content selector). 

7.	 Short description: Enter a description that indicates the type of articles 
that should be assigned to this subsection. For example, the subsection 
Leads (in section Sales) has a description of “Sales leads and ideas”. 

8.	 Show in online menus?: Select Yes if you want the subsection available in 
the web version of edDesk. 

9.	 Is subsection available for new articles?: Select Yes if you want to make 
this available for new articles. This gives the subsection an Active status. 

10.	 Click on <Save & Close>. 

11.	 Your subsection is added to the Subsections view. 
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ii 	 Editing subsections 
1.	 Go to the Setup tab. 

2.	 Select Subsections. 

3.	 Double-click on the subsection name. 

4.	 The Subsection definition form opens.  Make your changes. 

5.	 Click on <Save & Close>. 

20.5 	 PRODUCTION SCHEDULE – VOLUME AND ISSUE DEFINITIONS 

Production schedule lets you view, edit and create new issue definitions.  Issue 
definitions contain information about Issues and Volumes, including all relevant 
dates for production of the publication. 

Issue and Volume are mandatory fields when creating articles. 

Figure 191: Production schedule 

Information displayed is: 

•	 Serial – number used to order the Production schedules. The 
oldest issues will have the smallest serial number. 

•	 IssueCheck – Year: Month number. 

•	 Volume – Year of the volume. 

•	 Number – issue number. 

•	 Cover – cover date. 

•	 Onsale – date the issue goes on sale. 

•	 Copy – date by which copy must be received to adhere to the 
Production schedule. If copy is not received by this date it is 
shown in the Late running copy view (in the Editing tab). 
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Creating issue definitions 
1.	 Go to the Setup tab. 

2.	 Select Production schedule. 

3.	 Click on the issue at the bottom of the schedules. 

Handy hint 

Some information is pre-filled when you click on <New issue definition>. 

If you click once on the issue at the bottom of the list before you click 
<New issue definition> the pre-filled information is for the previous issue – it’s 
easy to then just increment numbers. 

4. Click on <New issue definition>. The Issue definition form displays. 

Figure 192: Issue definition form with some fields pre-filled with information from 
the previous Issue. 

5.	 Issue Serial Number: Add one to the number already in the field.  For 
example if the field is pre-filled with 26 then the number for the issue 
definition you are creating will be 27. 

6.	 Volume: Volume is usually the year of the publication. 

7.	 Number: Issue number within the volume.  A monthly publication would 
have the number equating to the month.  For example, Volume 2005, 
Number 9 would be September 2005. 

8.	 Cover date: Date to appear on the current issue’s cover. 

9.	 Onsale date: Date the issue is first on sale. 

10.	 Copy deadline: Date by which all copy must be received in order to meet 
the publishing schedule. 
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11.	 Cover line: This is optional. A very short (two or three words) version of 
the main cover line. 

12.	 Issue description: This is optional. One paragraph summary of the main 
story for this issue. 

13.	 Cover image: This is optional.  Use the File menu then select Attach to 
attach a 80 pixel, 60% quality JPEG of the cover image.  Name any cover 
images in the format publicationtitle_cov_ddmmyy.jpg 

14.	 Click on <Save & Close>. 

15.	 Your new Issue definition is added to the list of production schedules. 

ii 	 Editing issue definitions 
1.	 Go to the Setup tab. 

2.	 Select Production schedule. 

3.	 Double click on the issue definition you need to edit.  The Issue definition 
form opens. 

4.	 Click on <Edit>. 

5.	 Make the required changes. 

6.	 Click on <Save & Close>. 

20.6 	 KEYWORD TOPICS 

Keywords are used to classify articles.  Keywords are used by indexes and search 
engines and when the appropriate words are selected the articles are easier and faster 
to find. Keywords are divided into keyword topics and subtopics.  L see 
section 11.3i.: Keyword Topics for more information on using Keywords in articles. 

Figure 193: Keyword topics and subtopics. 

Information displayed is: 

•	 Topics – the major keyword topics 
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•	 Subtopics – subtopics within each topic.  Subtopics are listed in 
the order in which they were created in the topic. 

Creating keyword topics and subtopics 
1.	 Go to the Setup tab. 

2.	 Select Keyword topics. 

3.	 Click on <New Topic>. The Keyword topic definition form displays. 

Figure 194: Keyword topic definition form 

4.	 Title of the keyword topic: Enter the title of your keyword topic. Make 
sure that it is meaningful and describes the type of subtopics that you will 
create in this topic. 

5.	 Included keyword sub topics: Enter the keyword subtopics. Separate 
each subtopic with a comma.  Type the subtopics in the case want them to 
appear in when people are classifying their articles. 

6.	 Click on <Save & Close>. 

7.	 Your keyword topic and subtopics are added to the list of keyword 
definitions and are now available to be used in articles and in views. 

Editing keyword topics and subtopics 
1.	 Go to the Setup tab. 

2.	 Select Keyword topics. 

3.	 Click on the topic you want to edit. 

4.	 Do one of the following: 

a. Click on <Edit>. The Keyword topic definition form opens. 

b. Double click on the topic. 	The Keyword topic definition form opens.  
Click on <Edit>. 

5.	 Make your changes as required. 

6.	 Click on <Save & Close>. 
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20.7 	 GEOGRAPHY 

Geography is used when classifying articles to indicate which regions the article is 
relevant, or in which regions it will be published.  L see section 11.3ii: Geography 
for more information. 

Figure 195: Sample Geograpical regions. 

Information displayed is: 

•	 Regions – The main region.  This could be an entire country, or a 
locale. 

•	 Subregions – parts of the region. This could be states of a county, 
areas of a city or particular towns/suburbs in a locale. 

Creating Regions 
1.	 Go to the Setup tab. 

2.	 Select Geography. 

3.	 Click on <New Region>. The Geographic region definition form 
displays. 

Figure 196: Geographic region definition form 

4.	 Name of the region: enter the name of the region. The name is listed in 
the article Classification tab. 

5.	 Included locales within this region: Enter the locales for this region. 
Separate each locale with a comma or type it on a new line.  Locales will 
display as “subregions”. 
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6.	 Click on <Save & Close>. 

7.	 Your regions are now available to be used in articles and in views and 
searches. 

ii 	 Editing regions 
1.	 Go to the Setup tab. 

2.	 Select Geography. 

3.	 Click once on the region you want to edit. 

4.	 Do one of the following: 

a.	 Click on <Edit>. The Geographic region definition form opens. 

b.	 Double click on the topic. The Geographic region definition form 
opens. Click on <Edit>. 

5.	 Make the required changes. 

6.	 Click on <Save & Close>. 

20.8 	 PUBLICATION TITLES 

Publication titles 

Figure 197: Title definition page. 

Information displayed is: 

•	 Key – number assigned by edDesk.  Each title definition has its 
own unique number, indicating the order in which the title 
definitions were created. 

•	 Name – title of the publication. 

•	 Directory – production directory in which files to be used with 
this publication should be stored. 

•	 Root – 

Creating title definitions 
1.	 Go to the Setup tab. 

2.	 Select View existing title definition. 

3.	 Click on <New Title Definition>. The Publication title definition form 
displays. 
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Figure 198: Publication title definition form 

4.	 Title of the publication: enter the publication title here. 

5.	 Production directory: enter the directory in which all files to be used in 
this publication will be stored.  This includes standard images used across 
the publication. 

6.	 Production root title: Leave this blank if you do not know. 

7.	 Default site interface: The default is edDesk Simple Site. Select your 
publication’s interface from the menu if you do not want to use the default. 

8.	 Default template: select your default export template.  This will ensure 
than formatting used in your publication is applied to articles in this 
publication. 

9.	 Click on <Save & Close>. 

Editing title definitions 

1.	 Go to the Setup tab. 

2.	 Select View existing title definitions. 

3.	 Double click on the definition you want to edit.  The Publication title 
definition form opens with the information for your selected publication. 

4.	 Select <Edit>. Make the required changes and <Save & Close>. 
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Appendix A: Creating simple Views 

A view is a list of articles in a database.  Views let you sort, categorise and select 
articles. They display information about the articles. 

Views can be created by any person with the access to read articles in a database.  
The person creating a view specifies the view criteria so that only articles fulfilling 
particular criteria will be listed in that view. 

Views are similar to folders, except that views are automatically updated as articles 
are added to and deleted from your database. 

L see chapter 4: Views for information and instructions about using edDesk’s 
standard views. 

OBJECTIVES 

By the end of this chapter you should be able to: 

• create simple views 

• use your views to list articles fitting the view criteria 

• go to required views 

• edit your views 

• rename views 

• delete views (that you created) when they are no longer needed. 

CREATING A SIMPLE VIEW 

The easiest way to create a view is to base it on a view that is already in your 
database, and then just adjust the conditions and information that you want to 
display. This gives your view a better chance of working, and can avoid a lot of 
frustration! When you have more experience, you can create a view “from scratch”. 

1. Go to the Home tab. 

2. Select the Create menu. 

3. Select View…. The Create View dialogue box displays. 
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Figure 199: Create view dialogue box with default information displayed 

4.	 View name: enter a name for your view. 

5.	 View type: Your choices are: 

•	 Shared - this is the default. Shared allows anyone with access to 
the database to use this view. 

•	 Shared, contains documents not in any folders – DON’T WORRY 
ABOUT THIS ONE 

•	 Shared, contains deleted documents – Lets you see a list of deleted 
articles. Useful if you have accidentally deleted some articles, 
because it helps you retrieve them. 

•	 Shared, private on first use – DON’T WORRY ABOUT THIS 
ONE. 

•	 Shared, desktop private on first use – DON’T WORRY ABOUT 
THIS ONE. 

•	 Private – can only be used by the person who created it, and the 
database administrators. 

6.	 Select a location for the view. If your View Type is Private you can only 
put your new view into your list of private views. 

7.	 Copy style from view: The default is All documents. This means that your 
new view will inherit the columns of information that display in the All 
documents view. This is a good thing to do when you are creating your first 
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view (as the All documents view works properly!)  You can add your own 
criteria for articles to be listed in your view. 

L see section for more information on creating views from scratch. 

8.	 Selection conditions: If you have left the Copy style from view as All 
documents, this field displays a lot of criteria for articles to be listed in the 
All documents view.  Don’t do anything to this field. 

9.	 Select by formula. Uncheck this!  Then the Create view dialogue box 
changes slightly to let you add conditions for your view. 

Figure 200: Create View dialogue box with “Select by formula” unchecked.  Now 
you can Add Conditions for your view. 

10.	 Click on <Add Condition…>. The Add Condition dialogue box displays. 
Remember that only articles that match the conditions you enter here will 
be displayed by your view. 

L see section 5.6i: Conditions for more information on adding conditions. 

11.	 Add the required conditions. 

12.	 Click on <OK>. The view is saved. 

GOING TO YOUR VIEW 

When you created your view, you selected a location for it.  To use your views you 
must “go to” them.  Private views can only be saved in your list of private views. 

The easiest way to go to one of your views is to display a standard edDesk view.  
When you are in a view you can then tell edDesk to go to your view. 
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1.	 Display any view (a simple one is All Issues, as there will be articles 
listed). 

2.	 Click once on any article in the view (you don’t have to do this if you are 
using the All Issues view). 

3.	 Select the View menu. 

4.	 Select Go To… 

5.	 The Go To dialogue box opens, listing all views. 

Figure 201: Go To dialogue box.  Your private views are at the bottom of this list. 

6.	 Your private views are at the end of the list.  Scroll down to the required 
view. 

7.	 Click on the view you want to go to. 

8.	 Click <OK>. 

9.	 Your view is displayed. 

CUSTOMISING A VIEW 

Customising is a simple way of letting you change which columns display, the order 
in which columns are displayed and whether they are sorted.  Customising does 
NOT let you edit the view conditions. 

1.	 Go to the view to be customised. 

L see Going to your view for instructions. 

2.	 Select the View menu. 

3.	 Select Customize This View…. The Customize View dialogue box 
displays. 
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Figure 202: Customize View dialogue box 

Columns to Display 

Columns are listed with the leftmost column at the top.  The first column is selected 
(highlighted in blue). 

Information displayed here is: 

•	 Visible: All of your columns are checked by default. If you click 
on the checkbox (and the tick is removed) your column will not 
display in the view. 

•	 Name: This is the name of the column.  This can only be changed 
in the Design View window. L see Designing views for more 
information. 

•	 Sort: Indicates whether the column is sorted. 

•	 Width: Width of the column as it is displayed. 

•	 Resizable: If this is Yes you can change the width of the column. 

•	 Selected Column: This lets you change the sort method and width 
of the selected column. 

o	 Sort: Choose from None, Ascending and Descending. 
Ascending will sort in increasing order – the most recent 
articles are at the bottom of the view.  Descending will 
sort in decreasing order – the most recent articles are at 
the top of the view. 

o	 Width: you can change the width of the selected column, 
wherever they are shown as Resizable. 
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1.	 Make sure that any column you want to display has a tick in the Visible 
checkbox. 

2.	 Use the <Move Down Ø> and <Move Up ×> buttons to reorder the 
columns from left to right.  <Move Down Ø> moves your column to the 
right, <Move Up ×> moves it to the left. 

 Entire View 

Information you can change here is: 

•	 Row spacing: You can set the vertical spacing between each row 
in the view. The default of 1¼ is usually the easiest to look at 
without having too much space between rows. 

•	 Lines per row. This is the maximum number of text lines per row 
in the view. If you have articles with lengthy subjects you may 
want to increase this so that the subject is not truncated by the view 
display. 

•	 Shrink rows to content: Tick this to make sure that shorter text 
lines do not take up the maximum lines per row (and leave too 
much gap between rows of articles returned by your view). 

1.	 Make the required changes. 

2.	 Click <OK> to save the customised view. 

3.	 Your view is displayed, showing the customisations you have made. 

DESIGNING VIEWS 

Creating a simple view covered creating a simple view, based on the All Documents 
view. 

This section tells you how to design (and redesign) your view so that you can give 
your columns a different name, make them appear in a different order and change 
some other display aspects of your view.  Designing allows you to make more 
changes to your view than Customisation does. 

This section does not cover advanced aspects of designing views.  Please see the 
Lotus Help for more information on how to perform more advanced customisations. 

Programming not covered 

This User Guide does NOT cover programming your view.  It does cover editing the 
conditions you set when creating the view and changing some simple display 
elements of your view.  See your System Administrator if you need a more complex 
view that involves programming. 

1.	 Go to the view that you want to alter. 

L see Going to your view for instructions. 

2.	 Select the Actions menu. 

3.	 Select View Options. 

4.	 Select Design… 
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5. The Design View pane opens. This contains some technical information, 
which you don’t need to know about! 

Figure 203: Design view pane, showing the information when your view is based 
on the "All Documents" view 

The top half of the Design View pane contains is the View Preview. If you 
want to see a list of the articles returned by your view, click on 
<Refresh (F9)> or the  at the left of the column headings. 

The bottom half of the Design View pane is where you make your changes 
to the view.  It is split into two parts – the left column contains elements of 
your view (this is technical and is not covered in this User Guide).  The 
right column contains the programming details which make the elements in 
the left column work properly (this is also not included in this User Guide). 

Instructions for making simple changes to a view are below. 

Modifying selection conditions 
Selection conditions determine which articles are listed by your view. 

1. Click on the Selection Conditions icon -
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2. The current selection conditions are displayed in the bottom right pane of 
the Design pane. 

Figure 204: Selection conditions for the view "Frances' old stuff".  The only 
condition is that an article field called ArticleAuthor must contain the name 
Frances. 

3. If you want to add a new condition, click on <Add Condition…>. 

L see section 5.6i: Conditions for information on adding conditions. 

4. If you want to edit a condition: 

a. Click on the condition to be edited. 

b. Click on <Edit Condition…>. Make the required changes 

c. Click <Add>. Your changes are saved. 

If you do some non-technical administration as well as create articles… 

and you want your view to only list articles where you are an author, not everything 
that you have created then make sure that your selection condition has the 
following: 

Condition: By field 
Field: ArticleAuthor  contains 
Value: (your name, as it is entered in edDesk) 

View properties 
View properties control the appearance of the entire view.  This includes colours 
used, text fonts and the view name. 

The View properties dialogue box must be displayed before you can change view 
properties. 
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Figure 205: View properties dialogue box 

If the View properties dialogue box is not displayed click on the Database 
.properties icon 

Renaming a view 

1.	 Click on the View info tab (the left tab in the View properties dialogue 
box). 

2.	 Name: enter the new name for the view. 

 Style attributes 

Style can make your view easier to use. Style lets you change the layout of the 
view. Some of the style options can also be changed in the Customize View 
dialogue box. Changes you make in this tab are shown straight away in the top of 
the Design View pane. 

Note 

Not every option is discussed here.  You can experiment with the style options and 
see the results immediately and without affecting which articles are listed. 

1. Click on the Style tab (second from the right in the View properties 
dialogue box). The Style tab opens. 
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Figure 206: Styles tab 

2.	 Body: used to select colours for the view. 

•	 Row: select a colour for the background of the view 

•	 Alternate rows: select a different colour for alternate rows to have 
a different background colour. This makes your view easier to 
read. 

3.	 Grid: sets a style for gridlines in the view.  Grid displays according to the 
settings in the Header option. Be careful with the Grid option as it can 
make your view harder to read. 

•	 Style: select a style. The default is none. 

4.	 Header: Shows a bar at the top of the view, with column titles in different 
looks. Your settings here affect how the Grid displays. 

•	 Style: select a style. 

•	 Height: specifies how many lines the header will take up.  If you 
have long column titles you may want more than one line for the 
header. 
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5.	 Rows: specifies how many lines a column can contain and the spacing 
between each row.  Articles that use more than this will have information 
truncated. You can also make these settings in the Customize View 
dialogue box. 

6.	 Other: 

•	 Show selection margin – displays a margin to the left of articles in 
the view. Selected articles are indicated with a tick.  This makes it 
easy see when you are selecting multiple articles. 

Figure 207: Document selection margin with some selected articles 

•	 Hide selection margin border – if the selection margin is visible, 
this will remove the border between the margin and the article 
information. 

•	 Extend last column to window width - select this to make your 
view easier to read. 

7.	 Margin: Lets you select the amount of whitespace around the view 
contents. 

Column properties 
Columns contain information about each listed article.  Column properties let you 
rename the column, change the display of column headings and contents, and sorting 
of articles within the column. 

Display the Column properties dialogue box. If the Column properties dialogue 
box is not displayed click on the Database properties icon . If the View 
properties is displayed, click on the dropdown list in the top left of the dialogue box 
and select Column. 
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Figure 208: Changing the properties dialogue box from View 

Renaming a column 

1.	 Move your mouse to the View Preview pane. Click on the column header 
that you want to rename. 

Note 

If you click on the column contents the Column properties dialogue box 
changes to the View properties dialogue box.  Click on the column header 
to redisplay the Column properties. 

2.	 Title: enter the new name for the column. 

Changing the display of column headings 

1.	 Click on the Title tab 

2.	 Select your title attributes. 

3.	 If you want to have the same title styles for each column click on 
<Apply to All>. 

Changing the display of column contents 

1.	 Click on the Font tab 

2.	 Select the font attributes. 

3.	 If you want to have the same style for each column click on <Apply to All>. 

Sorting column contents 

Sorting columns lets you organise the view display so that it is easier read.  For 
example, if you have created a view that lists all of your articles by date, you might 
want to sort the dates so that the oldest article is at the top or bottom of the view. 

1.	 Click on the Sort tab . The Column Sort dialogue box displays. 

. 

. 
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Figure 209: Column Sort dialogue box 

2. Change your sort options as required. 

• Sort: 

o	 Ascending - sorts in increasing order. That is numerical 
starting at the lowest number, then alphabetical, earlier dates 
before later dates. 

o	 Descending – sorts in decreasing order.  That is, largest number 
down to smallest number, reverse alphabetical (Z-A), later 
dates before earlier dates. 

• Type: 

o	 Standard – Repetitive information in a column is listed 
separately for each instance of that information.  For example, if 
you are sorting the author column and there are several 
articles by the same author, the author name is repeated for 
each of their listed articles. 

o	 Categorized - groups same information in a column together.  
This is useful to get a list of articles by particular authors so 
that the author name is not repeated next to each listed article.  
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Figure 210: Author column is sorted with Type: Standard.  Red colour just means 
that the article has not been read by the view creator. 

Figure 211: Author column is sorted with Type: Categorized.  Red colour just 
means that the article has not been read by the view creator. 

•	 Case sensitive sorting – sorts lowercase before uppercase. 

•	 Accent sensitive sorting – sorts accented characters after non-
accented characters. 

•	 Categorized is flat version 5 or greater – don’t worry about this! 

•	 Click on column header to sort – Tick this option so that when you 
are using the view if you click on the column header you will 
change the sort order. This is useful! 

•	 Secondary sort column – Lets you have multiple levels of sorting.  
For example, if your first column sorts by author, you might like a 
second column sorting by date, so that all the author’s articles are 
listed in date order. 
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Saving a view after you have designed it 
There are a few ways of saving your view from the Design pane.  Do one of the 
following: 

1.	 Press <Ctrl> + s; OR 

2.	 Select the File menu then select Save; OR 

3.	 Click on the close icon (the cross at the top right of the View tab name).  
You are prompted “Do you want to save your changes?” 
Click on <Yes>. 

RENAMING A VIEW 

Make sure your view names indicate the type of information displayed by that view.  
If you have modified your view since creating it, you may need to change its name. 

1.	 Go to the view to be renamed. 

L see Going to your view for instructions. 

2.	 Select the Actions menu. 

3.	 Select View Options. 

4.	 Select Rename… 

5.	 The Rename dialogue box displays. 

Figure 212: Rename dialogue box with old name highlighted 

6.	 Type the new name for your view. 

7.	 Click <OK>. Your view is renamed. 

DELETING A VIEW 

1.	 Go to the view to be deleted. 

L see Going to your view for instructions. 

2.	 Select the Actions menu. 

3.	 Select View Options. 

4.	 Select Remove View. 

5.	 You are prompted This action may not be undone. Are 
you sure you want to delete the view (your view
name) from this database? 

6.	 If you really want to delete the view click <OK>. 
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Appendix B: Creating simple Agents 

Agents are simple programs that let you perform repetitious tasks quickly and 
simply.  You can use agents to automate almost any task that you can perform 
manually in a database.  You can also use search options to select only articles 
matching your criteria and then create agents to perform tasks with those matching 
articles. 
For example, you might want staff to receive an email each week that lists all active 
articles that have not been modified in the past year.  You might also want a daily 
update of articles that have been created or modified in the past day. 

Agents can be: 

•	 private - used only by you; or 

•	 shared - able to be used by other people who use your database. 

No technical knowledge? No problem! 

You do NOT need any programming or technical knowledge to create simple 
agents and you may create as many agents as you like. 

OBJECTIVES 

By the end of this chapter you should be able to: 

•	 create simple agents 

•	 create an agent using a worked example 

•	 test your agent 

•	 use your agents 

•	 view at a list of your agents 

•	 edit an agent 

•	 delete agents (that you created) that you no longer need. 

WHERE TO GO FOR MORE HELP, OR FOR AGENTS REQUIRING PROGRAMMING 
SKILLS 

Complex agents and agents requiring programming skills are outside the scope of 
this User Guide. If you need to use complex agents consider the following two 
options: 

•	 see your system administrator – they may be able to write the 
agent for you. Remember, you must know what you want the 
agent to do (you don’t need to know how to do it though).  Your 
system administrator may also be able to refer you to useful 
reference materials. 

•	 refer to the Lotus Notes online help – Context Sensitive Help is 
represented by a question mark in the right top corner of dialogue 
boxes. Click on the question mark to see help about the feature 
you are currently at. If you do not have a dialogue box open press 
<F1>. 
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CREATING AGENTS 

Important 

This section does NOT cover each option available when you create agents.  Only 
very simple agents, requiring no programming knowledge are discussed.  If you 
need to use more complex agents see your system administrator. 

1.	 Open the database in which you want to create the agent. 

2.	 Go to the Create menu. 

3.	 Select Agent… 

4.	 The Agent properties dialogue box and the Programmer’s pane display. 

Note 

You must select criteria from BOTH the Agent properties dialogue box and the 
Programmer’s pane to create a working Agent. 

The Agent properties dialogue box contains the name, description and details the 
conditions the agent will run under – when and the how the agent will do 
something.  The Programmer’s pane contains the actions – what the agent will do. 

Figure 213: New agent showing Agent properties dialogue box (in foreground) and 
Programmer's pane (in background). 

Agent properties dialogue box 

1.	 Name: Enter a name for your agent. 

2.	 Comment: Enter a description of the agent.  The comment appears in a list 
of agents. 
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3.	 Options: You may notice that some of the options are greyed out 
(unavailable). The availability of options depends on your level of access 
to the database in which you are creating the agent. 

•	 Shared / Private – If you want to share this agent with other people 
who use your database click on the Shared option. If you are the 
only person who will run this agent click on Private. 

•	 Store search in search bar menu – if your agent is going to search 
for text in articles you can display your search criteria in the 
Search bar. 

•	 Store highlights in document – if your agent is going to search for 
text in articles you can highlight the matching text in the articles. 

•	 Run in background client thread – if you select this option your 
agents will not be seen by a user.  However if you are using agents 
to email people this is OK!  Don’t worry too much about this 
option. 

1.	 Runtime: You need to select a “trigger” for your agent.  Triggers cause the 
agent to be run. You can select either: 

•	 On event – select a particular event, from the dropdown list under 
the trigger field, which will trigger the agent.  L see below, 
Runtime trigger: On event for more detail about the On event 
options. 

•	 On schedule – schedule the time, day or frequency that the agent 
will run. L see below, Runtime trigger: On schedule for more 
detail about the On schedule options. 

Runtime trigger: On event 

1.	 You now need to select the event that will run your agent.  The following 
options are available: 

•	 Action menu selection: The agent will be listed as an option in the 
Action menu.  When you want to run the agent you need to go to 
the Action menu and select the agent.  This is useful if you want to 
run the agent at varying intervals. 
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Figure 214: Action menu selection - the agent using this trigger is 
"Frances' agent". 

•	 Agent list selection: For agents that are “called” by other agents – 
that is, other agents use this agent.  DON’T WORRY ABOUT 
THIS ONE. 

•	 Before new mail arrives: Works on every item of mail before it is 
received in your mailbox.  Can be used to move incoming mail to a 
folder. Use this option with care. 

•	 After new mail has arrived: Works on newly received mail.  
Particularly useful if you have just sent out many emails and 
people are responding to them – for example a client survey.  You 
can use this option to send automated replies. 

•	 After documents are created or modified: DON’T WORRY 
ABOUT THIS ONE. May be used for workflow tasks, but the 
edDesk article workflow tab replaces the need for this option. 

•	 When documents are pasted: DON’T WORRY ABOUT THIS 
ONE. Used for articles that must be modified when they are 
pasted into a database. 

2.	 Target: select the articles on which the agent will be run.  Your options in 
the Target field vary depending on the Runtime trigger you selected. For 
example, the event runtime triggers “Before new mail arrives” and “After 
new mail has arrived” only act on mail items – not on articles. All available 
options are listed below. 

•	 All documents in database 

•	 All new and modified documents 

•	 All unread documents in view:  You select article search criteria 
and your agent only acts on articles matching those criteria. 

Appendix B - 4 



 
 

 

 

 

 

 

 

 

 

 

 

 

 

 
  

 
 

 

 

edDesk (Lotus Notes) User Guide 

•	 All documents in view: You select article search criteria and your 
agent only acts on articles matching those criteria. 

•	 All selected documents. 

•	 None. 

3.	 Click on the close icon (top right of the dialogue box) when you have 
entered your agent properties. 

4.	 The Programmer’s pane is displayed. 

Runtime trigger: On schedule 

1.	 If you have selected On schedule as your runtime trigger you must select 
the frequency of the agent’s running. 

•	 More than once a day: Only used for very high priority items.  If 
you schedule very frequent runs you could slow your server! 

•	 Daily: For important items that you only need to know about once 
a day. itechne uses this for sending out a list of articles that have 
been modified or added in the day. 

•	 Weekly: For routine tasks, particularly useful for summary reports 
so you can see what has happened during the week. 

•	 Monthly: For low priority tasks. For example, archiving articles, 
distributing monthly newsletters. 

•	 Never: DON’T WORRY ABOUT THIS ONE. 

2.	 Click on <Schedule…>. The Agent Schedule dialogue box displays. 

Figure 215: Agent Schedule dialogue box, where you enter the schedule by which 
to to run your Agent. 

3.	 Use the Agent schedule dialogue box to specify the schedule by which 
your agent is run. Remember that agents do take up system memory, and 
complex agents, or agents running on many articles, will slow your 
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database down when they run. Specify a sensible schedule that has 
minimum impact on other users. 

•	 Run Agent Once Every Day: Select the time your agent is to run.  
It will run at the same time each day (until you change the time). 
Start running agent at: If your agent is system intensive (takes a 
lot of memory, or will have to search through a lot of articles) 
select a time when you know that there are fewer people using 
your database. 

•	 Restrict Dates When Agent Runs: These options are used to 
restrict the dates the agent runs.  If you only want to use an agent 
for a particular period or not on the weekends you need to select 
your criteria here. 

Start running agent on this date. If you want to start running your 
agent on a particular date click on the checkbox then enter the first 
date you want the agent to run. If you are not sure of the date 
format click on the calendar icon next to the date.  A calendar is 
displayed. Select the required date. 

Stop running agent on this date. If you want to stop running your 
agent on a particular date click on the checkbox then enter the last 
date you want the agent to run. If you are not sure of the date 
format click on the calendar icon next to the date.  A calendar is 
displayed. Select the required date. 

Don’t run agent on weekends. If you don’t want your agent to run 
on weekends, check this option. 

•	 Where the Agent Runs: Only change this option if you know 
which servers your database uses.  Most people will leave this 
option at -Any Server-. 

4.	 Click on <OK> when you have set your Agent Schedule. 

5.	 Target: select the articles on which the agent will be run.  On schedule has 
only two options: 

•	 All documents in database 

•	 All new and modified documents 

6.	 Click on the close icon (top right of the dialogue box) when you have 
entered your agent properties. 

7.	 The Programmer’s pane is displayed. 

Programmer’s pane 
The Programmer’s pane is where you select the actions done by the agent.  That is, 
what the agent does. You can also specify which articles are to be selected. 

The Programmer’s pane is divided into two panes – the left pane is the Objects 
tab. There are two available option s - Document Selection and Action. Document 
Selection is not always used, but it is where you can specify that the agent run on 
only a particular set of articles.  Use Document Selection if the Agent properties 
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dialogue box did not allow sufficiently refined article selection criteria.  Action is 
always used and is the selected option when you first enter the Programmer’s pane. 

 Action object 

1.	 Click on <Add Action…>. 

2.	 The Add Action dialogue box displays. 

Figure 216: Add Action dialogue box on entry, showing default action of "Modify 
Field". 

3.	 Action: The default action is Modify Field. Click on the dropdown list to 
see a list of available actions. Look at the bottom of the dialogue box - 
outlined in blue is a description of what the selected action does. 
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The options for the actions change as you select different actions.  Compare 
Figure 216, above, with the Add Action dialogue box below (after a 
different action has been selected). 

Figure 217: Add Action dialogue box with a the Action “Move to Folder” selected.  
This action moves articles specified in the Agent properties dialogue box to the 
selected folder. 

4.	 Select the required action and the parameters that your selected action needs 
to be completed.  (In Figure 217, above, the parameter is to select the folder 
to which you want to move your articles). 

Some Actions have no parameters. 

If there are no parameters for an action the blue action description box will 
contain “This action does not require any parameters.”  There will be 
nothing for you to select other than the action itself. 

5. Click on <Add>. Your action is added to the agent and appears in the 
Programmer’s pane. 

Figure 218: Action “”Move to Folder” now added to programmer's pane. 
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6. If you want to add more actions for your agent to perform repeat steps 3 to 
5. Actions must be added in the order that you want them to be run. 

Document Selection object 

1.	 Click on Document Selection in the Objects tab. 

2.	 The Programmer’s pane displays as below: 

Figure 219: Document Selection object selected in the Programmer's pane. 

3.	 Click on <Add Condition…>. The Add Condition dialogue box displays. 
L see section 5.6i: Conditions for details on specifying the most commonly 
selected conditions. 

SAVING YOUR AGENT 

Do one of the following: 

4.	 Press <Ctrl> + s; OR 

5.	 Select the File menu then select Save; OR 

6.	 Click on the close icon (the cross at the top right of the Agent tab name).  
You are prompted “Do you want to save your changes?” 
Click on <Yes>. 

TESTING YOUR AGENT 

It is important to test your agent to make sure that it runs correctly. 

If your agent is going to manipulate articles, or email you a list of new or modified 
articles then create at least one new article so that you receive some indication that 
the agent is running correctly. 

Have a new or modified article ready 

It is best to ensure that there is at least one new or modified article in your database, 
so that you can see exactly what the email will look like.  If necessary create a 
dummy article (you only need to complete the mandatory fields in the Basics 
tab). 

1.	 Close the agent (click on the cross at the top right of the Agent tab name). 

2.	 Go to the View menu. 

3.	 Select Agents. A list of all of your agents is displayed. 

Appendix B - 9 



 
 

 

 

 
 
 
 

 

 

 

 

 
 

edDesk (Lotus Notes) User Guide 

Figure 220: List of all of my agents. 

4.	 Highlight the agent that you want to test. 

5.	 Go to the Agent menu. 

6.	 Select Test. 

7.	 After the agent has been tested a Test Run Agent Log displays. 

Figure 221: Test Run Agent Log 

8.	 Read the Test Run Agent Log carefully as it tells you about the total 
number of articles in your database, how many meet the criteria specified 
by the agent and what will happen to those articles.  In the Log above a 
newsletter summary will be sent to recipients specified in the programmer’s 
pane. 

9.	 Click on <Done>. 

DELETING AND DISABLING AGENTS 

Only delete agents that you have created and that only you run!  If you are not sure 
that you are the only person who uses an agent disable it instead of deleting it. 

Delete – permanently removes the agent from the database. 

Disable – the agent is still in the database, but it cannot be run. 

Deleting an agent 
1.	 Go to the View menu. 

2.	 Select Agents. The Agents list is opened. 
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3.	 Select the agent to be deleted. 

4.	 Press <Delete>. You are prompted Delete agent ‘(agent
name)’ permanently from the database? 

5.	 Click <Yes>. 

Disabling an agent 
1.	 Go to the View menu. 

2.	 Select Agents. The Agents list is opened. 

3.	 Select the agent to be disabled. 

4.	 Click on <Disable>. 

WORKED EXAMPLE – AN AGENT TO SEND A DAILY EMAIL THAT LISTS NEW AND 
MODIFIED ARTICLES 

This agent sends an email each weekday morning (at 8:30am) to other people in an 
organisation. The email lists all new and modified articles in a database.  Each new 
and modified article has a link so that people can open the article.  Other information 
displayed is the article author, modification or addition date, article size (in bytes) 
and article subject. 

1.	 Open the database in which you want to create the Agent. 

2.	 Go to the Create menu. 

3.	 Select Agent. 

Agent properties dialogue box 

4.	 Name: Type “New and Modified Articles” 

5.	 Comment: Type “sends daily email about new and modified articles” 

6.	 Trigger: Select On schedule. 

7.	 Select Daily from the dropdown list. 

8.	 Click on <Schedule…> 

9.	 Start running agent at: Click on the clock icon in this field. 

10.	 Scroll through the list until the time displayed is 08:30AM. 

Appendix B - 11 



 
 

 

 
 

 
 

 
 

 

 

 

 

 

 

 

 

edDesk (Lotus Notes) User Guide 

11.	 Click away from the list. You are returned to the Agent Schedule dialogue 
box. 

12.	 Don’t run agent on weekends: Select this. 

13.	 Click <OK>. 

14.	 Target: select All new and modified documents. 

15.	 Close the Agent Properties dialogue box. 

 Programmer’s pane 

16.	 Look down at the bottom of the pane.  Click on <Add Action…>. 

17.	 Action: Click on this list and select Send Newsletter Summary. 

18.	 To: Type the email addresses of the people to whom you are sending the list 
of new and modified articles. If you have a group contact list, you may 
type its title. For example, #staff@company.com. 

19.	 Subject: Type New and Modified Articles. 

20.	 Send the following message: This field is for text that appears in the 
body of an email.  Type The following articles are new or have been 
modified: 

21.	 Include summary for each document using view: Make sure this field 
is ticked. Then select All Documents. Your email will include information 
displayed in the view “All Documents” (a very useful view!). 

22.	 The Add Action dialogue box should look like the one below.  (The 
address of the recipients will be different) 
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Figure 222: Completed Add Action dialogue box as per the instructions in this 
example. 

23.	 Click on <Add>. 

24.	 Your action is now added to the agent. The Programmer’s pane is 
displayed as below. 

Figure 223: Programmer’s pane after you have completed the Add Action dialogue 
box. 

25.	 Save your agent by either: 

•	 going to the File menu then selecting Save OR 

•	 pressing <Ctrl>+s 

26.	 Close the agent.  (Click on the cross in the agent’s tab). 
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Test your agent 

Have a new or modified article ready 

It is best to ensure that there is at least one new or modified article in your database, 
so that you can see exactly what the email will look like.  If necessary create a 
dummy article (you only need to complete the mandatory fields in the Basics 
tab). 

27.	 Go to the View menu. 

28.	 Select Agents. 

29.	 Highlight the agent you want to test. 

30.	 Go to the Agent menu. 

31.	 Select Test. 

32.	 Read the Test Run Agent Log carefully to make sure that your agent has 
run as expected. Make any required modifications to your agent. 

Appendix B - 14 



 
 

 

 

 
 

 

edDesk (Lotus Notes) User Guide 

Appendix C: Using Webforms 

WEBFORMS 

Webforms are used by your clients to review articles that you are publishing on their 
behalf. They are particularly useful for independent publishers, such as 
Hardie Grant. 

This appendix instructs you in the procedures involved in using webforms, from the 
author receiving a brief emailed through edDesk, through to the editors and the 
client reviewing the edited article. 

Webforms involve using a web browser for submission and review of articles.  The 
address of the website you need to use for article submission is given in the briefing 
email to the author.  The address of the review site is given to you by itechne – you 
then give that address to the client who needs to review their articles. 

Author tasks 
This is written from the perspective of the author. 

1.	 Open the briefing email.  The email is displayed, containing details of the 
brief and instructions follow to submit the article. 

Figure 224: briefing email showing all text of email 
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2.	 Write your copy in whatever application you usually use for stories. 

3.	 Web-based submission: When you are ready to submit the story click on 
the link under the Web-based submission heading. 

Figure 225: Briefing email showing details of the submission instructions 

4.	 A browser window opens, with a login screen. 

Note 

If a browser window does not open, then you need to open a browser 
window and copy and paste the link into the URL of the browser. 

Figure 226: Login screen for webform - used in article submission 

5.	 Type in the username and password given to you in the briefing email.  The 
username and password are case sensitive. 

6.	 Click on <Access Server>. 

7.	 The webform for article submission displays. 
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Figure 227: Webform in which to copy and paste your article 

8. Headline: type the headline for your article. 

9. Intro: type the introduction for your article. 

10. Copy and paste your article into the area below the Intro: 

You can do many simple word processing functions here – such as bold, 
italic, indent, outdent, bulleted lists, numbered lists. 

If you’ve used a wordprocessing application such as Word, your formatting 
will be pasted in as it appeared in Word. 

Figure 228: Example of an article ready for submission.  Formatting has come 
across when pasting from Word. 

11. Click on <Submit> when you are ready to submit your article. 

12. A confirmation message appears, thanking you for your submission. 
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Figure 229: Confirmation message that appears after you click on <Submit>. 

Editor tasks 
Submitted articles are listed in the Filed Copy view, available from the Editing
tab. When an article is submitted, edDesk “replicates” this around the network – 
meaning that it can take several minutes for a submitted article to be listed in the 
Filed Copy view. Be patient – it will appear. 

1. Click on the Editing tab. 

2. Click on Filed copy. 

3. All articles with a copy status of “Filed” are listed. 

Figure 230: Filed copy view, with the article that was submitted by the author 
outlined with the black box. 

4. Click on the article you need to edit. The article opens. 

5. Click on <Edit>. 
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6.	 Make any required changes to the text and/or formatting. 

7.	 Go to the Workflow tab. 

8.	 Change the Copy status to reflect what part of the editing process the 
article is up to. 

9.	 <Save> the article. 

Save new version 

If you want to keep a copy of the article, as it was originally submitted by the author, 
and a copy with any edits you have made, you can use <Save new version>. 

If the author has submitted their article by emailing a Word document you can attach 
that document to the article in a different manner. 

1.	 When you have edited the article, click on <Save new version>. 

2.	 The article is saved and closed. 

3.	 Look at the Filed copy view (from which you entered the article you just 
edited). 

4.	 The article is now listed twice; the edited version is the “parent” and has an 
arrow next to its subject; the original article is a “child” of the edited article. 

Figure 231: Edited version is the one with the arrow next to the subject, original 
version is indented underneath. 

Client review of edited articles 
When the article has a copy status of “Copy ready” it is available for the clients to 
review at an approval site. itechne set up the approvals site, and then you (at Hardie 
Grant) let itechne know the logins and passwords you want.  You then give the site 
address and login details to the client. 

This section is written from the perspective of the client. 
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1. Go to the approvals address. Your publisher will give you this address. 

2. Login in to the approvals site. 

3. A list of all articles with a copy status of Copy ready is displayed, as below. 

Figure 232: Client site, listing articles submitted for approval 

4. Information displayed about each article is: 

•	 Subject (this is in bold with an arrow next to it). 

•	 Issue: information is taken from the Volume and Number fields in the 
Basics tab of the article. 

•	 Section: information is taken from the Section / Subsection fields in the 
Basics tab of the article. 

•	 Author: information is taken from the Author field in the Brief tab of 
the article. 

•	 Approval date: taken from the Issue date of the publication (in the 
Setup tab, Production schedule). 
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•	 Intro: Text is taken from the Intro: field in the Copy tab of the article.  
If the author has submitted the article using the webforms, this was 
entered into the Intro field of the webform (and from there edDesk put it 
into the Intro field in the Copy tab of the article). 

5.	 Click on the Subject. 

6.	 The Approval submission page displays. 

Figure 233: Webform article approval 

7.	 The article details display.  The article text is at the bottom of the page. 

8.	 If you would like changes to be made, type those changes into the Changes 
required to the article field. Click on <Request changes>. 

9.	 If the article does not need any changes, click on <Approve>. 
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Appendix D: Troubleshooting and FAQs 

TROUBLESHOOTING 

I marked an article for deletion by accident 
It is easy to accidentally mark an article for deletion.  It is also easy to undo the 
deletion! 

How you did it (relax it’s very easy to do) 

1.	 Opened the article. Did not select <Edit>. 

2.	 Pressed <Delete>. 

3.	 Closed the article, either by clicking <Cancel> or by closing the window 
tab. 

4.	 Your article has been marked with a cross. 

Figure 234: Article marked for deletion is indicated with a cross. 

How to undelete it (this is also easy) 

Do one of the following: 

1.	 Select the Edit menu (at the top of your screen).  Select Undo Delete OR 

2.	 Press <Ctrl>+z. 

I really did delete an article 
You need to contact your System Administrator as quickly as possible.  If your 
deletion is replicated your article may need to be restored from backup versions of 
your database. 

It’s always best to change the Copy status to Cancelled instead of deleting an article.  
L see section 15.2: Cancelling an Article for more information. 

I want to print a view, but cannot get the Print View or Print Documents 
dialogue boxes to display 
Some views require you to select a document before selecting print.  You tell 
edDesk to print the entire view when the dialogue box is displayed. 

1.	 Click once on any article listed in the view. The Print View dialogue box 
opens. 

2.	 What to Print – Click on Selected view. 
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3.	 Click on the Page Setup tab. 

4.	 Orientation – Click on Landscape. 

5.	 Click <OK> to print, or <Preview…> to have a preview and check that 
your print settings are correct. 

FREQUENTLY ASKED QUESTIONS 

Why are Volume and Issue fields pre-filled in my new article? 
If you have an article selected in the content view then added a new article, the 
Volume and Number fields in the new article are pre-filled with the information 
from the article you had selected. 

In the diagram below the selected article is dated 07/31/2004 (that is, 31 July 2004) 
– or Volume 2004, Number 7. 

Figure 235: Article selected from Content > Sections 

If you select the New menu and then Article you will find that your new article has 
the Volume and Number fields pre-filled with the same information as for the 
article you had selected. 
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Figure 236: Pre-filled Volume and Number fields taken from selected article in Figure 10 
above 

Important Note: 

If you use the Content view and are briefing out a lot of material you must 
remember that your new articles inherit characteristics from the selected article in 
your view. 

After you have briefed out your new article, edDesk takes you back to your content 
view and any new article automatically inherits the Volume and Number from the 
selected article. 

Remember that you may need to update these fields with the correct information 
for the particular new article you are creating. 

How do I create a link from a small image on my webpage to a larger (or 
better quality) image, preferably opening in a new window.? 
11.	 Be in the article you want to have the images available in. 

12.	 Add the small image to the article, in the position in which you want it to 
display on the posted webpage. 

13.	 Click on Attachments and resource files (this is at the bottom of your 
article). This section expands. 
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Figure 237: Expanded Attachments and resource files section of the article 

14.	 Click on the <Attach files> button. 

15.	 The Create Attachments dialogue box displays.  Locate the image you 
want to link to. 

16.	 Double-click on the image.  It is now added to the article (in the 
Attachments and resource files section). 

17.	 Click once on the small image. 

18.	 Select Add Hotspot (shape). 

19.	 Choose a shape that fits with the area you want to make a hotspot.  If you 
want to select an irregular area then select Add Hotspot Polygon. 

20.	 Position your cursor where you want your hotspot to be then drag your 
mouse to make the hotspot the required size. 

21.	 The Hotspot properties dialogue box opens.  There are a couple of fields 
that you need to complete: 

•	 Type: leave this as URL 
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•	 Value: This must be in the format 
articleIDs/[thisdocid]/$file/[filename] 

WHERE 
[thisdocid] is the article ID and 
[filename] is the filename of the image. 

Important 

The square brackets just indicate that variable information goes 
here - make sure that you don't put them in your value field. 

•	 Type: enter _new. This opens the linked image in a new browser 
window. 

To get the article ID: 

3.	 Go to the Web tab. 

4.	 Copy the contents of the Article ID field. 
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About the images used in this screen capture 

Figure 238: Image in body of article, with Attach files listing image linked to by a hotspot set 
in the body image. 

This article has an image in the body of the article.  It also has an attached file 

topgear_peugeot.jpg. 


A hotspot was created around the image in the body of the article.  The hotspot 

properties Value field contains the following: 


articleIDs/22AEA87282497C14CA257267000F96F2/$file/
topgear_peugeot.jpg 

WHERE  

22AEA87282497C14CA257267000F96F2 is the articleID (from the 
Web tab) AND 

topgear_peugeot.jpg is the name of the attached file. 
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How do I make the text in an article larger, so it’s easier to see when 
I’m editing? 
1. Open the article and go into Edit mode. 

2. Select all the text in the body of the article. 

3.	 Press <Ctrl>+K.  The Text properties dialogue box opens at the font 
tab. 

Figure 239: Text properties dialogue box 

4. Select the font size as required. 

5. Click on the close icon. 
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I prefer to use my keyboard where possible.  Are there any keyboard 
shortcuts? 
There are many keyboard shortcuts. The most useful when you are in an article are 
listed below. They are grouped into Macintosh and PC shortcuts. 

Macintosh users 
You must be in Edit mode before using the shortcuts. 

Press To do this 
COMMAND+B Bold selected text 

COMMAND+E Toggles between Edit and Read modes 

COMMAND+F Find text and replace 

COMMAND+G Find next word when "Find text and replace" starts 

COMMAND+I Italicize selected text 

COMMAND+J Format paragraphs (alignment, spacing, etc.) 

COMMAND+K Format text (font, size, color, etc.) 

COMMAND+R Show/Hide ruler 

COMMAND+T Change text style to default (color changes only if 
the text style is from a Paragraph Style) 

COMMAND+U Underline selected text 

F1 Undo last action 

F7 Indent first line in paragraph 

F8 Indent entire paragraph        

F9 Refresh current document (in Edit mode), view, or 
workspace 

F11 Cycle through paragraph styles (defined in the 
Paragraph Styles tab in Text Properties) 

SHIFT+COMMAND+L Insert page break 

SHIFT+F7 Outdent first line in paragraph 

SHIFT+F8 Outdent entire paragraph 
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PC users 
You must be in Edit mode to use these shortcuts. 

Press To do this 
CTRL+B Bold selected text 

CTRL+E Put document in either Read or Edit mode 

CTRL+F Find text and replace 

CTRL+G Find next word when "Find text and replace" starts 

CTRL+I Italicize selected text 

CTRL+J Format paragraphs (alignment, spacing, etc.) 

CTRL+K Format text (font, size, color, etc.) 

CTRL+R Show/Hide ruler 

CTRL+T Change text style to default (color changes only if the 
text style was applied using a Paragraph Style) 

CTRL+U Underline selected text 

CTRL+Z Undo last action 

F2 Enlarge selected text to next available point size 

F7 Indent first line in paragraph 

F8 Indent entire paragraph        

F9 Refresh current document (in Edit mode), view, or 
workspace 

F11 Cycle through paragraph styles (defined in the 
Paragraph Styles tab in Text Properties) 

SHIFT+CTRL+L Insert page break 

SHIFT+F2 Reduce selected text to next available point size 

SHIFT+F7 Outdent first line in a paragraph 

SHIFT+F8 Outdent entire paragraph 
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Your notes and comments 

Please feel free to send feedback to fborkman@itechne.com 

Your notes and comments 

mailto:fborkman@itechne.com�
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